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About Output Server 2
Output Server 2 is Grass Valley’s next generation video playout engine for iTX systems. It 
has improved standards compliance, more flexibility and greater stability than our previous 
video engine and forms the backbone of the iTX system.

This guide describes the features and functionality of Output Server 2 (OS2), as well as the 
underlying principles of Output Server 2. It also explains how to install or upgrade to 
Output Server 2, how to create and configure channels using Output Server 2 and provides 
information about the day-to-day operation and maintenance of an Output Server 2 
channel.
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About the Output Server 2 Services
Output Server 2 is a combination of services that work together to form the video engine 
that is responsible for the playout of a television channel. 

The core services that make up the Output Server 2 system are:
• TXPlay 2 - automation engine

An instance of the TXPlay 2 service runs for every channel in the iTX system. TXPlay2 is 
responsible for running the playout schedule and sending the appropriate commands 
to the Output Server 2 service. As well as interacting with the Media Cache 2 service.
Additional instances of TXPlay 2 can be run that act as “edit channels”, which can be 
used for off-air schedule manipulation. A special instance can also be run in “live 
channel” mode, which can send alternative playout commands for ad hoc operations.

• Output Server 2 service - playout communication and command interface
An instance of the Output Server 2 service runs for every channel in the iTX system. 
Each one provides the communications interface for receiving playout commands for 
the channel from TXPlay 2. The Output Server 2 service also performs media transfers 
for caching operations, as instructed by the Media Cache 2 service. 
Supporting Output Server 2 is the GV Engine, which is the media application 
framework plugin that performs all video, audio and ancillary data processing 
operations. The operations have been separated into two processes to allow the video 
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engine to be reinitialized without the overhead of also re-initializing the network 
communications, allowing faster recovery from video/audio processing issues.

• Channel Controller service - schedule controller
An instance of the Channel Controller service runs for every channel in the iTX system. 
The Channel Controller service acts as the controller for TXPlay channels, with all 
schedule changes and actions (Cue, Take) being performed through this service. All 
controlled TXPlay channels act as playout nodes in that they are supplied a schedule by 
the Controller, which they then playout. 
In conjunction with the iTX Desktop’s Network channel, the Channel Controller is 
responsible for the control and schedule management/substitution of the channel 
schedule, while also allowing you to view the status of channel items. See About the 
Network Channels in the iTX Desktop on page 9 for more information.

• I/O Device Controller - AJA video/audio I/O card interface
The I/O Device Controller service manages the configuration of the ports on the 
playout server’s video and audio input/output card(s). It receives this configuration 
from TXPlay 2 on start up and then interfaces between the video/audio I/O card and 
the Output Server 2 service. It is also used to specify the input reference signal, frame 
rate family and the output timing for the channel.
Only one instance of the I/O Device Controller is required per playout server.

• Media Cache 2 - file caching mechanism
The Media Cache 2 service manages all caching operations required for playout from 
the local machine. It also provides a channel view so that the current file caching queue 
can be monitored from within iTX Desktop. The actual media transfer is performed by 
the Output Server 2 service, which can throttle the transfer speed dynamically to 
ensure reliable playout.
A single media cache can be shared by multiple channels running on the same playout 
server.

These services, along with any other components installed on your playout server are 
launched and managed by another application, called the Server Controller. This means to 
start all of these services, you only need to start the Server Controller. See Starting Output 
Server 2 on page 95.

Output Server 2 integrates with the current iTX framework, allowing you to easily upgrade 
your existing channels. Whilst Output Server 2 supersedes the previous video engine, 
Output Server 1 is still supported and it is even possible to run both video engines in the 
same iTX system. See Transitioning to Output Server 2 on page 18.

Note: To support 4K input and output, 64-bit versions of the Output 
Server 2 service, GV Engine and I/O Device Controller are automatically 
installed when the Output Server 2 is selected for install.
2
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About Output Targets (SDI and IP)
There two methods by which a playout server can send and receive transmission signals:

• Via an SDI (Serial Digital Interface) card, such as the AJA Corvid 88, 
• Over a computer network using IP (Internet Protocol), via a dedicated network adapter.

To maintain clarity through this document, both SDI card and the network adapter being 
using for streaming are referred to as video/audio I/O cards.

It is also possible to use a combination of SDI and IP targets on the same playout server. For 
example, for dual channel playout, one channel could be output to an SDI target, while the 
other could be sent to an IP target. 

A single channel can even have a combination of up to two output targets (SDI or IP) 
depending on the availability of I/O cards on the system. Output targets allow for different 
branding levels or output quality settings to be used simultaneously on a given channel.

See Creating an Initial Channel During Installation, on page 41 and Configuring Channel 
Playout, on page 63 for instructions on setting and configuring Output Targets.

SDI card support
Output Server 2 supports the following models of SDI video/audio I/O card:

• AJA Kona 3G 
• Single AJA Corvid LP 
• Dual AJA Corvid LP 
• AJA Corvid 44
• AJA Corvid 88

IP Playout Requirements
For IP playout, your iTX system must meet the following requirements:

• To maintain the integrity of the IP playout, the streaming network (used for the IP 
inputs and output) must be independent from the management network (used to 
control the equipment).

• Your playout server must have a minimum of two network adapters — one for the 
streaming network and one for management network.

• The streaming network adapter must have enough bandwidth to support the 
combined bit rates of all your simultaneous live IP inputs and the IP output. 

• The iTX Router Service must be installed and the IP sources and IP destinations 
configured on the iTX Framework Server. See the iTX System Administrator Guide for 
more information about installing and configuring the IP Router Service. 

Note:
• Although iTX 2.x supports the AJA Kona 3G video/audio I/O card, it does not 

support the AJA Kona 3 card.
3
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About Playout Types
A playout type defines which input and output ports on the video/audio I/O card are active 
and require cabling. This dictates what kind of channel can be operated on the playout 
server. For example, the input and output ports required to operate a single channel are 
different to those required to operate dual channels. iTX Output Server 2 supports the 
following playout types:

• Single Channel Playout
• Single Channel (4K)
• Single Channel (4K 2SI)
• Single Channel + Fill & Key
• Dual Fill & Key
• Dual Channel Playout
• Dual Live Input
• Dual Live + Fill & Key
• Simulcast Playout
• Simulcast + Fill & Key
• On-Demand Playout

Single Channel Playout
Single channel playout means the channel has a single input and a single output. This 
playout type can be used for main channels and backup channels running on their own 
playout servers.

Single Channel (4K)
iTX supports playout of 4K media encoded as Quad Full HD (QFHD), which has a pixel 
resolution of 3840 x 2160 (four times the resolution of 1080p). 

4K is only supported on AJA Corvid 44 and AJACorvid 88 SDI video/audio I/O cards and has 
the following cabling requirements:

• For 4K output, all four output spigots on the SDI video/audio I/O card must be 
connected to four inputs on a matrix router.

• For 4K input, your playout server must be equipped with a AJA Corvid 88. All four input 
spigots on the Corvid 88 must be connected to four destinations on a matrix router.

Single Channel (4K 2SI)
iTX supports the playout of 4K 2SI (two Sample Interleave), which allows a 4K picture to be 
split into four HD (1080p) pictures. Each picture is sampled to a quarter of the original 
resolution and thus can be recombined to reconstruct the original 4K picture. This methods 
is an alternative to sampling the 4K picture into square division quad split (top-left, top-
right, bottom-left, bottom-right). For 2SI, any of the 4K outputs can be used for monitoring 
the 4K picture, rather than requiring to route and reassemble all four outputs.

4K 2SI is only supported on AJA Corvid 44 and AJACorvid 88 SDI video/audio I/O cards and 
has the following cabling requirements:
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• For 4K 2SI output, all four output spigots on the SDI video/audio I/O card must be 
connected to four inputs on a matrix router.

• For 4K 2SI input, your playout server must be equipped with a AJA Corvid 88. All four 
input spigots on the Corvid 88 must be connected to four destinations on a matrix 
router.

Single Channel + Fill & Key
Single Channel + Fill & Key provides the identical functionality as a standard Single 
channel playout type, in that the channel has a single input and a single output on the 
playout server. Additionally, the Single Channel + Fill & Key playout type offers the ability to 
add one Fill and Key graphics overlay to the output from a single pair of Fill and Key inputs. 

When using an Output Server equipped with a Corvid 44 card, the channel has a single 
input, a single output and there is no clean output. However, if it is equipped with a 
Corvid 88 card, then the channel has a single input, a single output and a clean output. 

Dual Fill & Key
The Dual Fill & Key playout type provides a standard single channel playout using two live 
inputs and a single output on the playout server. Additionally, the Dual Fill & Key playout 
type offers the ability to add up to two independent Fill and Key graphics overlays to the 
output from two pairs of Fill and Key inputs. The Fill & Key graphics are overlayed during a 
crossfade between the two live inputs.

Dual Channel Playout
Dual channel playout means there are two independent channels running on a single 
playout server, each with its own inputs and outputs. This can be used to run a main 
channel and the backup of another channel on a single playout server (providing it is 
equipped with a compatible video/audio I/O card).

Dual Live Input
Dual live Input means the channel has two live input sources, but a single output. In an 
Output Server 2 system, both live inputs can be connected to and played out from a single 
playout server (providing it is equipped with a compatible video/audio I/O card). 

Within ITX Desktop, the two live inputs appear on a single channel as program A and 
program B (PGM A and PGM B on the timeline). This allows you to switch between back-to-
back live events using the internal iTX Master Control plugin. See Viewing Live Event Inputs 
on Channel Control Layouts on page 124.

Note: The resolution of the Fill & Key inputs must match the resolution 
of the output; otherwise the Fill & Key events will fail to go to air.

Note: The resolution of the Fill & Key inputs must match the resolution 
of the output; otherwise the Fill & Key events will fail to go to air.
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Dual live input also allows for live-to-live cross fade transitions and picture-in-picture (PiP) 
effects, where one input is used for the main display and the other is used for a smaller 
frame with the main display.

The iTX Simulcast Playout also supports the use of Dual Live Inputs, which is configured as 
part of the standard simulcast playout. See Simulcast Playout below.

Dual Live + Fill & Key
Dual Live + Fill & Key playout type provides the identical functionality as a standard Dual 
Live channel playout type, in that the channel has two live inputs and a single output on 
the playout server. Additionally, the Dual Live + Fill & Key playout type offers the ability to 
add Fill and Key graphics overlays to the output from a single pair of Fill and Key inputs. The 
Fill & Key graphics are overlayed during a crossfade between the two live inputs.

Simulcast Playout
For simulcast playout, two channels share two inputs, but have independent outputs on 
the playout server (providing it is equipped with a compatible video/audio I/O card). A 
typical use case for a simulcast system is to have one high resolution transmission and one 
lower resolution transmission from a single schedule that is loaded on to the main channel. 
For example, HD as the main channel and SD the simulcast, or 4K as the main channel and 
HD the simulcast. Because the main and simulcast channels have different requirements for 
the resolution, aspect ratio control (ARC) and audio output, the two channels are 
configured independently.

To transmit appropriate branding for a simulcast channel, iTX allows you to configure event 
mapping rules. Using these rules, iTX is able to swap assets such as logos and CGs based on 
their names in the main channel’s schedule before they go to air. 

iTX manages the broadcasting of main and simulcast channels using a system of 
networked instances of TXPlay 2, known as a channel network. The main channel in any iTX 
system is identified as a leader channel. The controlling instance for the simulcast and 
network in general is known as the Channel Controller. 

When TXPlay 2 is set to a simulcast playout type, iTX also supports dual live inputs for 
simulcast. As each live feed in a dual live input channel is connected to different input, 
when operating dual live inputs for simulcast, the Channel Controller selects which input it 
is going to use and informs the channels to use the same input.

For more information about the leader/follower model, see About Logical Audio Programs, 
on page 11.

Simulcast + Fill & Key
Simulcast + Fill & Key provides the identical functionality as a standard Simulcast playout 
type, in that two channels share two inputs and have independent outputs on a single 
playout server. Additionally, the Simulcast + Fill & Key playout type offers the ability to add 

Note: The resolution of the Fill & Key inputs must match the resolution 
of the output; otherwise the Fill & Key events will fail to go to air.
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Fill and Key graphics overlays from two independent Fill and Key input pairs to one or both 
of the channel outputs.

On-Demand Playout
Unlike the conventional playout types, the On-Demand playout does not permit an output 
to a monitor. Instead, the output generates a master video file from the schedule and also 
transcode, proxy and metadata if needed.

Playout Type Support
The table below shows which playout types are available to each supported model of 
video/audio I/O card:

Note: The resolution of the Fill & Key inputs must match the resolution 
of the output; otherwise the Fill & Key events will fail to go to air.

Playout Type K3G 
1x 

CLP
2x 

CLP C44 C88 IP Comment

Single channel       Default for all models of video/audio I/O 
card. Use for stand alone main or backup 
channels.

Single channel 
(4K)

  Corvid 44 only supports 4K output. For 4K 
input, your playout server must be 
equipped with a Corvid 88.

Single channel 
(4K 2SI)

  Corvid 44 only supports 4K output. For 4K 
input, your playout server must be 
equipped with a Corvid 88.

Single channel 
+ Fill & Key

  Corvid 44 card, the channel has a single 
input, a single output and there is no 
clean output. Corvid 88 card, the 
channel has a single input, a single 
output and a clean output. 

Dual Fill & Key  Select if you are configuring a single 
channel with two inputs and one output 
with graphics overlays from two pairs of 
Fill & Key inputs.

Dual channel     Select to configure two channels running 
on the same playout server (i.e. channel A 
main and channel B backup).

Dual live     Select if you are configuring a single 
channel with two inputs and one output.

Dual Live + 
Fill & Key

 Select if you are configuring a single 
channel with two inputs and one output 
with graphics overlays from a single pair 
of Fill & Key inputs.
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Key:
• K3G is AJA Kona 3G for SDI targets
• CLP is AJA Corvid LP for SDI targets
• C44 is AJA Corvid 44 for SDI targets
• C88 is AJA Corvid 88 for SDI targets
• IP is Internet Protocol playout using a network adapter.

Simulcast    Select if you are configuring a simulcast 
channel on a separate playout server or 
you are configuring a main channel and a 
simulcast on the same playout server.

Simulcast + 
Fill & Key

 Select if you are configuring a simulcast 
channel with graphics overlays from two 
independent pairs of Fill & Key inputs.

On Demand The On-Demand playout type does not 
have an I/O Device Controller service since 
there is no I/O processing occurring 
through the video/audio I/O cards.

Playout Type K3G 
1x 

CLP
2x 

CLP C44 C88 IP Comment
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About the Network Channels in the iTX Desktop
The introduction of the Channel Controller service in iTX 2.11 changed the way TXPlay 
channels are viewed, edited and controlled in the iTX Desktop.

Each main TXPlay channel now has an associated Network channel, which is represented in 
the iTX Desktop’s Channel View by a button labeled with the name of the main channel 
with “-NETWORK” appended to it.

The Network channel is the control channel used to edit and control the content of its 
associated TXPlay channels (including regional/sub-channels and simulcast channels). All 
schedule changes, playout actions (Cue, Take) and other operator interventions are 
performed on the Network channel. 

Existing TXPlay channels still appear in the iTX Desktop’s Channel View, however these 
TXPlay channels are read-only and simply playout the schedule supplied by the Network 
channel. Schedule changes, playout actions (Cue, Take) and other operator interventions 
are not permitted on these TXPlay channels.

The purpose and functionality of the TXPlay EDIT channels remains the same in that they 
are not controlled by the Network channel and they are used to manually create or edit 
schedules.

To emphasize the functional difference between the Network channels and TXPlay 
channels, we recommend creating a Channel View containing only the new Network 
channels that will be used for control purposes and a separate View for the TXPlay channels 
for configuration purposes rather than having them all in one view.
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The channel configuration tasks that are normally performed in the iTX Desktop’s 
Engineering > Channel Config can only be performed on the main TXPlay channels, not on 
the Network channels. 

You can see which TXPlay channels the Network channel is controlling by hovering over the 
NETWORK icon located above the Network channel’s schedule grid. The displayed message 
indicates which TXPlay channels are routed to air and which are on Standby.

The On Air status indicator to the left of the Network channel in the Channel Selector 
provides operators with a quick reference of which primary channel is On Air (main or 
backup). Note that the On-Air status is based on primary channels within the Channel 
network only. Other channels such as simulcast, regional and/or sub channels do not affect 
the On-Air status.

The color of the On-Air indicator is determined by the Master On-Air and Backup On-Air 
settings in the iTX Desktop's Colour Configuration settings. By default, the color of the 
Master and Backup channels is the same. For operators to quickly identify at a glance which 
primary channel is On-Air, we recommend that you change the Master On-Air and Backup 
On-Air settings to different colors. See “The Color Configuration pop-up layout” in the iTX 
System Administrator Guide for more information.

Hovering over the On-Air indicator displays a status overview of each channel within the 
Network channel.
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About Regional and Sub Channels
Your iTX system may include a Main playout channel along with up to eight regional and/or 
sub channels. 

Regional and sub channels may appear to be very similar, but there are notable differences 
in their purpose and configuration.

Regional channels play out the Main channel’s content to several regions simultaneously 
via the Network channel’s schedule with the ability to temporarily break away from the 
Main channel’s content and playout its own scheduled content using unique primary and 
secondary items. 

Using a configured Live asset, a sub channel plays out the primary channel’s output, 
including any additional content or processing that has been applied by downstream 
hardware devices. The advantage of this is that each sub channel conserves the Main 
channel’s output without needing to replicate the processing already performed by 
downstream devices. This eliminates the need to have a separate set of downstream 
devices for each sub channel.

See Adding and Configuring Regional and Sub channels on page 48 for instructions on how 
to add a regional channel or sub channel to an iTX playout server, and Assigning Channels 
to the Channel Network, on page 51for how to add regional and sub channels to the 
Channel Network.

About Logical Audio Programs
For video and voice over media, Output Server 2 provides the ability to define mapping 
rules for audio formats and languages, then apply those rules on a per-channel basis. This is 
achieved through the use of logical audio program labels.

When video and voice over media is imported via Delivery Manager, the audio track 
configuration and metadata are analyzed and divided into audio programs. Simple audio 
types, such as PCM stereo, PCM mono and Dolby D have just one audio program each, 
while the more complex Dolby E type can hold multiple audio programs (as defined in the 
asset’s metadata). 

Audio programs are given a unique label, which is stored in the iTX Opus database, so that 
it is available across the iTX system. Within the Output Server 2 user interface, you can 
define audio mapping rules to control the order of preference for applying the known 
labels to the output audio program group, as applied to each physical pair when the media 
is encoded. This is illustrated in Figure 1-1below.

IMPORTANT
Each regional or sub channel runs its own instance of Output Server 2, whose 
playout configuration must be consistent with the Main channel’s playout 
settings.

Note: Live logos and ALC are not applied by sub channels since they are 
already present in the Main channel’s output.
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Fig. 1-1: Logical audio programs, brought together as groups along with an encoding method and 
how this relates to physical audio channels on output.

The audio output program groups you create are also associated with the configuration of 
Dolby metadata, automatic loudeness control (ALC), upmixing and audio watermarking.

On playout, operators can see which events have had their audio mapped and can override 
mappings where necessary. See Managing Audio from iTX Desktop on page 113.

iTX offers two ways of managing media that does not have an audio program that matches 
the audio mapping rules:

• If no match is found, the item shows an error status in the Audio Mapping column of 
the iTX Desktop’s Schedule Grid. The operator can remedy this situation by changing 
the item’s audio mapping directly from within iTX Desktop. See Managing Audio from 
iTX Desktop on page 113. 

• A Silence label can be added to the end of an audio mapping rule, which tells iTX if no 
match can be found, play out silence. See Defining Audio Mapping Rules for Audio 
Programs, on page 75.

About Asset Management for Logical Audio Programs 
Consider the following points about how Output Server 2 handles assets for logical audio 
programs:

• Video and voice over assets ingested prior to iTX 2.8 will not include logical audio 
programs and must therefore be updated using the Asset Fixer Service. 
See Updating Existing Assets to Use Logical Audio Programs on page 24.

Note: Output Server 1 and Output Server 2 (up until iTX v2.8) supported 
PCM (Auto) mode for Audio Mapping. In this mode, the number of channels 
was determined by the source audio stream. Use of the PCM (Auto) output 
format could impact the track positioning of subsequent output streams and 
is not supported for media with logical audio programs.
12
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• For audio programs to be extracted from new video assets by Delivery Manager, your 
iTX system must be configured to register video file types using the GV Engine. 
See Media Import Configuration Tool in the iTX System Administration Guide.

• By default, iTX groups mono tracks on import to create stereo programs. This behavior 
can be changed within the Delivery Manager configuration. 
See Separating Mono Tracks on Import on page 128.

• By default, iTX ignores language metadata on import. This behavior can be changed 
within the Delivery Manager configuration. 
See Including Language Metadata on Import on page 128.

• Audio import rules are an optional configuration setting that allow you group and label 
the audio tracks of video assets during the import stage so that they can be assigned to 
a specific output audio program during playout.
See Creating Labels and Audio Import Rules for Logical Audio Programs, on page 20.

• As live events are not analyzed by GV Engine, they must have their audio program 
groups defined on a per asset basis. This is performed from the Property Editor, within 
the iTX Desktop Asset layout.
See Adding logical audio programs and groups to live assets on page 89.

Upgrading from Output Server 1 to Output Server 2
iTX allows broadcasters to transition from an Output Server 1 system to an Output Server 2 
system by running both video engines in parallel within the same iTX system during the 
upgrade. This is known as a “mixed Output Server system” and is only recommended 
during the upgrade and testing process, and not for prolonged day-to-day operation.

For more information see the iTX Output Server 1 to Output Server 2 Playout Server Migration 
Guide.

Known limitations of Output Server 2
Output Server 2 has the following known limitations:

• Output Server 2 does not currently support news flash. This functionality will be added 
in a future release.

• Raw audio mode is not supported for MPEG audio codecs.
• When using Dolby E (Auto) output, Dolby Metadata is not supported.
• Squeeze effects are not supported for CGs or logos in either Output Server 2 or Output 

Server 1.
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Preparing for Output Server 2
This chapter discusses the hardware and software prerequisites for operating an Output 
Server 2 iTX system, including the additional licenses that may be required. It also provides 
an overview of the installation process for new iTX systems and upgrades from Output 
Server 1.

Summary
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Prerequisites and Compatibility Requirements
Output Server 2 has both hardware and software prerequisites that must be met before the 
module is installed.

Required Software and Driver Versions

Software Requirement

AJA video/audio I/O 
video card driver 
version

Output Server 2 requires AJA video card driver version 12.4.1.460 to be 
installed via Windows Device Manager before installing or upgrading 
iTX. 
If you have previously installed Output Server 1, the version 7.4.0.49 
AJA drivers must be uninstalled and deleted from Device Manager 
before installing the latest drivers. 

IMPORTANT:
Do not use drivers that are supplied with your AJA video/audio I/O 
card or any that have been downloaded from the AJA website. The 
required drivers for iTX are specially supplied by AJA and are included 
with the iTX Suite in the Drivers folder.

Framework 
component version

Your playout server and framework server must be running the same 
version of their respective iTX components for Output Server 2 to 
function.

Vertigo Suite version If you are using Vertigo XG graphics, Output Server 2 requires Vertigo 
Suite v5.4 or later. 
If you have purchased the Vertigo Suite and require the installation 
software, contact Grass Valley Product Support. For more details visit: 
http://www.grassvalley.com/support/contact.
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Required System Configuration

License Requirements
The modules that make up the iTX system are individually licensed and add-on 
components (such as XG Inside) require their own license to function. 

Depending on your system architecture, the following licenses may be required to operate 
Output Server 2:

Feature Requirement

Media registration 
method

Set the Media Import Configuration Tool to use GV Engine as the 
global import override for all of your video file types.
See Configuring Your Delivery Manager Endpoint for Logical Audio 
Programs on page 23.

Dual channel playout To transmit dual channel or simulcast broadcasts, your playout server 
needs the following:
• For output to SDI targets: an AJA Corvid 44 or Corvid 88 video/audio I/O card 
• For output to IP targets: either a networking adapter dedicated to the 

streaming network or a multi-port network adapter (from iTX v2.8 onwards).
• The I/O Device Controller service (available from iTX v2.6 onwards).

Simulcast playout

Vertigo XG Inside When XG Inside is enabled, Remote Desktop must be disabled on the 
playout server.

Component/feature Required license

Video playback on Output Server 2 via 
the GV Engine

GV Engine

Vertigo XG Inside graphics iTX Integrated XG graphics

SMPTE 2022-2 IP Input/Output Plugin, 
per Channel 
• Adds IP Input / Output support of SMPTE 

2022-2 Compressed IP Transport 
Streams.

• Output in MPEG2 or H.264 up to 50Mbs 
as MPTS, HLS or RTMP.

Note:
• Requires Output Server 2 Video Engine 

running on Appliance 2 or Approved HP 
Hardware.

ITX-TV-IP2022-2 

SMPTE 2022-6 IP Input/Output Plugin, 
per Channel 
• Adds IP Input / Output support of SMPTE 

2022-6 Uncompressed IP Streams.
Note: 
• Requires Output Server 2 Video Engine 

running on Appliance 2 or Approved HP 
Hardware with Windows Server 2012 OS. 

• Requires a Mellanox® ConnectX®-4 Lx EN 
NIC Card must be purchased separately.

ITX-TV-IP2022-6

4K inputs and outputs 4K playout
16
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Licenses are stored in .lic files and require a Grass Valley license dongle to be inserted into 
a USB port on the playout server. For more information about purchasing software licenses 
and the Grass Valley license dongle, please contact: itxlicensing@grassvalley.com.

Registering an iTX license file
To register a new license it must be imported via the System Service, which provides access 
to configuration data and system management and runs on your iTX Framework Server.

To import a license file using the System Service:
1 On your framework service, open and expand the System Service.
2 Click on the Licensing tab.
3 Click the License Details tab.
4 Click Import License.

The Import License File… browse window appears.
5 Browse to the directory containing your .lic license file.
6 Select the license file and click Open.

The license file is registered and appended to the list of licenses on the Licence Details 
tab.

7 When an updated version of an existing license file is imported, services (such as 
TX Play on playout servers), must be restarted to ensure they reflect the updated 
license. 
When TXPlay 2 restarts it will check that the required licenses have been installed. The 
status of the licenses can be checked by running diagnostics on TXPlay 2.

Process Overview - Output Server 2 Installation and Channel 
Configuration

The process of installing Output Server 2 and configuring a channel consists of the 
following actions:

1 Install the required licenses and drivers. 
See Prerequisites and Compatibility Requirements on page 15.

2 Install the Output Server 2 module on your playout server. 

Dolby metadata Dolby

Audio watermarking • Nielsen
• Kantar Snap

Automatic Loudness Control (ALC) ALC

Voice overs Voice Over

Simulcast Simulcast

Fill & Key input Fill & Key

Component/feature Required license
17
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See Installing Output Server 2 on page 29.

3 Add your first channel, followed by any subsequent channels. 
See Adding Channels to an ITX Playout Server on page 37.

4 Start Server Controller to launch Output Server 2 and its related services. 
See Starting Output Server 2 on page 125.

5 Configure the routing and communication model for the channel. This involves the 
following steps:

a Route the SDI channel sources to matrix destinations.
b Configure the channel communication setup.
c If you have a simulcast channel, define an Event Substitution Rule.

See About Channel Communication and Routing on page 53.
6 (Optional) IP Playout: Configure the IP routing and playout settings. This involves the 

following steps:
a Assign IP Router Matrix Destinations to the channel inputs.
b Configure the channel’s IP output settings.

See About Channel Communication and Routing on page 53
7 Configure the basic channel playout settings. This involves the following steps:

a Set a Reference source and Frame Rate Family, and adjust the output timing (if 
required). 

b Configure the timecode settings.
c Configure the Active Format Description Insertion Lines.
d Configure channel delay, if required.

See Configuring Channel Playout on page 63.
8 Configure your channel to process splice insert messages. There are two ways to 

configure this:
• Using the legacy VANC plugin
• Using the enhanced SCTE104 plugin

See Configuring Splice Insert Processing on page 91.
9 Configure any additional plugins or functionality you have licensed. This involves the 

following steps:
a Configure Softel Inside for subtitle playout. 
b Select the channel to use for XG Inside graphics. 
c Define custom Aspect Ratio Control (ARC) modes.

See Configuring Optional Plugins and Functionality on page 97.
10 (New installations) Configure and import media to populate your Opus database with 

your audio program labels. 
This involves the following steps:

Note: If you have purchased a Grass Valley Playout Appliance 2 it will come 
pre-installed with Output Server 2.
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a If using audio import rules to define audio groupings and labels, create the 
necessary language labels and audio import rules. 

b Configure how audio within video files is registered in Delivery Manager.

See Preparing for Logical Audio Programs on page 19.
11 (Upgrades from iTX v2.7 or earlier) Update your existing live assets, media and 

registration rules to support logical audio program groups before configuring your 
audio setup in Output Server 2. 
This involves the following steps:

a Set the media registration method to GV Engine for deep analysis. This is required 
to extract audio program labels from media as it is imported via Delivery Manager. 

b If using audio import rules to define audio groupings and labels, create the 
necessary language labels and audio import rules. 

c Configure how audio within video files is registered in Delivery Manager. 
d Convert existing media and live assets to the logical audio program model using 

the Asset Fixer Server. 

See Preparing for Logical Audio Programs on page 19.
12 Configure the audio output and mapping using the audio program labels extracted 

from your updated or recently imported assets. This involves the following steps:
a Create an audio mapping rule for each audio program.
b If required, configure which audio program(s) voice overs should be applied to.
c If required, configure Dolby metadata for each audio program.
d If required, configure audio upmixing for each audio program.
e If required, configure the audio watermarking, such as Nielsen or Kantar Snap, for 

each audio program.
f If required, configure Automatic Loudness Control (ALC) for each audio program.

g Assign audio program to audio output program groups.
See Configuring Audio Output on page 73.

13 If you have created a 4K channel and will be using the iTX CG or Logo plugins, you must 
also add the 4K Desktop environment variable to all of the iTX Desktop PCs that will be 
used to control the channel. 
See Configuring iTX Desktop for 4K CGs and Logos on page 72.

Preparing for Logical Audio Programs
iTX 2.8 introduced the logical audio programs model for handling audio output and audio 
mapping. This fundamentally changed how video needs to be imported, so that audio 
program labels are extracted and registered in your Opus database. As a result of these 
changes, you need to change how new video assets are registered and also update your 
existing assets to ascertain their audio program labels. 

To prepare your iTX system to use logical audio programs, you must:
1 Configure the Media Import Configuration Tool to use the GV Engine as the global 

import override for all of your video file types. See Configuring Your Delivery Manager 
Endpoint for Logical Audio Programs, on page 23.
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2 Choose one of the following methods for defining the audio program grouping and 
language labels that will be applied to a video asset’s audio upon ingest using the 
Delivery Manager endpoints.

• Audio Import Rules

Audio import rules allow you to define the audio program groupings and language 
label assignments that will be applied to video asset’s audio. To use audio import 
rules, you must:

• Create audio import rules to define how the media’s audio tracks will be 
grouped and labeled within the video asset upon being ingested. See Creating 
Labels and Audio Import Rules for Logical Audio Programs, on page 20.

• Configure the Audio Options of your Delivery Manager endpoints to apply the 
audio import rules. See Configuring Your Delivery Manager Endpoint for 
Logical Audio Programs, on page 23.

• Mono track grouping and/or default labeling

Configure the Audio Options of your Delivery Manager endpoints to specify 
whether mono tracks should be combined to create PCM stereo programs on 
import. See Configuring Your Delivery Manager Endpoint for Logical Audio 
Programs, on page 23.

3 Update the audio program groupings and/or labels of existing assets in your iTX 
system using the Asset Fixer Service. See Updating Existing Assets to Use Logical Audio 
Programs, on page 24.

Setting the Media Import Overrides to GV Engine
So that Delivery Manager can extract audio program labels from video and voice over 
assets and register them in the Opus database on import, the Media Import Configuration 
Tool needs to be configured to use the GV Engine as the global import override for all of 
your video file types. This provides deep analysis of the metadata in your video and voice 
over media when they are imported.

For more information on installing and configuring the Media Import Configuration Tool, 
see section Media Import Configuration Tool in the iTX System Administration Guide.

Creating Labels and Audio Import Rules for Logical Audio Programs
Audio import rules define the audio program grouping and language labels that will be 
applied to the video asset’s audio upon ingest if the Delivery Manager endpoint is 
configured to Use Audio Import Rules.

The sections below provide instructions for creating labels and audio import rules using the 
iTX Desktop’s Configuration layout. 

Viewing and creating audio labels
Before creating an audio import rule, we recommend that you verify that the necessary 
language labels exist in the system. If a required label is not listed in the Configuration 
layout’s Manage Audio Labels page, then you can create the label.
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The instructions below describe how to create labels using the iTX Desktop’s Configuration 
layout. Labels can also be created and managed using the Audio tab in the Output Server 2 
Configuration user interface. See Editing Audio Program Labels on page 129.

To create a new audio label
1 Open the iTX Central Configuration page via the iTX Desktop’s Configuration layout.
2 Click Configure Labels.

All of the labels that currently exist in the system are listed. 
3 If the required label does not already exist, click Create a Label to create a new label.
4 In the Create a Label dialog, type the name of the new label.
5 Click OK.

The new label is added to the Manage Audio Labels page in the Configuration layout.

Creating a new audio import rule
An audio import rule allows you to define the audio program groupings and language label 
assignments that will be applied to video asset’s audio.

Audio import rules consist of a number of audio programs which correspond to the audio 
channels within the incoming media file. Each of those audio programs is defined by a 
encoding type, audio channel type and language label(s).

If the audio pattern within the media file corresponds with a given audio rule, Delivery 
Manager groups and labels the audio channels as defined in the audio import rule.

For example, the following rule would be used for a media file that contains four channels 
of audio, where the first program defines channels 1 and 2 as PCM and channels 3 and 4 as 
Dolby E. The application of this rule would result in the label ENG being applied to the two 
PCM channels, label FRE being applied to the first Dolby E channel and label ESP being 
applied to the second Dolby E channel.

Note: Please consider the following when naming a new label:
• The name should easily identify the language.
• The name can contain a maximum of 10 characters.
• The name should be unique. No two labels can have identical names.
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To create a new audio import rule
1 Open the iTX Central Configuration page via the iTX Desktop’s Configuration layout.
2 Click Configure Audio Rules.
3 To create a new rule: 

a Click Create A Rule. 
b Type a name for the new rule.
c Click OK.

4 Add audio programs to the rule:
a Click Add Program.

Note: Please consider the following when creating a new audio import 
rule:
• The name should easily identify the audio rule type.
• The name can contain a maximum of 20 characters. 
• The Pipe character | is not supported in the name.
• The name should be unique. No two rules can have identical names.
• Programs within a rule cannot be assigned the same label.
• The total channels in the audio import rule number must match the 

number of audio channels inside the media file.
• The audio encoding type for each of the source media channels in the 

rule must match the corresponding channel inside the media file. If 
not, the rule will not be applied.
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b In the Add Audio Programs dialog, complete the Encoding Type, Audio Type and 
Label fields according to the following associations:

c If the audio in these channels is not required for playout, then select the Ignore 
Program checkbox and the Label setting will be automatically filled in with 
UNUSED. 

d Click OK. 

The program is added to the rule with its Source Media Channels and Number of 
Channels fields completed according to the program’s settings.

5 Repeat step 4 for as many programs is necessary to cover all channels of audio of the 
media file.

6 Click Save Rule and the new rule is added to the list in the Manage Audio Rules page.

Configuring Your Delivery Manager Endpoint for Logical Audio Programs
The Audio Options setting on an endpoint’s configuration page instructs Delivery Manager 
how to apply audio program groupings and/or language labels to a video asset’s audio 
during ingest.

The Audio Options setting consists of the following three options:
• Use Audio Import Rules

This option applies the selected audio import rule(s) (audio programs and labels) to the 
assets as the media is imported.

Encoding Type Audio Type Label

PCM • Mono
• Stereo
• 5.1
• 7.1

• Label 

Dolby D • Stereo
• 5.1

• Label

Dolby D Plus • 7.1 • Label

Dolby E • 5.1 • Label

• 5.1 + 2 • Label for 5.1
• Label for Stereo

• 2 + 2 • Label for Stereo
• Label for Stereo

Notes
• Labels must be unique and no two rule may share a common label. The 

only exception to this is the Unused label.
• Labels must already exist in the iTX system or be created separately using 

the iTX Desktop’s Configuration layout or the Audio tab on the Output 
Server 2 Configuration user interface. See Viewing and creating audio 
labels, on page 20 or See Editing Audio Program Labels on page 129 for 
more information.
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When checked, the two other Audio Options settings are replaced by the Audio Import 
Rules field. Clicking the Browse button, opens the Set Audio Import Rules dialog 
which allows you to select one or more audio import rules to apply. If the audio pattern 
within the ingested media file corresponds with one or more of the selected audio 
import rules, then Delivery Manager groups and labels the audio channels as defined in 
the audio import rule.

• Group Mono Tracks
When checked (default), this option combines mono tracks to create PCM stereo 
programs on import. See See Separating Mono Tracks on Import on page 128 for more 
information.

• Ignore Language Metadata
When checked (default), this option tells Delivery Manager to exclude any audio 
program language labels within the media (e.g. language tags) and use the default 
labels instead (i.e. P#1, P#2, etc). See See Including Language Metadata on Import on 
page 128 for more information.

These options are available to all endpoint types and need to be configured for each 
endpoint individually. See iTX Delivery Manager Setup and Configuration Guide for more 
information on creating and configuring Delivery Manager endpoints 

Updating Existing Assets to Use Logical Audio Programs
Any video, voice over or live assets added to your database prior to iTX v2.8 will not include 
logical audio programs. However, iTX includes the Asset Fixer Service, which can be used to 
update these assets to use the logical audio programs model. The Asset Fixer performs a 
shallow analysis of all media on the media store, without performing a de-archive action. 
This means the size of your media does not affect the duration of the fixer job, only the 
quantity of files on the media store.

The following sections provide instructions for how to update existing assets:
• Installing the Asset Fixer Service, on page 24
• Updating existing media to use logical audio programs, on page 25
• Viewing Asset Fixer job progress, on page 26
• Checking for updated assets, on page 26
• Canceling an Asset Fixer job, on page 27

Installing the Asset Fixer Service
The Asset Fixer Service must be installed on the database server, along with the Job Service 
Manager. 

Within the Asset Fixer Service’s Configuration, the options for setting logical audio 
programs and applying Audio Import Rules mirrors those of the Delivery Manager 
endpoint.

To install the Asset Fixer Service
1 Access and open the iTX Installer.

Note: If you are migrating from Output Server 1, updated assets will 
continue to playout using its existing physical audio mapping.
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2 Right-click the Setup.exe file and select Run as administrator. 
The iTX Select Software to Install window appears.

3 Expand the Content Management and select Asset Fixer Service section.
4 Click OK.

The Select Software to Install window closes. 
5 On the iTX Installer window, click CONTINUE.

The selected components install.
6 Click FINISH to complete the installation.

Updating existing media to use logical audio programs
Once installed, the Asset Fixer plugin appears as an additional service on the database 
service. Unlike other services, the asset update jobs performed by the Asset Fixer Service 
need to be manually triggered.

Once started, the Asset Fixer Service updates all video assets as one job, then updates all 
voice over assets as a second job and finally updates live assets as a third job. 

To update existing media to the logical audio program model
1 On the database server, expand the Asset Fixer Service.

The Asset Fixer Service user interface appears.
2 Click on the Configuration tab.
3 If you want to update video assets with an audio import rule:

a Select the Apply Audio Import Rule tab. 
b From the Audio Import Rule list, select the option that best targets the 

circumstance of the video assets that you want to update:
• No Matching Rule: Video assets may have had an audio import rule applied to 

them, but that rule no longer exists in the system.
• No Rule Applied: Video assets that have never had an audio import rule 

applied to them.
• <RuleName>: Video assets that have had this exact audio import rule applied 

to them in the past, but you now want to update the asset with this rule. A 
common reason for doing this type of update is if the rule’s name has not 
changed, but its settings have.

c From the to Audio Import Rule list, select name of the audio import rule that you 
want to apply when updating the video assets.

d Click Update matching Video Assets.

The Asset Fixer Service begins processing your existing assets.
4 If you want to update all video assets have grouped mono tracks and/or default labels:

a Select the Set Logical Audio tab.
b Set the following values, as required:

• Group Mono Tracks - When checked (default), this option combines mono 
tracks to create PCM stereo programs on import.
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• Ignore Language Metadata - When checked (default), this option tells 
Delivery Manager to exclude any audio program language labels within the 
media (e.g. language tags) and use the default labels instead (i.e. P#1, P#2, etc).

c Click Update Assets.

The Asset Fixer Service begins processing your existing assets.

Viewing Asset Fixer job progress
Asset Fixer jobs appear in the Job Monitoring layout, along with other workflow jobs. The 
Job Monitor layout includes Type filters to show either the video asset update jobs or the 
voice over asset update job.

To view the progress of Asset Fixer jobs from iTX Desktop
1 In iTX Desktop, select the Job Monitoring layout.
2 Set the filter at the top of the layout to one of the following:

• Type | Is | Set Audio Logical Audio Data
• Type | is | Set Video Logical Audio Data
• Type | is | Set Live Logical Audio Data

3 (Optional) Click  to add an additional filter. This allows you to include both the Set 
Video Logical Audio Data and the Set Audio Logical Audio Data filters.

4 Press the Enter key or click  to begin the search.
5 The Job Monitor layout updates to show only jobs that match the selected type(s).

Checking for updated assets
PinPoint includes a Category filter that allows you to search for assets that have been 
processed by the Asset Fixer Service.

To check for assets that have been updated
1 In iTX Desktop, select the Asset layout.
2 In PinPoint, select a filter to search for either a video or voice over assets:

• To restrict the search results to video assets, click .
• To restrict the search results to voice over assets, click .
• To restrict the search results to live assets, click .

3 Set the filter at the top of PinPoint to Category | Is | Logical Audio Fixed
4 Press the Enter key or click  to begin the search.

Note: To update both video and voice over assets in parallel, you can run 
the update jobs on two separate Opus servers at the same time. One 
instance of the Asset Fixer Service will update the video assets, while the 
other will update the voice over assets.
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5 The search results displays all of the assets that have been processed by the Asset Fixer 
Service.

Canceling an Asset Fixer job
From within the Job Monitoring layout, you can cancel jobs that are in a State of either 
Active or Waiting.

To cancel an Asset Fixer job
1 In the Job Monitoring layout, filter the job list to show only the Asset Fixer job you want 

to cancel.
2 Select the job and click Cancel.

The State of the job changes to Cancelled:

Note: The results from this search does not include assets that have had 
their logical audio programs processed by Delivery Manager. These assets 
can be searched using Media filter. See Viewing an Asset’s Logical or Physical 
Audio Mapping on page 113
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Installing and Upgrading Output Server 2 
This chapter discusses how to perform a new installation of Output Server 2 on your 
playout server, including how to configure your iTX domain and create a shared folder to 
use as a media cache. It also explains the differences when upgrading from one version of 
Output Server 2 to the latest version.

If you have a Grass Valley Appliance Server 2 playout server, it will be pre-installed with an earlier 
version of Output Server 2, which will need to be upgraded to the current version. See 
Upgrading an Existing Output Server 2 System on page 32.

If you intend to use IP playout, you will also need to install the IP Routing Service on the 
Framework server and configure its sources and destinations. See the iTX System 
Administration Guide for more information.

Summary
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Installing Output Server 2
Output Server 2 and its related services need to be installed on a playout server, equipped 
with a compatible video/audio I/O card. Of these services, the Media Cache 2 and TXPlay 2 
services require user input before the installation is complete.

For more information on which video/audio I/O cards are supported and the services that 
make up an Output Server 2 system, see About Output Server 2, on page 1.

To perform a new installation of Output Server 2
1 Access and open the iTX Installer on the playout server.
2 Right-click the Setup.exe file and select Run as administrator. 

The iTX Select Software to Install window appears.
3 Expand the Playout section
4 Check Output Server 2.
5 Click OK. 

The Select Software to Install window closes. 
6 On the iTX Installer window, click CONTINUE.

The selected components installs on your playout server.
7 During the installation, the iTX Domain Configuration dialog appears. Enter the name 

of the required iTX Domain and Locator Service details, as described in Configuring ITX 
Domain and Locator Service Details, below.
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Configuring ITX Domain and Locator Service Details
iTX services and clients (including iTX Desktops) on the same TCP/IP network can interact 
with each other if they are in the same iTX domain. An iTX domain is identified by a domain 
name assigned to machines on which iTX software runs. In general, iTX services and clients 
belong to the same iTX domain if they run on machines that have the same iTX domain 
name.

As part of a new Output Server 2 installation you are required to enter the details of the iTX 
domain to which the playout server and its channels belong, including the IP addresses of 
any Locator Services in the same domain.

To configure the required iTX Domain and Locator Service Details
1 During the installation of Output Server 2, the iTX Domain Configuration window 

appears.

2 In the ITX Domain Name field, type in the name of the required iTX domain.

3 If you have a Locator Service operating in the same domain, click Add.
An Add Locator dialog appears.

4 In the blank field, enter the IP address for your Locator Service.
5 Click OK.
6 If you have a group of load balanced Locator Services for the domain, you can enter 

additional IP addresses, then reorder them using the Move Up and Move Down 
buttons.
The order of Locator Services in the list determines the order in which iTX selects them 
to handle connection requests. A service that requires connection details contacts the 
Locator Service at the top of the list, if this one is busy, it contacts the next in the list and 
so on.

Note: Only lower case letters, numbers and a hyphen are allowed in 
the domain name.
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7 The Advanced Options button opens an additional dialog, containing a range of 
settings that should only be modified by Grass Valley engineers. 

8 Click Save. 
The iTX Domain Configuration dialog closes and the installation continues.

9 Before the installation completes, the Media Cache Configuration dialog appears. 
Enter the cache name and location, as described in Creating and Sharing a Media 
Cache Folder, below.

Creating and Sharing a Media Cache Folder
As part of a new Output Server 2 installation, you are required to create a folder on your 
playout server to use as the caching location for media as it transitions from your media 
store to playout.

To configure the Media Cache for your playout server
1 During the installation of Output Server 2, the Media Cache Configuration dialog 

appears.

2 By default, the Cache Name field will be populated with the playout server’s Windows 
Computer Name followed by the suffix -CACHE. 
You may enter a name of your choice, but you must ensure the name does not match 
any channel names in your iTX system. The name must also include the -CACHE suffix.

3 Click Create CACHE Share. The Create Share dialog appears.

4 Click the Browse button. The Browse For Folder dialog appears.
5 Select a location to create the caching folder (e.g. Computer > C:).
6 Click Make New Folder and enter the name Cache. 
7 Click OK. 

The Browse For Folder dialog closes and you are returned to the Create Share dialog.
8 Click Share This Folder as ‘CACHE’.
9 Click the Close button. The Create Share dialog disappears, retaining your selection 

and you are returned to the Media Cache Configuration dialog. 
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10 Click SAVE to confirm your media cache configuration.
The installation continues.

11 After creating a media cache folder, the iTX Channel Config dialog for TXPlay2 appears. 
At this point you should add any channels that you require on this playout server. See 
Adding Channels to an ITX Playout Server on page 37.

12 Apply any additional configuration that is required for your channel. 
This is covered in the following chapters:

• About Channel Communication and Routing, on page 53.
• Configuring Channel Playout, on page 63.
• Configuring Audio Output, on page 73.
• Configuring Splice Insert Processing, on page 91.
• Configuring Optional Plugins and Functionality, on page 97.

Upgrading an Existing Output Server 2 System
Since new releases of the iTX software often include new features and enhancements, it is 
possible that you may need to be aware of slight changes to the upgrade procedure when 
updating an existing Output Server 2 system.

While the Release Notes document that accompanies the new iTX Installer is the best 
source for general upgrade information and instructions, the sections below highlight 
particular changes that may directly affect the upgrade of your Output Server 2 system.

Upgrading from v2.5 Output Server 2 to v2.6 (or later)
Since the first release of Output Server 2 in iTX v2.5, additional playout types and the I/O 
Device Controller have been introduced. As such, during an upgrade from iTX v2.5 you are 
asked to confirm your basic channel configuration and required playout type.

To upgrade from v2.5 Output Server 2 to v2.6 or later:
1 Download and extract the required version of the iTX Suite.
2 Access and open the iTX Installer.
3 Right-click the Setup.exe file and select Run as administrator.

The iTX Installer appears listing all of the new modules and those that will be updated.
4 Click CONTINUE. 

The updated software will install.
5 During the upgrade you may be asked to confirm your media cache configuration. 

• For information on configuring the media cache, see Creating and Sharing a Media 
Cache Folder, on page 31.

• If no changes to the media cache configuration are required, click Save.
6 Before the upgrade completes, the iTX Channel Config dialog for TXPlay 2 appears. 

To confirm your channel details:
a Select your required Playout Type. 
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For main or backup channels running on their own playout server, the Playout 
Type can be set to a single channel type. If another playout type is required, select 
it from the drop down list.

b In the Root Name field, re-enter the base channel name. 
c Confirm the following fields are correct, as required:

• Channel Name
• Backup (This must be checked for backup channel upgrades)
• Simulcast (if present)
• Plugin
• Edit channel (if present)
• Live channel (if present)
• Integrated XG
• Use Dedicate Softel Driver (only required for external Softel subtitlers)
• Use SMPTE ST 2059 (PTP)
• Configure for High Bit Rate

7 Click SAVE. 
The iTX Channel Config window closes. 

8 Complete the installation of any other iTX modules you have selected, as described in 
the iTX System Administrator Guide.

9 Apply any additional configuration that is required for your playout server. 
This is covered in the following chapters:

• About Channel Communication and Routing, on page 53.
• Configuring Channel Playout, on page 63.
• Configuring Audio Output, on page 73.
• Configuring Splice Insert Processing, on page 91.
• Configuring Optional Plugins and Functionality, on page 97.

Upgrading Output Server 2 from 2.10 (or earlier) to v2.11 (or later)
iTX v2.11 introduces the Channel Controller service as part of the Output Server 2 software 
module. This new service allows for the replacement of the Leader/Follower model by a 
Network channel model, which provides a single interface from which to view and control 
multiple TXPlay channels. See About the Network Channels in the iTX Desktop on page 9.

The following sections provide guidelines for upgrading an iTX system with existing Output 
Server 2 channels from v2.10 (or earlier) to 2.11(or later).

Note: The combination of these fields that is available is determined by the 
selected playout type.
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Order of Upgrading iTX System Components
When upgrading the Output Server 2 from iTX v2.10 (or earlier) to v2.11, you are required to 
first run the upgrade installer on the iTX Desktop Client and then the Framework Server. 
The Output Server 2 channels are updated afterwards as described below. 

Upgrading the Output Server 2 Channels
Often system administrators prefer to try a new version of the iTX software on a backup 
channel while still running an existing version on the main channel. In such cases, we 
require that the channel called -BACKUP be upgraded before the main channel; otherwise 
the two channels will not be able to communicate with one another.

After running the installer on the -BACKUP channel and the upgrade is complete, the server 
will be running an instance of the Channel Controller service called [channel name]-
NETWORK and a TXPlay channel which will now be called [channel name]-BACKUP-TXP.

There is no need to change the views used by the Channel Selector control in the iTX 
Desktop at this stage. Even though the -BACKUP TXPlay has been renamed, the commands 
that are sent from the iTX Desktop to [channel name]-BACKUP will all be handled by the 
new Channel Controller service.

At this point, the iTX Desktop’s Channel Monitor control for the -BACKUP channel should be 
updated to monitor the channel called [channel name]-BACKUP-TXP (rather than [channel 
name]-BACKUP).

When you are ready to upgrade the main channel, failover to the -BACKUP channel and 
then run the installer on the main channel. As part of the upgrade, the TXPlay on the main 
channel will be renamed to [channel name]-TXP. This means that it can no longer be 
selected using the Channel Selector control in the iTX Desktop. Therefore the views in the 
iTX Desktop must be immediately updated as described below.

Updating the Channel Views
A new Upgrade Management Tool has been added to the iTX Framework Server to 
automate the updating of Channel Views to include the [channel name]-NETWORK channel 
and also to update any references within the views from [channel name] to [channel name]-
TXP. 

Note: This upgrade sequence only applies to the first-time you upgrade the 
system from 2.10 to 2.11. Subsequent updates (2.11 GA to 2.11 SP1+) or 
upgrades (2.11 GA to 2.12+) return to the usual installation order of 
Framework Server, Output Server 2 and then iTX Desktop.

Note: When a View is automatically updated to [channel name]-TXP, it 
updates the channel name that is stored within the View, not the alias for 
the channel. The list of channels will look the same in the Channel 
Selector after the tool has been run if the channel has an alias. However, 
if the channel does not have an alias, then the name will now have -TXP 
appended to it.
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To update the Channel Views using the Upgrade Management Tool
1 Ensure that the iTX Desktop Client, Framework Server and Output Server 2 

components have all been upgraded to a release version of iTX 2.11 (or newer).
2 On the Framework Server, open the Upgrade Management Tool from the Windows 

Start Menu > iTX 2.0 > Upgrade Management Tool.
The Upgrade Management Tool window appears.

3 In the Channel field, click the Select Channel button to navigate to and select an 
existing channel name.
After selecting the channel, the remaining fields Upgrade Management Tool are 
automatically filled in.

4 Click the Upgrade All button.
5 Click Yes to confirm that you want to proceed with the upgrading of the channel views. 

All of the Views listed in the Views Affected field are automatically updated with the 
Network channel(s) and TXPlay channel names.

Update Application Configurations
After completing the upgrade from iTX 2.10 (or earlier) to 2.11 (or later), there are some 
applications that require configuration updates. There is no need to change the TXPlay 
Config, even though the name of the TXPlay service has been changed to have -TXP 
appended to the name. If any of the following services are in use, then they require 
configuration updates:

• Missing Materials
If the Missing Materials service is configured to monitor TXPlay channels, it must be 
changed to monitor the equivalent -NETWORK channels.

• Channel Monitor Controls
The Channel Monitor controls in the iTX Desktop must be updated to monitor the -
TXP channels.

• GSM Gateway

Note: The Downgrade All button on the Upgrade Management Tool can 
be used to revert Channel Views that have been previously upgraded to 2.11.
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GSM Gateway must be configured to monitor the -TXP channels. Note that the 
channel names within the data sent out to iControl will not change (i.e. the -TXP is 
stripped off, so no changes are required in iControl).

• Xml Adapter
The XmlAdapter configuration must be changed to reference [channel name]-TXP.

• Preview Channel Desktop Layout
The Preview Channel layout in the iTX Desktop must be updated so that the 
channel used for preview is now -NETWORK channel.

• Studio Countdown application
The Studio Countdown configuration must be updated to use the -NETWORK 
channel; except when monitoring a main and backup channels separately, in which 
case it should be updated to point to the main and backup -TXP channels.
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This chapter explains how to add each type of channel to an iTX system, via the iTX Channel 
Config dialog for TXPlay 2, and the basic rules for ensuring your combination of channels 
and playout servers provide a solid resilience model.

For detailed information on setting up an iTX system, refer to the iTX System Administration 
Guide.
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Channel Resiliency Guidelines
When adding channels to an iTX system consider the following guidelines:

• Backup channels should be kept on separate playout servers from their main channels. 
• If your playout servers have Corvid 44 or 88 video/audio I/O cards or a dedicated 

streaming network adapter, a dual channel playout type can be used transmit the main 
for one channel and backup for a different channel. For example:

• Playout Server 1 runs channel A main and channel B backup.
• Playout Server 2 runs channel B main and channel A backup.

• A simulcast channel does not provide redundancy for a main channel. If a main channel 
fails, its simulcast follower also fails. Therefore, it is acceptable to run a main channel 
and its simulcast channel on the same playout server. 
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About the iTX Channel Config Dialog
The basic details for the channel (or channels) you want to run on a playout server are 
created using TXPlay 2’s iTX Channel Config dialog. From here you can define the channel 
name, playout type, channel type and whether or not to use Vertigo XG graphics or the 
legacy Softel subtitle drivers for external Softel subtitlers. 

This dialog appears during the installation of Output Server 2 and can also be accessed 
independently using the TXPlay 2 Config shortcut on your playout server’s Windows 
desktop.
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The table below describes the features of the iTX Channel Config dialog:

Field Description

SDI Device Read only field that displays the name of your current SDI video/audio I/O 
card.

Playout Type This drop-down list contains the available playout types for the 
video/audio I/O card currently installed in the playout server. 
The available playout types are:
• Dual channel
• Dual Fill & Key
• Dual live
• Dual live + Fill & Key
• Simulcast
• Simulcast + Fill & Key
• Single channel
• Single channel (4K) — SDI only
• Single channel (4K 2SI)
• Single channel + Fill & Key
• On-Demand
For each playout type there is a version for combined SDI and IP targets 
and a version for IP only targets. The playout type you select here 
determines what other fields and options are displayed.

Channel Name This field has two functions:
When creating channels, use this field to enter a name to identify the 
channel. When entering names the following rules must be followed:
• Each channel name must be unique.
• You cannot enter hyphens or minus symbols (-).
• Backup and Simulcast channels must have the same name as their main channel.
• To define a channel as a region or sub channel, add the # character followed by 

the output ID, which must be a single digit from 1 to 8 (e.g. channelname#1).
If one or more channels have already been created, this field becomes a 
drop-down list containing the names of the existing channels. These 
names include any suffixes that are applied when Backup or Simulcast 
are checked.
Note:
An alias for the Channel Name can be created in iTX Desktop to provide a 
user friendly channel name within the Channel Control layouts. For more 
information see the iTX System Administration Guide.

Backup Checking this option identifies the channel as a backup channel and adds 
the suffix -BACKUP (in gray) to the name in the Channel Name drop-
down list.

Simulcast Checking this option identifies the channel as a simulcast channel and 
adds the suffix -SIM (in gray) to the name in the Channel Name drop-
down list. This option is only available if a simulcast playout type is 
selected.

Output 1
Output 2

Sets the Output Target for each channel.
• Output 1 can be set to SDI, IP 2022-2, IP 2022-6, Http Live Streaming (HLS) or 

Real-time Messaging Protocol (RTMP). 
• Output 2 can be set to None, IP 2022-2, IP 2022-6, Http Live Streaming (HLS) or 

Real-time Messaging Protocol (RTMP). 
See About Output Targets (SDI and IP), on page 3 for more information.
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External DVB Allows for output over IP TSNetwork 2 packets containing DVB compliant 
packets to External iTX SubMux. Using this route, iTX renders the subtitles 
into bitmaps before forwarding them to the Submux. This adds them to 
the DVB Subtitle PID using the PCR supplied to the Submux in the 
incoming GIGs Transport stream. The resulting PID is then forwarded onto 
the downstream multiplexer for inclusion in the full transport stream for 
broadcast.

External SCTE-27 Allows for output over IP TSNetwork 2 packets containing SCTE-27 
compliant packets to External iTX SubMux. Using this route, iTX renders 
the subtitles into bitmaps before forwarding them to the Submux. This 
adds them to the SCTE-27 Subtitle PID using the PCR supplied to the 
Submux in the incoming GIGs Transport stream. The resulting PID is then 
forwarded onto the downstream multiplexer for inclusion in the full 
transport stream for broadcast.

Additional 
Channels
• Edit channel

Check this option to create an edit channel alongside the current channel. 
Edit channels can be used for off air schedule management.

Additional 
Channels
• Live channel

Check this option if you need to play out ad hoc schedule events using the 
Live Control on iTX Desktop

Integrated XG Check this option if the playout server features integrated Grass Valley 
Vertigo XG graphics solution (often called XG Inside).
For more information about configuring XG Inside, see the Vertigo XG 
Inside User Manual.

Use Dedicated 
Softel Driver

By default, Output Server 2 uses a legacy driver for external Softel 
subtitles. Check this option to enable the updated driver, which supports 
Softel Swift TX Classic, Softel Swift mTX and Softel Swift mTX Multi-
Language external subtitlers.

Use SMPTE ST 
2059 (PTP)

Select the Use SMPTE ST 2059 (PTP) check box if you wish to 
synchronize playout on your Output Server using SMPTE ST 2059 (PTP).
When this option is selected, the PTP client is started and managed by the 
Server Controller on the Output Server (the PTP client is always 
automatically installed with Output Server 2).

Configure for High 
Bit Rate

To support high bitrate playout, the relevant network adapter is 
automatically configured to support a higher throughput when a IP-2022-
6 option is selected as the Output Target Type in the server's iTX Channel 
Config dialog. This option can be disabled by unchecking the Configure 
for High Bit Rate checkbox. This option is unchecked by default for IP-
2022-2.
High bitrate playout also requires that the System Time be synchronised 
with a PTP master clock. As such, a PTP client is also automatically 
installed and started by the Server Controller when an IP option is the 
selected Output Target Type.

Add Extra Channel If you have selected a playout type that supports multiple channels on a 
single playout server (such as dual channel or simulcast), click Add Extra 
Channel to create the additional channels.

Field Description
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During a new installation of Playout Server 2, TXPlay 2’s iTX Channel Config dialog appears 
so that you can create your first channel. Whether this is a main, backup or simulcast 
channel depends on how you wish to configure your iTX system.

To create an initial channel during installation:
1 Before the installation of Output Server 2 completes, the ITX Channel Config dialog for 

TXPlay 2 Config appears.
2 On the Playout Type drop-down list, select the required playout type. 

For the main channel in any iTX system, the default single channel Playout Type can be 
used. If another playout type is required, select it from the drop down list.

3 In the Channel Name field, enter the a name to identify the channel. 
4 In the Output 1 drop down list, select one of the following output targets:

• SDI
• IP 2022-2
• IP 2022-6 (if IP 2022-6 is not already slected in Output 2 field)
• Http Live Streaming (HLS)
• Real-time Messaging Protocol (RTMP)

5 In the Output 2 drop down list, select one of the following targets:
• None
• IP 2022-2
• IP 2022-6 (if IP 2022-6 is not already slected in Output 1 field)
• Http Live Streaming (HLS)
• Real-time Messaging Protocol (RTMP)

6 Check the following fields, as required:
• Backup
• Simulcast (if present)
• Edit channel (if present)
• Live channel (if present)
• Integrated XG
• Use Dedicate Softel Driver (only required for external Softel subtitlers)
• Use SMPTE ST 2059 (PTP)
• Configure for High Bit Rate

7 Click SAVE. 

Remove Channel Remove the currently selected channel. 

Save Any changes you make to a channel are only applied when you click Save. 
This includes channel deletions.

Field Description

Note: The fields that are available are determined by the selected Playout 
Type.
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The iTX Channel Config window closes. 
8 Configure the channel’s playout settings according to your playout requirements.

This is covered in the following chapters:
• About Channel Communication and Routing, on page 53.
• Configuring Channel Playout, on page 63.
• Configuring Audio Output, on page 73.
• Configuring Splice Insert Processing, on page 91.
• Configuring Optional Plugins and Functionality, on page 97.

Adding a Backup Channel to an iTX System
If you are creating a main/backup setup, you need to add the backup channel on a separate 
playout server from the main channel. This ensures the backup channel is unaffected in the 
event of the main channel failing.

To add a backup channel on its own playout server:
1 If is it not currently running, start TXPlay 2 Config by double-clicking on the TXPlay 2 

Config icon on the Windows desktop. 
The iTX Channel Config dialog appears.

2 The Playout Type drop-down list will default to a single channel type. For a backup 
channel in a typical main/backup setup a single channel type is recommended.

3 In the Channel Name field, enter the same channel name as the main channel.
4 In the Output 1 drop down list, select one of the following output targets:

• SDI
• IP 2022-2
• IP 2022-6 (if IP 2022-6 is not already slected in Output 2 field)
• Http Live Streaming (HLS)
• Real-time Messaging Protocol (RTMP)

5 In the Output 2 drop down list, select one of the following targets:
• None
• IP 2022-2
• IP 2022-6 (if IP 2022-6 is not already slected in Output 1 field)
• Http Live Streaming (HLS)
• Real-time Messaging Protocol (RTMP)

6 Check Backup. 
The Channel Name field now displays the name you entered followed by -BACKUP, e.g. 
ITX1-BACKUP.

7 Check the following fields, as required:
• Edit channel
• Live channel
• Integrated XG
• Use Dedicate Softel Driver (only required for external Softel subtitlers)
• Use SMPTE ST 2059 (PTP)
• Configure for High Bit Rate
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8 Click SAVE. The iTX Channel Config window closes. 
9 If you are adding a backup channel as part of an installation, complete the installation 

as normal.
10 The configuration of a backup mirrors that of their main channel. Within the Output 

Server user interface, any configuration changes on the main channel are automatically 
applied to the backup and vice versa.
This is covered in the following chapters:

• About Channel Communication and Routing, on page 53.
• Configuring Channel Playout, on page 63.
• Configuring Audio Output, on page 73.
• Configuring Splice Insert Processing, on page 91.
• Configuring Optional Plugins and Functionality, on page 97.

11 In the iTX Desktop, open the iTX Central Configuration layout and add the Backup 
channel to the Network channel. See Assigning Channels to the Channel Network on 
page 51.

Adding a Simulcast Channel to an iTX System
A simulcast channel can be created for any existing channel, providing the playout server 
has a compatible video/audio I/O card installed. For more information see Playout Type 
Support, on page 7.

To add a simulcast channel to its own playout server:
1 If is it not currently running, start TXPlay 2 Config by double-clicking on the TXPlay 2 

Config icon on the Windows Desktop. 
The ITX Channel Config dialog appears.

2 On the Playout Type, select one of the following types:
• Corvid 44, Simulcast (allows both SDI and IP targets to be configured)
• Corvid 88, Simulcast (allows both SDI and IP targets to be configured)
• Corvid 88, Simulcast + Fill & Key (allows both SDI and IP targets to be 

configured)
• IP Only, Simulcast 

3 In the Channel Name field, enter the same channel name as the main channel.
4 In the Output 1 drop down list, select one of the following output targets:

• SDI
• IP 2022-2
• IP 2022-6 (if IP 2022-6 is not already slected in Output 2 field)
• Http Live Streaming (HLS)
• Real-time Messaging Protocol (RTMP)

Note: The steps below describe the process for creating a simulcast 
channel on its own playout server. To add a simulcast channel to a 
playout server that already has a channel configured on it, see Adding 
Extra Channels to a Playout Server, on page 46.
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5 In the Output 2 drop down list, select one of the following targets:
• None
• IP 2022-2
• IP 2022-6 (if IP 2022-6 is not already slected in Output 1 field)
• Http Live Streaming (HLS)
• Real-time Messaging Protocol (RTMP)

6 Check Simulcast. 
The Channel Name field now displays the name you entered followed by -SIM, e.g. 
ITX1-SIM.

7 Check the following fields, as required:
• Integrated XG
• Use Dedicate Softel Driver (only required for external Softel subtitlers)
• Use SMPTE ST 2059 (PTP)
• Configure for High Bit Rate

8 Click SAVE. 
The iTX Channel Config window closes.

9 If you are adding a simulcast channel as part of an installation, complete the 
installation as normal.

10 The configuration of a simulcast channel should match their main channel, with the 
following differences:

• Set the main channel to a HD resolution (e.g. 1080i) and the simulcast channel to 
an SD resolution (e.g. 625).
See Selecting the Channel Resolution and Frame Rate on page 64.

• Configure the aspect ratio to the requirements of the main and simulcast channels 
independently. For example, being HD, the main channel may need an aspect ratio 
of 16:9, while the simulcast channel, which is SD, may only need an aspect ratio of 
4:3.
For more information see the iTX System Administration Guide.

• On the simulcast channel, define event substitution rules to swap HD logos, stills 
and CGs for their SD counterparts.
See About Event Substitution Rules for Simulcast Channels on page 60.

• Configure the audio output to the requirements of the main and simulcast 
channels independently. For example, the main channel may use Dolby E 5.1, while 
the SD channel may only use PCM 5.1.
See Configuring Audio Output on page 73.

11 In the iTX Desktop, open the iTX Central Configuration layout and add the Simulcast 
channel to the Network channel. See Assigning Channels to the Channel Network on 
page 51.
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If you have a backup channel for your main channel, as well as a simulcast channel, it is 
recommended that you also add channel that is a backup of the simulcast channel. 

To add a simulcast backup channel to its own playout server:
1 If is it not currently running, start TXPlay 2 Config by double-clicking on the TXPlay 2 

Config icon on the Windows Desktop. 
The ITX Channel Config dialog appears.

2 On the Playout Type, select one of the following types:
• Corvid 44, Simulcast (allows both SDI and IP targets to be configured)
• Corvid 88, Simulcast (allows both SDI and IP targets to be configured)
• Corvid 88, Simulcast + Fill & Key (allows both SDI and IP targets to be 

configured)
• IP Only, Simulcast

3 In the Channel Name field, enter the same channel name as the main channel.
4 In the Output 1 drop down list, select one of the following output targets:

• SDI

• IP 2022-2

• IP 2022-6 (if IP 2022-6 is not already selected in Output 2 field)
• Http Live Streaming (HLS)
• Real-time Messaging Protocol (RTMP)

5 In the Output 2 drop down list, select one of the following targets:
• None
• IP 2022-2
• IP 2022-6 (if IP 2022-6 is not already slected in Output 1 field)
• Http Live Streaming (HLS)
• Real-time Messaging Protocol (RTMP)

6 Check Backup. 
The Channel Name field now displays the name you entered followed by -BACKUP, e.g. 
ITX1-BACKUP.

7 Check Simulcast. 
The Channel Name field now displays the name you entered followed by -BACKUP-
SIM, e.g. ITX1-BACKUP-SIM.

8 Check the following fields, as required:
• Integrated XG
• Use Dedicate Softel Driver (only required for external Softel subtitlers)
• Use SMPTE ST 2059 (PTP)

Note: The steps below describe the process for creating a simulcast 
backup channel on its own playout server. To add a simulcast backup 
channel to a playout server that already has a channel configured on it, 
see Adding Extra Channels to a Playout Server, on page 46.
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• Configure for High Bit Rate
9 Click SAVE. The iTX Channel Config window closes. 

10 If you are adding a simulcast backup channel as part of an installation, complete the 
installation as normal.

11 Simulcast backup channels should be configured in exactly the same way as the 
simulcast channel. 
For more information see Configuring the Channel Communication Setup, on page 59.

12 In the iTX Desktop, open the iTX Central Configuration layout and add the Simulcast 
Backup channel to the Network channel. See Assigning Channels to the Channel 
Network on page 51.

Adding Extra Channels to a Playout Server
If are going to operate multiple channels from a single playout server (i.e. a simulcast 
channel on the same playout server as the main channel), the extra channel can be added 
to your iTX system from the iTX Channel Config dialog in TXPlay 2 Config. 

To add an extra channel to a single playout server:
1 If it is not currently running, start TXPlay 2 Config by double-clicking on the TXPlay 2 

Config icon on the Windows Desktop. 
The ITX Channel Config dialog appears.

2 From the Playout Type drop-down list, select one of the following types:
• Simulcast 
• Simulcast + Fill & Key
• Dual Channel

The Add Extra Channel button appears at the bottom of the dialog.
3 In the Output 1 drop down list, select one of the following output targets:

• SDI
• IP 2022-2

• IP 2022-6 (if IP 2022-6 is not already slected in Output 2 field)
• Http Live Streaming (HLS)
• Real-time Messaging Protocol (RTMP)

4 In the Output 2 drop down list, select one of the following targets:
• None
• IP 2022-2

• IP 2022-6 (if IP 2022-6 is not already slected in Output 1 field)
• Http Live Streaming (HLS)
• Real-time Messaging Protocol (RTMP)

5 Click Add Extra Channel. 
The Add Extra Channel dialog appears.
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6 In the Channel Name field, type the basic name for the extra channel, as per the rules 
defined in About the iTX Channel Config Dialog, on page 38.

7 Define the channel’s function:
a If you are creating a backup channel, check Backup.
b If you are creating a simulcast channel, check Simulcast.
c If you are creating a simulcast backup channel, check both Backup and Simulcast.

8 Click OK. 
The Add Extra Channel dialog closes.

9 On the iTX Channel Config dialog, the Channel Name field is now a drop down list, 
which includes the new channel name with the appropriate suffixes in gray (e.g. -
BACKUP for a backup channel, -SIM for a Simulcast channel or both).
You can select each channel from the Channel Name drop-down list and configure 
them individually, as required.

10 Click SAVE. 
The iTX Channel Config window closes. 

11 If you are adding a channel as part of an installation, complete the installation as 
normal.

12 Apply any configuration that is required for your playout server. 
This is covered in the following chapters:

• About Channel Communication and Routing, on page 53.
• Configuring Channel Playout, on page 63.
• Configuring Audio Output, on page 73.
• Configuring Splice Insert Processing, on page 91.
• Configuring Optional Plugins and Functionality, on page 97.

13 In the iTX Desktop, open the iTX Central Configuration layout and add the channel to 
the Network channel. See Assigning Channels to the Channel Network on page 51.

Creating a Dual Channel iTX System
iTX allows for two different channels to operate on a single playout server (for example 
channel A main and channel B backup), providing it is installed with a compatible 
audio/video I/O card. For more information see Playout Type Support, on page 7. 

To create a dual channel system on a single playout server:
1 If is it not currently running, start TXPlay 2 Config by double-clicking on the TXPlay 2 

Config icon on the Windows Desktop. 
The ITX Channel Config dialog appears.
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2 From the Playout Type drop-down list, select Dual Channel.
3 Add the first channel, as described in Creating an Initial Channel During Installation, on 

page 41.
4 Click Add Extra Channel. The Add Extra Channel dialog appears.
5 Fill-in the Add Extra Channel dialog, as described in Adding Extra Channels to a 

Playout Server, on page 46.
6 Apply any playout configuration that is required for your playout server. 

This is covered in the following chapters:
• About Channel Communication and Routing, on page 53.
• Configuring Channel Playout, on page 63.
• Configuring Audio Output, on page 73.
• Configuring Splice Insert Processing, on page 91.
• Configuring Optional Plugins and Functionality, on page 97.

Creating a Dual Live Channel
A dual live channel has two live inputs into a single playout server, which are then played 
out via a single output. For this, the playout server must be installed with a compatible 
audio/video I/O card. For more information see Playout Type Support, on page 7. 

To create a dual live channel:
1 If is it not currently running, start TXPlay 2 Config by double-clicking on the TXPlay 2 

Config icon on the Windows Desktop. 
The ITX Channel Config dialog appears.

2 From the Playout Type drop-down list, select Dual Live or Dual Live + Fill & 
Key.

3 Create the channel, as described in Creating an Initial Channel During Installation, on 
page 41.

4 Apply any playout configuration that is required for your playout server. 
This is covered in the following chapters:

• About Channel Communication and Routing, on page 53.
• Configuring Channel Playout, on page 63.
• Configuring Audio Output, on page 73.
• Configuring Splice Insert Processing, on page 91.
• Configuring Optional Plugins and Functionality, on page 97.

5 Configure the routing so the channel has two live inputs. See About Video Signal 
Routing on page 53.

6 From the Asset layout in iTX Desktop, create a live asset. This can then be scheduled for 
playout on the channel. For more information see the iTX Desktop Operator guide.

Adding and Configuring Regional and Sub channels
For a system that requires content to be played out to several regions simultaneously, you 
can include a combination of up to 8 regional or sub channels per channel network. 
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To add and configure regional (including sub channels) to your iTX system
1 On the playout server hosting the main channel, add and configure a Main channel 

according to your playout requirements. See Process Overview - Output Server 2 
Installation and Channel Configuration, on page 17.
We recommend that you take note of the Main channel’s playout configuration settings 
since you will need to replicate them when configuring the regional channel in step 3 
below.

2 On each playout server hosting a regional, use the TXPlay2 Config (iTX Channel Config 
dialog) to add a channel to the system. 
Ensure that the Channel Name setting for each regional channel uses the main 
channel’s name followed immediately by the # character and then the output ID, which 
must be a single digit from 1 to 8 (e.g. mainchannelname#1, mainchannelname#2). See 
About the iTX Channel Config Dialog, on page 38.

3 On the playout servers hosting the regional channels, configure each regional channel 
so that the channel configuration settings are identical to those of the Main channel.

a In the I/O Device Controller’s Configuration page, set the Reference, Frame Rate 
Family and MainInput fields to exactly match the Main channel’s settings. See Setting 
an SDI Reference Source and Frame Rate Family, on page 63.

b On the Channel tab of the Output Server 2 user interface, set the Resolution field 
to match that of the Main channel. See Selecting the Channel Resolution and 
Frame Rate, on page 64.

c Configure the regionals channel to match the Main channel’s playout configuration 
settings. Return to the configuration performed in step 1 above for the specific 
settings.

4 In the iTX Desktop, add the regional channel to a channel Views and specify an 
appropriate alias name for each of the regional channels. See “Setting up a channel 
view” and “Channel Config 1 – for all channel types” in the iTX System Administrator 
Guide. 

5 In the iTX Desktop, select the View that lists the regional channels and configure the 
Routing settings for each of the regional channels. See Configuring the Channel 
Communication Setup on page 59 and “Channel Config 3 - for playout channels” in the 
iTX System Administrator Guide.

6 Restart all the iTX services on each of the playout servers.
7 In the iTX Desktop, select the Network Channel in the channel View and click the Select 

Tracks button above the Timeline component to ensure that the Output tracks are 
displayed in the Timeline. 

8 In the iTX Desktop, open the iTX Central Configuration layout and add the regional 
channel(s) to the Network channel. See Assigning Channels to the Channel Network on 
page 51.

IMPORTANT
Each regional or sub channel must run on its own instance of Output Server 
2 and must be configured relative to the Main channel.
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Network
After the Main channel and its associated channels (backup, simulcast, regional, sub-
channels) have been added to the iTX domain (see Adding Channels to an ITX Playout 
Server, on page 37), you must assign the channels to the Channel Network by adding them 
to the Channel Controller configuration. Adding the associated channels allows the 
Channel Controller to control and manage items to be played out on the associated TXPlay 
channels from a single schedule. 

To assign channels to the Channel Network
1 Start the iTX Desktop on a client PC and login with an Administrator profile.
2 Open the Configuration layout.
3 Click Configure Channel Controller.

The Manage Channel Controller page appears and lists the channels currently 
registered with the Channel Controller.

4 Click Edit next to the channel to be configured.
The channel’s current Channel Controller configuration is displayed.

5 Select the Network tab and perform the following as required:
• If the Main channel has a backup channel (see Adding a Backup Channel to an iTX 

System, on page 42), click Add Backup in the Primary channels section. A backup 
channel is added to the primary channel list.

• For a system that requires content to be played out in HD and SD formats 
simultaneously (see Adding a Simulcast Channel to an iTX System, on page 43), 
click Add Simulcast in the Simulcast channels section to add the simulcast 
channel to the channel network.
If the simulcast channel has a backup channel (see Adding a Simulcast Backup 
Channel to an iTX System, on page 45), click Add Backup in the Simulcast 
channels section. A simulcast backup channel (-Backup-TXP) is added.

• For a system that requires content to be played out to several regions 
simultaneously, (see Adding and Configuring Regional and Sub channels, on 
page 48), click Add Region or Sub Channel in the Regional channels section to 
add the regional or sub channel to the channel network. 
For Sub channels, select a Live asset from the Choose a Live Asset for Substitution 
list. This setting identifies the name of the live asset that will be used to substitute 
for the primary channel content.
If a regional or sub channel has a backup channel, click Add Backup to the right-
side of the channel. A backup channel (-Backup-TXP) is added immediately below 
the regional/sub channel.

6 If you are configuring your iTX system for dual-site channel control, then select the 
Dual Site tab and perform the following:

a Check Enable Dual Site.
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b Set the Main channel’s Location field to the domain that is hosting the backup 
channel (Site B).

c Set the Backup channel’s Location field to the domain that is hosting the Main 
channel (Site A).
Please refer to the “iTX Dual-site Channel Control Configuration Guide” for more 
information about configuring the controls on the Dual Site tab.

7 Click Save.
A message appears informing you that the configuration will only take affect after 
restarting the Channel Controller.

8 Click OK.
9 Restart the Channel Controllers on the Main and Backup channel and perform any 

playout configuration that is required for your playout server.
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Routing
This section explains how to setup the routing for a playout server using an existing 
video/audio matrix router. It does not explain how to install or configure a matrix router or 
the supporting iTX services.

For more information on installing and configuring matrix routers, refer to the “Using iTX 
with a Matrix Router” section of the iTX System Administrator Guide.

The guidance in this section is for an iTX playout server with live inputs, however some 
information is also applicable to an iTX server running the Encode service for ingest or both 
the Encode service and Output Server 2 service for ingest and playout.

For more information on setting up an ingest server, refer to the “Preparing Encode Server 
machines” section of the iTX System Administrator Guide.
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About Video Signal Routing
A video/audio router (also known as a matrix router or just matrix) allows a video signal 
source (such as a live satellite feed) to be connected to a destination, such as a playout 
server. The output from the sources are connected to inputs on the router and the outputs 
on the router are connected to inputs on the destinations. The router then allows any 
source to be routed to any destination and vice versa; these connections are known as 
crosspoints. An iTX server can act as a source (playout server), a destination (ingest server) 
or both (playout with live inputs), depending on your requirements.

For example, the live feed from a satellite would be a source and a transmission system 
would be a destination. In between you may want an iTX server (for example, so that the 
satellite feed can be recorded or breaks inserted), before being sent to the transmission 
system. In this scenario, the live satellite feed is routed to the inputs of a playout/ingest 
server (acting as a destination) via the matrix router and the output from the playout/ingest 
server (acting as a source) can then be routed to the transmission system via the same 
router.

Note: Some of the following configuration only applies to SDI output 
targets and some only applies to IP output targets. Where configuration 
is specific to an output target it is stipulated in the heading.
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Figure 6-1 on page 54 illustrates how source and destinations can be routed to one another, 
via crosspoints on the matrix router. The diagram also shows how the example above 
would be routed, with the live satellite feed being used as an input source to the 
playout/ingest server (ITX1),which is then routed to the transmission system.

Fig. 6-1: How channel sources and destinations connect to a matrix router.

There can be multiple sources, destinations and even routers in an iTX system. To ensure a 
playout/ingest server is receiving and sending the correct signals, iTX needs to know the 
following:

• Which router to use
• The destinations (i.e. to which router outputs are the inputs on the video/audio I/O card 

connected)
• The channel outputs (i.e. to which router inputs are the outputs on the video/audio I/O 

card connected)

How a channel's routing is configured also depends on the playout type. For example, 
simulcast channels share an input, so the playout server acts as a single destination; dual 
live input requires two inputs, so the playout server acts as two destinations (i.e. two 
different outputs on the router connect to two different inputs on the video/audio I/O 
card).

The playout server’s inputs are configured from within the Router Connections tab in the 
I/O Device Controller, while the channel outputs are configured in the Channel Config pop-
up layout in iTX Desktop. 

Assigning SDI Matrix Destinations to Channel Inputs
In the I/O Device Controller user interface, under Configuration > SDI is a Routing section, 
which is used to assign each channel input to a destination on a matrix router. 
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The inputs that are available correspond to the model of video/audio I/O card in your 
playout server and the playout type you selected in TXPlay2 Config. For example, a Corvid 
88 video/audio I/O card shows the following inputs for each playout type:

Playout type Inputs Router configuration

Single channel • Channel A Main Input Single router, with a single destination

Single channel 
(4K)

• Channel A Main Input 1
• Channel A Main Input 2
• Channel A Main Input 3
• Channel A Main Input 4

Single router, with four destinations.
Note: 4K input is only supported by AJA Corvid 88 
SDI audio/video I/O cards.

Single channel 
4K 2SI

• Channel A Main Input 1
• Channel A Main Input 2
• Channel A Main Input 3
• Channel A Main Input 4

Single router, with four destinations.
Note: 4K input is only supported by AJA Corvid 88 
SDI audio/video I/O cards.

Single channel 
+ Fill & Key

• Channel A Main Input 1
• Channel A Fill & Key Input 

Fill
• Channel A Fill & Key Input 

Key

Single router, with a single destination.
Note: In addition to the standard SDI routing 
configuration, Fill & Key channels also require a 
paired destination comprised of the Fill & Key 
signals. This is configuration is performed on the 
router itself.

Dual Fill & Key • Channel A Main Input
• Channel A Secondary Input
• Channel A Fill & Key Input 

Fill
• Channel A Fill & Key Input 

Key
• Channel A Fill & Key B Input 

Fill
• Channel A Fill & Key B Input 

Key

Up to two routers, with two separate 
destinations.
Note: In addition to the standard SDI routing 
configuration, Fill & Key channels also require two 
paired destinations comprised of the Fill & Key 
signals. This configuration is performed on the 
router itself.

Dual channel • Channel A Main Input
• Channel B Main Input

Up to two routers, with two separate destinations

Dual live • Channel A Main Input
• Channel A Secondary Input

Up to two routers, with two separate destinations

Dual live + Fill 
& Key

• Channel A Main Input
• Channel A Secondary Input
• Channel A Fill & Key Input 

Fill
• Channel A Fill & Key Input 

Key

Up to two routers, with two separate 
destinations.
Note: In addition to the standard SDI routing 
configuration, Fill & Key channels also require a 
single paired destination comprised of the Fill & 
Key signals. This configuration is performed on 
the router itself.

Simulcast • Channel A Main Input / 
Channel B Main Input

Single router, with a single destination

Simulcast + 
Fill & Key

• Channel A Main Input / 
Channel B Main Input

• Channel A Fill & Key Input 
Fill

• Channel A Fill & Key Input 
Key

• Channel B Fill & Key Input 
Fill

• Channel B Fill & Key Input 
Key

Single router, with a single destination.
Note: In addition to the standard SDI routing 
configuration, Simulcast Fill & Key channels also 
require two paired destinations comprised of the 
Fill & Key signals for each channel (A & B). This is 
configuration is performed on the router itself.
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To assign matrix destinations to inputs on the SDI I/O card:
1 On the server running the Output Server 2 system, maximize the I/O Device Controller 

service.
2 Select the Configuration > SDI tab.

The routing configuration appears, with a set of controls for each active input on the 
video/audio I/O card.

3 For each input, use the Matrix field to select the matrix router (or router bridge) with 
the required destination.

4 For each input, use the Destination field to select the router destination to which the 
transmission system receiving the channel output is connected.

The table below describes how different channel types and pairings should be routed. 
Note that the details below also apply to channels with + Fill & Key inputs. 

5 Click Save.
6 If the channel type includes Fill & Key inputs, then configure the Fill & Key sources for 

each channel using the Fill & Key Plugin in the iTX Desktop. See Assigning Fill & Key 
Sources to a Channel on page 57.

7 Now configure the output for each channel from the iTX Desktop. See Assigning Matrix 
Sources to Channel Outputs on page 58.

Note: If you are using a hardwired router for testing purposes, you can only 
connect one destination to it and you cannot mix router systems.

Channel types Matrix destination

Main and backup pair Connect both channels to the same matrix and 
destination

Simulcast and simulcast backup pair Connect both channels to the same matrix and 
destination

Main and simulcast pair Connect both channels to the same matrix and 
destination

Backup and simulcast backup pair Connect both channels to the same matrix and 
destination

Dual channel pair Connect channel A main input and channel B main 
input to separate matrix destinations

Dual live channels Connect channel A main input and channel A 
secondary input to separate matrix destinations

Dual live simulcast Connect channel A/B main input and channel A/B 
secondary input to separate matrix destinations. 
TXPlay 2 controls which input to use at any given 
time.

Backups of dual channels or dual live 
channels.

Connect each backup to the same matrix and 
destination as their main channel (e.g. channel A 
backup should be routed to the same matrix 
destination as channel A).
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Assigning IP Routing Matrix Destinations to Channel Inputs
Using the I/O Device Controller on the playout server, you must assign one or more 
destinations from the IP Router Matrix to each input channel.

The IP Routing tab on the I/O Device Controller provides a collapsible section for each of 
the device’s input channels as determined by the Playout Type you selected in the TxPlay 2 
Config. 

The connection name and IP address of the available network adapter’s connections is 
automatically detected and displayed.

To assign an IP Routing Matrix destination to the channel input on the playout server:
1 On the server running the Output Server 2 system, maximize the I/O Device Controller 

service.
2 Select the Configuration > IP tab.
3 In the input channel’s panel (e.g. Channel A, Channel B or Channel A/B), click the 

Show/Hide button  to display the channel’s current IP Input assignments.
4 Click the Add new IP Input button and a new IP-INPUT-# line is added.
5 From the Matrix drop-down list, select IP Matrix.
6 Click the Destination button.
7 From the Select Destination window, select the destination from the IP Router Matrix 

that you would like to be delivered to the channel’s input.
8 Click OK and the destination name is added to the channel’s IP-Input’s Destination text 

box.
9 Optional: Repeat step 4 to step 8 to add addition inputs to the streaming network 

adapter. 
10 Click Save.

Assigning Fill & Key Sources to a Channel
As well as configuring the matrix router Fill & Key destinations from I/O Device Controller, 
you must assign the Fill & Key sources to the channel. This is performed in iTX Desktop, from 
the Channel Config pop-up on the Engineering layout.

To assign Fill & Key sources to the channel:
1 Start the iTX Desktop on a client PC and login with an Administrator profile.
2 Open the Engineering layout.
3 Click Channel Config. 

Playout Type Inputs

Single Channel (including 4K and 4K 2SI) • Channel A

Dual Channel • Channel A 
• Channel B 

Simulcast • Channel A/B

Dual Live • Channel A 
• Channel A
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The Channel Config pop-up layout appears.
4 From the View list, select the view with the channels to be configured.
5 Select a TXPlay channel to configure.
6 Click the Plugins tab and then the Fill & Key tab.

7 From the Matrix field, select the matrix router with the required Fill & Key source inputs.
8 From the Source field, select the paired source comprised of the Fill & Key signals.

9 If your channel is configured as a Dual Fill & Key playout type, then set the Matrix B 
and Source B fields. Otherwise leave these fields set to Not Configured.

10 Click Save and then Close.

Assigning Matrix Sources to Channel Outputs
As well as configuring the matrix router destinations from I/O Device Controller, you must 
assign the matrix router sources to channel outputs. This is performed in iTX Desktop, from 
the Channel Config pop-up on the Engineering layout.

To assign matrix sources to channel outputs:
1 Start the iTX Desktop on a client PC and login with an Administrator profile.
2 Open the Engineering layout.
3 Click Channel Config. 

The Channel Config pop-up layout appears.
4 From the View list, select the view with the channels to be configured.
5 Select a TXPlay channel to configure.
6 Click the Channel Config 3 tab, which contains the Routing panel. 

7 From the Matrix field, select the matrix router (or router bridge) with the required 
source inputs.
This must be the router to which the transmission system receiving the channel output 
is connected and is typically the same matrix that is configured in the Router 
Configuration panel of the I/O Device Controller.

8 From the Channel Output field, select the router source input the channel output is fed 
into.
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9 From the Channel Output 2 field, select any router source input you want to monitor.
This option is useful for monitoring a live video signal for a pass-through channel that is 
being fed into a separate playout/ingest server.

10 Click Save and then Close.

Selecting the Default Live Asset for the Channel
Where a fixed router source is used for a number of different live assets that are unknown to iTX, 
a default live asset can be substituted in each case without changing the unique names of the 
original live assets. This is performed in iTX Desktop, from the Channel Config pop-up on the 
Engineering layout. 

To select the default live asset for the channel:
1 Start the iTX Desktop on a client PC and login with an Administrator profile.
2 Open the Engineering layout.
3 Click Channel Config. 

The Channel Config pop-up layout appears.
4 From the View list, select the view with the channels to be configured.
5 Select a channel to configure.
6 Click the Channel Config 3 tab, which contains the Routing panel.
7 Click the Default Live Asset button and use Pinpoint to perform a Live Event search.
8 From the search results, select the name of the default live asset and click OK.
9 Click Save and then Close.

Configuring the Channel Communication Setup
In iTX Desktop you need to define the channel communication setup. This is critical for 
TXPlay2 to be able to identify its on air status.

As well as stating which channels are in a main/backup, simulcast or regional setup, the way 
in which the channels are routed is also critical to the configuration. This then allows a 
channel to be failed over using a downstream device equipped with a Grass Valley HCO 
change-over card. The way in which a pair of channels are configured depends on the 
channel types (i.e. the configuration for a simulcast channel is different to that for a dual live 
channel).

The communication setup is performed using the following options on the Channel Config 
pop-up, on the Engineering panel:

• Matrix selection field in the Routing section
• Channel Destination selection field in the Routing section
• Channel Output selection field in the Routing section

To configure the channel communication setup for a channel:
1 Start the iTX Desktop on a client PC and login with an Administrator profile.
2 Open the Engineering layout.
3 Click Channel Config. 

The Channel Config pop-up layout appears.
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4 From the View list, select the view with the channels to be configured.
5 Select a TXPlay channel to configure.
6 Click the Channel Config 3 tab.
7 From the Matrix field, select the matrix router (or router bridge) with the required 

sources and destinations.
This must be the router to which the transmission system receiving the channel output 
is connected and is typically the same matrix as was configured in the Router 
Configuration panel of the I/O Device Controller.

8 From the Channel Destination field, select an output on the matrix router that delivers 
the output of the main channel. This typically matches the destination that was 
configured in I/O Device Controller. 
The table below describes how different channel types and pairings should be routed.

9 For a main/backup setup, use the Channel Output to select the router input the 
channel output is fed into.

10 Click Save and then Close.

About Event Substitution Rules for Simulcast Channels
When using a simulcast channel, you can define a rule to determine when logo, CG and 
stills events scheduled on the main channel are substituted on the simulcast channel. For 
example, so that 4K or HD branded logos can used on higher resolution channels, without 
them appearing on the lower resolution simulcast channel. Only one rule can be defined 
for each simulcast pair and it is applied to all matching assets. 

Substitutions are defined on the Simulcast Channel Config panel by the suffix of the higher 
resolution asset name, the suffix of the lower resolution asset name or both. For example, if 
_HD is entered into the Original Suffix field and _SD is entered into the Substitution field, 

Channel types Channel destination

Main and backup pair Route both channels to the same matrix and destination

Simulcast and simulcast 
backup pair

Route both channels to the same matrix and destination

Main and simulcast pair Route both channels to the same matrix, but to different 
destinations

Regional/Sub channels Each regional/sub channel should be set with an 
independent channel destination.

Regional/sub and regional/sub 
backup pair

Route both channels to the same matrix and destination

Dual live channels Route to the matrix and destination specified in I/O 
device Controller.
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an asset called iTX-Logo_HD would be substituted for a file called iTX-Logo_SD before 
playing out on the simulcast channel.

Cascading Logo Replacement Rules
On playout, if a scheduled logo is defined in the Logo Setup plugin it will be substituted for 
its replacement before going to air. 

If you are running a Simulcast channel and the replacement logo then meets the criteria 
defined in the Simulcast Replacement Rules, a further replacement will be performed. 

This provides two levels of control for logo replacement, as illustrated by Figure 6-2.

Fig. 6-2: How logo replacement rules cascade in iTX Desktop

Note:
• If Logo or CG are selected for substitution, live logos and live captions are 

also be subject to the same replacement rules.
• Both the original and the substitution assets must be available on the 

media store for the substitutions to take place.
• If you are operating a simulcast backup channel, you must apply the same 

substitution rules on the simulcast backup channel as its simulcast 
channel it is paired with.
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For more information about logo replacement using the Logo Setup configuration, see the 
iTX System Administration Guide.

Defining an Event Substitution Rule for a Simulcast Channel

To define an event substitution rule:
1 Open the iTX Desktop and click the Engineering layout.
2 Click Channel Config. 

The Channel Config pop-up layout appears.
3 From the View list, select the view containing the channels to be configured. The 

channels associated with that view appear.
4 Click the name of the channel to be configured.
5 Click the Simulcast Channel Config tab.
6 In the Original Suffix field, enter the characters used to identify the higher resolution 

events. For example, for a HD/SD pair, enter _HD, while for a 4K/HD pair, enter _4K.
7 In the Substitution field, enter the characters used to identify the lower resolution 

events. For example, for a HD/SD pair, enter _SD, while for a 4K/HD pair, enter _HD.
8 As you type in the Original Suffix or Substitution fields, the For Example text updates 

to demonstrate how the rules will be applied. For example:

9 From the Available Plugins list, select which event types you want to substitute, then 
click >> to add them to the Selected Plugins list.

10 Click Save.

About GPI Devices and Simulcast Setups
As simulcast channels follow the Channel Controller’s schedule and commands (including 
GPI commands), there is no requirement to configure GPI devices for simulcast or simulcast 
backup channels.

IMPORTANT
The required assets must be prepared with the appropriate suffixes prior 
to being scheduled.

Original Suffix 
text

Substitution 
text For example text

(None) (None) AssetName Keep as AssetName

(None) _SD AssetName Append to Make AssetName_SD

_HD (None) AssetName_HD Remove to Make AssetName

_HD _SD AssetName_HD Replace with AssetName_SD 
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Configuring Channel Playout
There are essential configuration steps that must be followed for your channels to playout 
as expected. This includes the selecting the reference source and frame rate family, 
selecting the channel resolution, configuring timecode and Active Format Description 
settings, configuring the output target parameters and adjusting the channel timing and 
delay.
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Setting an SDI Reference Source and Frame Rate Family
If you are using an SDI video/audio I/O card, before configuring Output Server 2 you should 
confirm your I/O Device Controller has the correct reference source and, if required, frame 
rate family. You set the reference source and frame rate family from the Configuration > SDI 
tab of the I/O Device Controller user interface.

To set the reference source and frame rate family:
1 On the playout server running the Output Server 2 system, expand the I/O Device 

Controller. 
The I/O Device Controller user interface appears. 

2 Select the Configuration > SDI tab. 
The SDI configuration panel appears:

Note: Some of the following configuration only applies to SDI output 
targets and some only applies to IP output targets. Where configuration 
is specific to an output target it is stipulated in the heading.

Note: The Reference and Frame Rate Family for the channel must be 
specified from the I/O Device Controller user interface before a Resolution 
can be selected in the Channel tab of the Output Server 2 user interface. 
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Selecting the Channel Resolution and Frame Rate
If your playout server is equipped with dual Corvid LP video/audio I/O cards, there is a 
separate Reference, Frame Rate and Output Timing Control section for each card:

3 If you are using an external reference input: 
a From the Reference drop-down list, select External.

When the external reference input is connected to your video/audio I/O card, the 
frame rate family is locked to that of the reference. 

b Continue with Configuring IP Output Target Parameters, on page 68.
4 If you do not have an external reference:

a From the Reference drop-down list, select Freerun. 
b From the Frame Rate Family drop-down list, select a frame rate (e.g. 50.00 Hz). 

This determines the resolution you can set in the Channel tab of the Output Server 
2 Configuration user interface. See Selecting the Channel Resolution and Frame 
Rate on page 64 for more information.

5 Click Save to store your changes.

Selecting the Channel Resolution and Frame Rate
The resolution and frame rate for a channel is configured from the Channel tab of the 
Output Server 2 user interface.

Note: If you are not using an external reference input on your video/audio 
I/O card, you must set the Reference to Free Run and an appropriate Frame 
Rate Family for the playout server. Without a reference and frame rate family, 
the Output Server 2 service starts up in an error state. See Viewing the 
Output Server 2 Engineering Panel on page 138.
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To configure the Resolution and Frame Rate for an Output Server 2 channel:
1 On the playout server, expand the instance of Output Server 2 for the channel to be 

configured (e.g. ITX1 Output Server 2). 
The Output Server 2 user interface appears. 

2 Go to Configuration > Channel tab. 
The channel configuration options appear. The Resolution and Frame Rate controls are 
on the top left of the window.

3 The Frame Rate setting is determined by the Frame Rate Family setting I/O Device 
Controller configuration and cannot be changed from the Output Server 2 user 
interface.

4 Specify the Resolution for the channel using the drop-down list. For example, 1080p 
59.95Hz for NTSC full HD or 4K(QFHD) 59.94 for NTSC 4K). 
Note that the frame rates referenced within the Resolution settings are determined by 
the Frame Rate Family setting I/O Device Controller configuration.

5 If the Resolution setting is set to an SD resolution (525 or 625), then the SD Aspect 
Ratio setting is added to the Channel tab with a default value of 4x3.
The SD Aspect Ratio setting allows you to override the SD aspect ratio for compressed 
output when the channel’s Output Target is set to either IP2022-2, RTMP, HLS or the 
channel is configured for secondary record. 

• Select 4x3 if you want the picture aspect ration of your output to be 4x3. 4x3 clips 
will be played as-is and 16x9 clips will have a letterbox.

• Select 16x9 if you want the picture aspect ratio of your output to be 16x9. 16x9 
clips will be played as-is and 4x3 clips will have a pillarbox.

6 Click Save to store your changes and automatically reboot the Output Server 2 service.
Alternatively, wait until you have finished making changes in other areas of the 
Configuration panel, then click Save.

Configuring Channel Delay
A channel delay may be needed to adjust the output timing for transitions, such as when 
switching the output of a national channel into and out of regional sub-channels. For 
accurate transitions, the internal processing may need adjusting to take account of the 
throughput time of a live source. 

To configure the channel delay for an Output Server 2 channel:
1 On the playout server, expand the instance of Output Server 2 for the channel to be 

configured (e.g. ITX1 Output Server 2). 
The Output Server 2 user interface appears. 

2 Go to Configuration > Channel tab. 
3 In the Channel Delay (sec:ms) field, enter a value in seconds and milliseconds or use 

the spinner button.
4 Click Save to store your changes and automatically reboot the Output Server 2 service.
65



Configuring Channel Playout
Configuring SDI Timecode Settings (VITC, ATC, LTC, DVITC)
Alternatively, wait until you have finished making changes in other areas of the 
Configuration panel, then click Save.

Configuring SDI Timecode Settings (VITC, ATC, LTC, DVITC) 
So that media can be identified, synchronized and edited, timecodes are added to the 
ancillary data space of the television signal as media metadata. The way that timecodes are 
encoded and processed is different for SD and HD media and there are several formats, 
both current and legacy, for encoding timecodes. 

iTX supports VITC (Vertical Interval Timecode) times for SD media and ATC (ancillary 
timecode) timecodes for HD media. Both are configured from the Channel tab of the 
Output Server 2 user interface.

To configure timecode settings for an Output Server 2 channel:
1 On the playout server, expand the instance of Output Server 2 for the channel to be 

configured (e.g. ITX1 Output Server 2). 
The Output Server 2 user interface appears. 

2 Go to Configuration > Channel tab. 
The channel configuration options appear in the upper portion. 

3 Expand the VANC heading to expose the timecode options.
4 If the channel broadcasts SD content and you are using a VITC (Vertical Interval 

Timecode) generator, select the line numbers to use for VITC timecodes.
a For SD VITC Detection Line, select the line number to indicate the presence of 

timecode information to downstream devices.
b For SD VITC Insertion Line, select the line number on which the timecode 

information is placed.
5 If the channel broadcasts HD content, for HD ATC Source Type, use the drop-down list 

to select the source input for ancillary timecodes. The options are:
• LTC for linear timecode sources.
• DVITC for Digital Vertical Interval Timecode sources.

6 The HD ATC Output Type field defaults to LTC+DVITC. Currently, this is the only 
available setting.

7 The Time Code Mode field is used in conjunction with the Timecode Source setting on 
the iTX Desktop’s Channel Config 4 page. The Timecode Source setting determines if 
and how the Vertical Interval Timecode is inserted into media being played out on the 
channel. See the iTX System Adminstrator Guide for more information.
The Time Code Mode field allows you to choose whether the time code should 
continue incrementing when the end of the primary event is reached.

• Clip: Specifies that the time code will stop when the last frame of the video clip is 
reached. For live events, the time code stops when the end of the live event is 
reached, even though the live event continues to play out. Clip is the default 
setting.

• Continuous: Specifies that the time code will continue increment even when 
frozen on the last frame of the video clip. For live events, the time code will 
continue to increment.
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8 Click Save to store your changes and automatically reboot the Output Server 2 service.
Alternatively, wait until you have finished making changes in other areas of the 
Configuration panel, then click Save.

Configuring SDI Active Format Description Insertion Lines
Information about what area of a 16:9 HD video image should be preserved when it is 
downscaled to 4:3 SD is defined by Active Format Description (AFD) codes. These AFD 
codes are carried in the baseband signal coming into the video/audio I/O card and then 
interpreted by viewers’ televisions and set top boxes to display the required frame for each 
item in the schedule. The standards for AFD are defined by the Society of Motion Picture 
and Television Engineers (SMPTE) and Output Server 2 supports SMPTE Standards 2016 and 
RP186 AFD codes. 

You configure the lines on which AFD codes are inserted for each SMPTE standard from the 
Channel tab of the Output Server 2 user interface.

To configure AFD insertion lines for an Output Server 2 channel:
1 On the playout server, expand the instance of Output Server 2 for the channel to be 

configured (e.g. ITX1 Output Server 2). 
The Output Server 2 user interface appears. 

2 Go to Configuration > Channel tab. 
The channel configuration options appear. 
The channel configuration options appear in the upper portion. 

3 Expand the VANC heading to expose the AFD options.
4 The values for the AFD insertion lines are determined by the selected Resolution. The 

default is typically the switch line +2 for all formats. 
To change the default values, enter the new values into the following fields:

• AFD S2016 Insertion Line
• AFD RP186 Insertion Line

5 Click Save to store your changes and automatically reboot the Output Server 2 service.
Alternatively, wait until you have finished making changes in other areas of the 
Configuration panel, then click Save.

Configuring Output Branding Levels for SDI and IP Output Targets
Each output target (SDI main, SDI secondary, and IP) can be assigned an output branding 
level to determine the types of secondary events that can be included/excluded from the 
output. For example, one output target may be configured Clean, which will exclude any 
logos or voice overs, while another output may be set to Complete and include all 
branding. 

Note that logos and CGs are rendered on top of any XG Inside branding. 

To set the output target’s branding level:
1 On the playout server, expand the instance of Output Server 2 for the channel to be 

configured (e.g. iTX1 Output Server 2).
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Configuring IP Output Target Parameters
2 Select the Configuration > Channel tab.
The channel configuration options appear.

3 Select the Output 1 or Output 2 sub-tab.
4 From the Main Output Branding Level drop-down list, select a branding level:

• Clean: Includes the primary event, DVEs and PIPs. Excludes logos, CGs or voice-
overs.

• XG: Includes all items in the Clean level, and adds XG rendering.
• Logo: Includes all items in the XG level, and adds iTX logos and CGs .
• Voice Over: Includes all items in the Logo level, and adds voice overs.
• Complete: Includes all secondary events and open subtitles.

5 If the Secondary Output Branding level field appears, set the branding level for the 
secondary SDI output.  
Note that this field only appears if the playout server’s video/audio I/O card supports a 
secondary SDI output (refer to I/O Device Controller’s Engineering tab).

6 Click Save to store your changes and automatically reboot the Output Server 2 service.
Alternatively, wait until you have finished making changes in other areas of the 
Configuration panel, then click Save.

Configuring IP Output Target Parameters
If you selected IP 2022-2, IP 2022-6, HLS or RTMP as either of the channel’s Output targets, 
you must set the channel’s IP parameters, which determine the encoding characteristics for 
IP playout.

Configuring the IP 2022-2 output target parameters
If you set one of the output targets (Output 1 or Output 2 fields) on the iTX Channel Config 
dialog (TXPlay2 Config) to IP 2022-2, then you must complete the following procedure to 
set the IP output target’s parameters.

To configure the IP 2022-2 output target parameters:
1 On the playout server, expand the instance of Output Server 2 for the channel to be 

configured (e.g. iTX1 Output Server 2).
2 Select the Configuration > Channel tab.

The channel configuration options appear.
3 Select the Output 1 or Output 2 sub-tab associated with 2022-2.
4 If you have not done so already, set the output branding level. See Configuring Output 

Branding Levels for SDI and IP Output Targets, on page 67.
5 (optional) Enable SAP Announcement if you want the Output Server 2 to broadcast to 

downstream equipment Session Announcement Protocol (SAP) messages containing 
information about the stream it is generating.

6 From the Preset drop-down list, select an IP output preset.
If the desired preset is not displayed in the Preset drop-down list, click the Browse (...) 
button and then Import to locate and import a preset.

7 Specify the Video Codec and complete its settings:
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a From the Video Codec drop-down list, select either MPEG2, AVC or x264.
b Click the Browse (...) button next to the Video Codec drop-down list.
c In the General section of the codec’s settings dialog, complete the following 

setting:
• Quality: Select the desired output image quality level. Higher quality requires 

more CPU time.
• Profile and Level: Set the maximum image resolution and encoding bitrate 

possible. Refer to the H.262 and H.264 encoding standards.
• Bitrate (kbits/s): Displays the constant bitrate to allocate to the video portion 

of the transport stream. Variable bitrate mode is not supported. Values are 
expressed in kilobits per second. Note that 1 kilobit = 1000 bits. 

d Expand the Advanced heading and complete the remaining settings according to 
the codec’s standards.

e Click OK to close the codec’s settings dialog.
8 In the Video PID field, set a value to define the Packed Identifier of the channel in the 

output IP transport stream. Valid PID numbers range from 32 to 8186 and must be 
unique across a given IP output target.

9 Expand the Destination heading and set the following parameters:
• IP Protocol: Select rtp or udp. 

Note that rtp brings error correction on the IP communication link at the cost of 
some more bandwidth.

• Address: Specify the IP address of the destination for the IP stream (playout server).
• Port: Specify the port number of the playout server.
• Sending Interface: Specify the IP address of the network adapter carrying the IP 

stream.
• TTL: The time-to-live (TTL) is the number of hops that a packet is permitted to 

travel before being discarded by a router. This setting is read-only and defaults to 
32.

10 Expand the Transport Stream heading and set the following parameters:
• Combined kbps: Specify the total constant bit rate bandwidth in kilobits per 

second allocated for the transport of audio, video and control structures of the IP 
Transport Stream. Set this value to your desired bandwidth.
Note that 1 kilobit is defined as 1000 bits. The default value is 10000 kbps (or 10 
megabits per second) and the maximum value is 50000 kbps.

• PAT Rate (per sec): Specify how many Program Association Tables per second to 
transmit.

• PMT Rate (per sec): Specify how many Program Map Tables per second to transmit.
• PMT PID: Specify the Packed Identifier to associate with the PMT. Valid PID 

numbers range from 32 to 8186 and must be unique across a given IP output 
target.

• PCR Spacing (ms): Specify the interval in milliseconds between transmissions of a 
Program Clock Reference. 

• PCR on Every PES Packet: Check this option to transmit a PCR on every elementary 
stream packet.
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Configuring the IP 2022-6 output target parameters
11 Click Save to store your changes and automatically reboot the Output Server 2 service.

Configuring the IP 2022-6 output target parameters
If you set one of the output targets (Output 1 or Output 2 fields) on the iTX Channel Config 
dialog (TXPlay2 Config) to IP 2022-6, then you must complete the following procedure to 
set the IP output target’s parameters.

To configure the IP 2022-6 output target parameters:
1 On the playout server, expand the instance of Output Server 2 for the channel to be 

configured (e.g. iTX1 Output Server 2).
2 Select the Configuration > Channel tab.

The channel configuration options appear.
3 Select the Output 1 or Output 2 sub-tab associated with 2022-6.
4 If you have not done so already, set the output branding level. See Configuring Output 

Branding Levels for SDI and IP Output Targets, on page 67.
5 (optional) Enable SAP Announcement if you want the Output Server 2 to broadcast to 

downstream equipment Session Announcement Protocol (SAP) messages containing 
information about the stream it is generating.

6 (optional) In the Timing Offset field, set an adjustment value in microseconds against 
the SMPTE-2059 timings.

7 Expand the Destination heading and set the following parameters:
• IP Protocol: This parameter read-only and is set to rtp. 
• Address: Specify the IP address of the destination for the IP stream (playout server).
• Port: Specify the port number of the playout server.
• Sending Interface: Specify the IP address of the network adapter carrying the IP 

stream.
• TTL: The time-to-live (TTL) is the number of hops that a packet is permitted to 

travel before being discarded by a router. This setting is read-only and defaults to 
32.

8 Click Save to store your changes and automatically reboot the Output Server 2 service.

Configuring the Http Live Streaming (HLS) output target parameters
If you set one of the output targets (Output 1 or Output 2 fields) on the iTX Channel Config 
dialog (TXPlay2 Config) to Http Live Streaming (HLS), then you must complete the 
following procedure to set the IP output target’s parameters.

To configure the Http Live Streaming (HLS) output target parameters:
1 On the playout server, expand the instance of Output Server 2 for the channel to be 

configured (e.g. iTX1 Output Server 2).
2 Select the Configuration > Channel tab.

The channel configuration options appear.
3 Select the Output 1 or Output 2 sub-tab associated with HLS
4 If you have not done so already, set the output branding level. See Configuring Output 

Branding Levels for SDI and IP Output Targets, on page 67.
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5 Specify the Video Codec and complete its settings:
a From the Video Codec drop-down list, select either AVC or x264.
b Click the Browse (...) button next to the Video Codec drop-down list. 
c In the General section of the codec’s settings dialog, complete the following 

setting:
• Quality: Select the desired output image quality level. Higher quality requires 

more CPU time.
• Profile and Level: Set the maximum image resolution and encoding bitrate 

possible. Refer to the H.262 and H.264 encoding standards.
• Bitrate (kbits/s): Displays the constant bitrate to allocate to the video portion 

of the transport stream. Variable bitrate mode is not supported. Values are 
expressed in kilobits per second. Note that 1 kilobit = 1000 bits. 

d Expand the Advanced heading and complete the remaining settings according to 
the codec’s standards.

e Click OK to close the codec’s settings dialog. 
6 Expand the Destination heading and set the following parameters:

• Master Playlist File Name: The local path where iTX saves the .M3U8 playlist file.
• Segment Duration (Sec): Specifies the length of each individual segment files.
• Max files in Playlist: Specifies the number of segment files that will be kept on disk 

before being deleted.
7 Click Save to store your changes and automatically reboot the Output Server 2 service.

Configuring the Real-time Messaging Protocol (RTMP) output target 
parameters

If you set one of the output targets (Output 1 or Output 2 fields) on the iTX Channel Config 
dialog (TXPlay2 Config) to Real-time Messaging Protocol (RTMP), then you must complete 
the following procedure to set the IP output target’s parameters.

To configure the Real-time Messaging Protocol (RTMP) output target parameters:
1 On the playout server, expand the instance of Output Server 2 for the channel to be 

configured (e.g. iTX1 Output Server 2).
2 Select the Configuration > Channel tab.

The channel configuration options appear.
3 Select the Output 1 or Output 2 sub-tab associated with RTMP
4 If you have not done so already, set the output branding level. See Configuring Output 

Branding Levels for SDI and IP Output Targets, on page 67.
5 Specify the Video Codec and complete its settings:

a From the Video Codec drop-down list, select either AVC or x264.
b Click the Browse (...) button next to the Video Codec drop-down list. 
c In the General section of the codec’s settings dialog, complete the following 

setting:
• Quality: Select the desired output image quality level. Higher quality requires 

more CPU time.
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Adjusting SDI Output Timing
• Profile and Level: Set the maximum image resolution and encoding bitrate 
possible. Refer to the H.262 and H.264 encoding standards.

• Bitrate (kbits/s): Displays the constant bitrate to allocate to the video portion 
of the transport stream. Variable bitrate mode is not supported. Values are 
expressed in kilobits per second. Note that 1 kilobit = 1000 bits. 

d Expand the Advanced heading and complete the remaining settings according to 
the codec’s standards.

e Click OK to close the codec’s settings dialog. 
6 Expand the Destination heading and set the following parameters:

• RTMP Destination: The endpoint at the streaming facility that will receive the 
RTMP stream.

• Auto Retry Count: The number of times iTX will try to reconnect to the server 
before actually failing.

7 Click Save to store your changes and automatically reboot the Output Server 2 service.

Adjusting SDI Output Timing
If you are using an external reference input into your SDI video/audio I/O card, but the 
video input signal and time reference signal are not synchronized, you can compensate by 
adjusting the horizontal and vertical output timing for each output on the video/audio I/O 
card(s). This is done using the controls in the Output Timing Control (Ext. Ref. Only) 
section and monitoring the results on a waveform analyzer. 

To adjust the output timing:
1 On the playout server running the Output Server 2 system, expand the I/O Device 

Controller. The I/O Device Controller user interface appears. 
2 Click the Configuration > SDI tab.

The SDI configuration panel appears, with a set of output timing controls for each I/O 
device in the playout server:

3 Click Selected Output and select the output to be adjusted (either A or B).
4 To set the horizontal output timing value in pixels, enter a value into the box or use the 

slider on the Horizontal (Pixels) field.
5 To set the vertical output timing value in lines, enter a value into the box or use the 

slider on the Vertical (Lines) field.
6 Use a waveform analyzer to ensure the signals are synchronized,
7 Repeat step 3 to step 6 for each output on the playout server.

For example, for a Corvid 44 in simulcast mode, set the timing for outputs A and B. For a 
dual Corvid LP system in dual channel mode, set Corvid 1 output A and Corvid 2 output 
A.

8 Click Save to store your changes.
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Configuring Audio Output 
For audio in video and voice over media, Output Server 2 allows you to configure the 
output channels, Dolby metadata, audio watermarking, upmixing to Dolby 5.1 and 7.1, 
ALC Profile, voice over handling and audio mapping rules for individual audio programs, 
then assign those audio programs to audio program output groups as required.

For live assets, this configuration has to be performed within iTX Desktop, from the 
property editor in the Asset layout.
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About Default Audio Program Configurations 
When you access the Audio tab for the first time it includes an initial audio program. How 
this initial audio program is configured depends on whether the instance of Output Server 
2 is for a new channel or an existing channel that has been upgraded to iTX v2.8 or later, as 
well as which audio features you have licensed:

• For a new channel, an audio program called Default is created, with the following 
details:

• The Preferred Rule cell contains a P#1 audio label only.
• The Alternate Rule cell is empty.
• The Apply VO field is checked.
• The Dolby metadata is configured with basic default settings for stereo output. 
• No upmixing is configured.
• No audio watermark is defined. 

Note:
• When using logical audio programs, the Audio Mapping configuration panel in iTX 

Desktop’s Channel Config 4 layout can be ignored.
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• Automatic Loudness Control (ALC) is set to the Default profile.
• The Output Channels is set to Stereo

• For an existing channel:
• The existing audio configuration (output channels, Dolby metadata, watermarking 

and upmixing) is converted into audio programs, with names derived from the 
previous configuration. 

• The Apply VO field is checked for the first audio program to be assigned to the first 
output group.

Creating an Audio Program
Although Output Server 2 provides default and converted audio programs, you should 
create additional audio programs to support your required combinations of audio 
configuration, outputs, encoding and mapping rules.

For example, you may want to have English audio that plays out with the same mapping 
rules for both stereo and Dolby surround 5.1 outputs. In which case, you should create two 
separate audio programs, then configure them according to these requirements. Each 
audio program can then be assigned to separate audio output program groups or they 
could both be applied to a single Dolby E audio output program group (fulfilling the 5.1+2 
criteria of Dolby E).

To create a blank audio program entry:
1 Open the Output Server 2 user interface:

a On the playout server, expand the instance of Output Server 2 for the channel to 
be configured (e.g. ITX1 Output Server 2). 
The Output Server 2 user interface appears. 

b Go to Configuration > Audio tab. 
The Audio Programs and Audio Output Program Groups panels appear.

2 In the Audio Programs section, click on the blank cell in the Name column. 
The word Name appears in the cell.

3 Replace the word Name with a name to identify the audio program (e.g. English5.1 for 
an English audio program in Dolby surround 5.1) and press Enter.
The cell displays the new name and a new blank row appears below.

4 You should now select the output channels for your audio programs. See Selecting the 
Audio Output Channels on page 75.
Alternatively, click Save to store your changes and automatically reboot the Output 
Server 2 service. 

IMPORTANT
The following audio features require separate licenses:
• Dolby metadata
• Audio watermarking (Nielsen and Kantar Snap)
• Voice overs
If your playout server is not licensed to use one of these features, the 
corresponding user interface will be hidden and the functionality disabled. 
See License Requirements on page 16
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Selecting the Audio Output Channels
Audio programs can be configured to output as mono, stereo, Dolby surround 5.1 or Dolby 
surround Plus 7.1 channels. The audio output channel type you select for an audio program 
affects the following aspects of the audio configuration:

• How Dolby metadata is configured, for example which audio coding modes can be 
selected.

• If you select a surround output channel, you should also configure the upmixing from 
mono and stereo.

• If you have stereo voice overs and surround outputs, you will need to select how they 
are mapped.

• Your selected audio output channels dictates to which audio output program groups 
the audio program can be assigned.

To the output channels for an audio program:
1 Open the Output Server 2 user interface:

a On the playout server, expand the instance of Output Server 2 for the channel to 
be configured (e.g. ITX1 Output Server 2). 
The Output Server 2 user interface appears. 

b Go to Configuration > Audio tab. 
The Audio Programs and Audio Output Program Groups panels appear.

2 Click on the Output Channels drop down box for an audio program and select one of 
the following options:

• Mono

• Stereo
• 5.1
• 7.1

3 You should now define the mapping rules for your audio programs. See Defining Audio 
Mapping Rules for Audio Programs on page 75.
Alternatively, click Save to store your changes and automatically reboot the Output 
Server 2 service. 

Defining Audio Mapping Rules for Audio Programs
Within the Output Server 2 user interface, you can define audio mapping rules to control 
the order of preference for which the audio channels from the media file are assigned to the 
given audio program.

Mapping rules for audio programs are created by assigning audio labels to the audio programs’ 
Preferred Rules and Alternate Rules columns. The order of the labels in these columns 

Note: If you change the default output channel, a pop-up message appears 
asking if you would like to change the Dolby configuration to defaults that 
are appropriate for the output type.
Click Yes to change your Dolby configuration to sensible defaults or No to 
leave the Dolby configuration as is.
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determines the order in which iTX attempts to map on playout. For example, the first label (from 
the left) is the first one iTX attempts to map on playout, then the second label on the left, then 
the third and so on. On playout, operators can quickly see which events have had their audio 
mapped by the color and state of the Audio Mapping icon in the iTX Desktop’s schedule grid. 
See Monitoring the Audio Mapping status of scheduled video or live events on page 121.

The Alternate Rules column defines the audio labels that will be used if there are no 
matches within the Preferred Rules. If the match for a given clip is for a label with the 
Alternate Rule column, then a warning is produced to alert the operator. For example, a 
German broadcaster may set their Alternate label options to be ENG & ENG 5.1, as these will 
provide English language audio on the video/live outputs. When a match is made on either 
of these labels, the Audio Status icon in the Audio Mapping column alerts the operator of 
this alternative match. The operator may then need to perform an action, like ingest or 
assign subtitles or re-ingest the media with German language audio. See Monitoring the 
Audio Mapping status of scheduled video or live events on page 121.

To define the audio mapping rule for an audio program:
1 Open the Output Server 2 user interface:

a On the playout server, expand the instance of Output Server 2 for the channel to 
be configured (e.g. ITX1 Output Server 2). 
The Output Server 2 user interface appears. 

b Go to Configuration > Audio tab. 
The Audio Programs and Audio Output Program Groups panels appear.

2 In the Audio Programs section, click Available Labels.
The list of labels expands, as shown below:

Note: When defining mapping rules for audio programs consider the 
following points:
• The audio programs labels that appear in the Audio configuration tab of 

Output Server 2 are extracted from media that has been registered in the 
Opus database, either on import or following an update by the Asset Fixer 
service. Therefore you must prepare your media before configuring audio 
mapping rules. See Preparing for Logical Audio Programs on page 19.

• If you are going to create an audio output group with RAW encoding, you 
must create an audio program with unique audio labels that are not 
assigned to any other audio programs.

• Only create as many audio programs as you need to populate the output 
groups you create. You cannot have unassigned audio programs in your 
Output Server 2 configuration.

• If the output from your server is going to a downstream device, you may 
want iTX to play out silence when no matching label can be found in the 
media. This can be done by adding a Silence label to the end of your rule. 
If no Silence label is applied to a rule, when no matching label can be found 
in the media, iTX Desktop will display a warning to the operator. See See 
Monitoring the Audio Mapping status of scheduled video or live events on 
page 121.
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3 In the Label column, select a label you want to use in the rule.
4 Drag and drop the selected label into the blank cell in the Preferred Rule column of an 

audio program.

5 Repeat step 3 and step 4 to add additional labels to the Preferred Rule cell in the order 
of preference (from left to right). 

Note: If a required label is not displayed, you can add a new label to 
the system by entering a label name in an empty cell at the bottom of 
this Available Labels list, or by opening the iTX Desktop’s 
Configuration layout and using the Configure Labels functionality 
(see Creating Labels and Audio Import Rules for Logical Audio 
Programs, on page 20).
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6 If silence is required when no matching audio label is found, drag the SILENCE label 
from the bottom of the Available Labels list and add it to the end of your Preferred 
Rule.

7 Repeat step 3, step 4 and step 5, but add labels to the Alternate Rule cell. 
8 You should now select if you want to apply voice overs to your audio programs. See 

Configuring Dolby Metadata on page 78.
Alternatively, click Save to store your changes and automatically reboot the Output 
Server 2 service. 

Configuring Dolby Metadata
You can configure the Dolby metadata for each audio program you have defined by 
clicking the Edit button in the Dolby column. This displays a Dolby Metadata popup, 
where you can set specific values for each parameter and set a resolution rule. 

To configure Dolby metadata for an audio program:
1 Open the Output Server 2 user interface:

a On the playout server, expand the instance of Output Server 2 for the channel to 
be configured (e.g. ITX1 Output Server 2). 
The Output Server 2 user interface appears. 

b Go to Configuration > Audio tab. 
The Audio Programs and Audio Output Program Groups panels appear.

2 In the Audio Programs section, go to the Dolby column for the audio program you 
want to configure and click Edit.
The Dolby metadata pop-up dialog appears.

IMPORTANT
The SILENCE label should only be added to the end of the rule (last item on 
the right). If SILENCE is listed before an audio program label, that label will 
never be matched on play out.
In the examples below, the first rule is acceptable, but on the second rule 
audio with the labels P#4 and P#6 would never be matched, because the 
Silence label is before them in the rule.

Note: Dolby metadata configuration is a licensed feature. If your playout 
server does not have the required license the Dolby button will not be 
visible on your Output Server 2 service. See License Requirements on 
page 16.
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3 Review and/or set the metadata parameters that are listed in the Setting column.
Hovering over the metadata setting field displays a brief description of the metadata 
parameter. 

4 For each metadata parameter, set the associated Rule field to one of the following 
values: 

• Manual Value applies the set value as the constant default. 
• Decoders, then manual value applies a conditional setting such that if the Dolby 

decoder provides a setting for that metadata parameter, then the decoder’s setting 
takes precedent over the set value. 

5 Click OK to store the metadata parameter settings and close the popup.
6 If you have created audio programs with surround channel outputs, you should now 

configure how Output Server 2 is to handle upmixing. See Configuring Audio Upmixing 
on page 79.
Alternatively, you can configure the watermarking for your audio programs. See 
Configuring Audio Watermarking on page 81 or click Save to store your changes and 
automatically reboot the Output Server 2 service. 

Configuring Audio Upmixing
Audio upmixing is only required for channels where the audio input needs to be upmixed 
to Dolby 5.1 or Dolby 7.1; therefore the ability to edit the upmixing properties is only 
available to audio programs that are set to 5.1 or 7.1.

Upmixing can be disabled by enabling the Passthrough (no mixing) setting, which enables 
Dynamic Audio Coding Mode (ACMOD) Switching where the Dolby Metadata configuration 
setting is ignored and default values according to the current ACMOD are used instead.

To enable and configure audio upmixing:
1 Open the Output Server 2 user interface:

a On the playout server, expand the instance of Output Server 2 for the channel to 
be configured (e.g. ITX1 Output Server 2). 
The Output Server 2 user interface appears. 

b Go to Configuration > Audio tab. 
The Audio Programs and Audio Output Program Groups panels appear.
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2 In the Audio Programs section, go to the Upmixing column for the audio program you 
want to configure and click Edit.
The Upmixing Configuration pop-up dialog appears for the selected audio program.

3 Leave the Passthrough (no mixing) unchecked (default) to force upmixing. 
If however you want to disable upmixing and allow the audio to pass through as-is, 
check the Passthrough (no mixing) check box and the Upmix configuration options 
are greyed out.

4 In the Stereo (L/R) Channels Level (dB) field, enter the stereo input volume level in 
decibels. 
The minimum value is -24 dB, the maximum is 6 dB and the default is -6 dB. 
Alternatively set the level to Mute.

5 In the Stereo Width field, enter a value from 0 to 31. The default is 27.
6 In the Center (C) Channel Level (dB) field, enter the center input volume level in 

decibels. 
The minimum value is -24 dB, the maximum is 6 dB and the default is 1 dB. Alternatively 
set the level to Mute.

7 In the LFE Level (dB) field, enter the low-frequency effects input volume level in 
decibels. 
The minimum value is -24 dB, the maximum is 6 dB and the default is -10 dB.
Alternatively set the level to Mute.

8 In the LFE Filter field, enter a value in hertz for low-frequency effects. 
The default is 80Hz for 50Hz video formats and 66.7Hz for 59Hz video formats.

Notes
• Passthrough behavior depends on the selected type of the audio output program 

group to which the audio program is assigned. 
When performing passthrough and the audio output program group is configured 
for PCM 5.1 or 7.1, the passthrough audio will be padded with silence to account 
for any difference in channel count. If the audio output program group type is 
configured for Dolby D or Dolby D Plus, then instead of using the ACMOD 
according to the audio program output channels setting (5.1 or 7.1), it will use an 
ACMOD matching the passed through audio (i.e. 2.0 for stereo).

• The Passthrough setting should not be used in conjunction with an audio output 
program group whose type is Dolby E.
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9 Click the Surround Mode field. 
The Select Item dialog appears. 

10 Select the required surround mode. 
The options are:

• Speech (default)
• Standard
• Movie

11 In the Surround (Ls/Rs) Channels Level (dB) field, enter the surround sound input 
volume level in decibels. 
The minimum value is -24 dB, the maximum is 6 dB and the default is -5 dB. 
Alternatively set the level to Mute.

12 In the Surround Delay (ms) field, enter the required delay in milliseconds. The default is 
16.

13 Click OK to store the upmixing settings and close the popup.

14 You should now configure the watermarking for your audio programs. See Configuring 
Audio Watermarking on page 81.
Alternatively, click Save to store your changes and automatically reboot the Output 
Server 2 service. 

Configuring Audio Watermarking
An audio watermark is an inaudible cue tone in the audio stream of the channel output 
signal. iTX offers two types of audio watermarking: Neilsen and Kantar Snap.

In the USA and Canada, the Nielsen audio watermark is detected by devices that provide 
information for television audience measuring. The following Nielsen watermark formats 
are supported: version 2 (N2), version 6 (NW) and Critical Band Encoding Technology 
(CBET). Each of these formats can be inserted into the data stream individually or in 
combinations (e.g. NW+CBET). 

To configure Neilsen watermarking on audio output:
1 Open the Output Server 2 user interface:

a On the playout server, expand the instance of Output Server 2 for the channel to 
be configured (e.g. ITX1 Output Server 2). 
The Output Server 2 user interface appears. 

b Go to Configuration > Audio tab. 
The Audio Programs and Audio Output Program Groups panels appear.

Note: Clicking Reset reverts the values to the default profile.

Note: Audio watermarking is a licensed feature. If your playout server 
does not have the required license the Watermark button will not be 
visible on your Output Server 2 service. See License Requirements on 
page 16.
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2 In the Audio Programs section, go to the Watermarking column for the audio program 
you want to configure and click Add.
The Watermark pop-up dialog appears for that audio program.

3 Using the Watermark Type drop-down list, select Nielsen.
The Nielsen watermarking pop-up dialog appears.

4 Using the Process Type drop-down list, select one of the following:
• Disable
• N2
• NW
• N2+NW
• CBET
• NW+CBET
• N2+NW+CBET

5 If the Process Type field is set to an option that includes N2 and/or NW, then set the 
following fields:

• In the Service ID field, enter the Nielsen service ID number.
• In the Check Digit field, enter the two-letter Nielsen check digit. 

If the Process Type field is set to an option that includes CBET, then set the following 
fields:

• In the CBet Service ID field, enter the CBET service ID number.
• In the CBet Check Digit field, enter the two-letter CBET check digit.

6 Using the Distribution Type drop-down list, select one of the following:
• Program Content
• Final Distributor

Click OK to store the Nielsen settings and close the popup.
7 In the Audio Programs section, the Watermark column displays a Nielsen button for the 

edited audio program.
8 Click Save to store your changes and automatically reboot the Output Server 2 service. 

Alternatively, wait until you have finished making changes in other areas of the 
Configuration panel, then click Save.

To configure Kantar Snap watermarking on audio output:
1 Open the Output Server 2 user interface:

a On the playout server, expand the instance of Output Server 2 for the channel to 
be configured (e.g. ITX1 Output Server 2). 
The Output Server 2 user interface appears. 

b Go to Configuration > Audio tab. 
The Audio Programs and Audio Output Program Groups panels appear.

2 In the Audio Programs section, go to the Watermarking column for the audio program 
you want to configure and click Add.
The Watermark pop-up dialog appears for that audio program.

3 Using the Watermark Type drop-down list, select Kantar Snap.
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The Kantar Snap option is only available if a valid license installed and the Output 
Server 2’s Frame Rate Family is set to 50 Hz in the I/O Device Controller.

4 The Kantar Snap watermarking pop-up dialog appears and the Mode field is read-only 
and set to Live, unless your Output Server 2 is configure for an On-Demand channel.

5 In Channel Name drop-down list, select the channel that you want to be inserted into 
the watermark.

6 In the License Directory field, verify that the directory path displayed identifies the 
location of where the Kantar license files are stored. 

7 Click OK to store the Kantar Snap settings and close the popup.
8 In the Audio Programs section, the Watermark column displays a Kantar SNAP button 

for the edited audio program.
9 Click Save to store your changes and automatically reboot the Output Server 2 service. 

10 Alternatively, wait until you have finished making changes in other areas of the 
Configuration panel, then click Save.

Configuring Automatic Loudness Control (ALC)
If licensed for Automatic Loudness Control (ALC), the iTX channel defaults to using the 
Default ALC profile. The settings of the ALC profile are applied to each audio program where 
it is assigned. ALC profiles are configured at the audio program level - allowing each audio 
program to have its own ALC profile selected.

The default profile can be updated to meet the ALC requirements of the channels using the 
profile. Alternatively it can be disabled using the Disable ALC Processing option.

When configuring an ALC profile, three predefined sets of ALC settings are available. 
Factory Light, Factory Standard and Factory Heavy have been designed to mirror the 
predefined settings in XVP-3901. A/85 ITU and EBU R128 standards for loudness can also 
be selected as appropriate for the channel frame rate family.

Changing the profile updates the settings for channels using that profile, but only after a 
Output Server 2 restart. Operators are notified when channels need restarting in order to 
use the modified ALC profile settings.

To configure the default ALC profile or create a new ALC profile
1 Open the Output Server 2 user interface:

a On the playout server, expand the instance of Output Server 2 for the channel to 
be configured (e.g. ITX1 Output Server 2). 
The Output Server 2 user interface appears. 

b Go to Configuration > Audio tab. 
The Audio Programs and Audio Output Program Groups panels appear.

Notes

• Settings for the Default ALC profile can be edited, but the Default ALC 
profile cannot be deleted from the iTX system.

• If a deleted ALC profile was configured to be used by a channel, then the 
channel reverts to the Default profile.
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2 In the Audio Programs section, go to the ALC column for the audio program you want 
to configure and click Default.
The ALC Profile pop-up dialog appears for that audio program.

3 If you want to disable ALC on all channels configured to use this profile, check the 
Disable ALC processing box.
If you want to apply the ALC profile to the on all channels configured to use this profile, 
uncheck the Disable ALC processing box. The remaining ALC profile settings become 
available for editing.

4 In the Target (LFKS) section, set the desired average output level.
• EBU R128: 50 Hz and 24 Hz will be defaulted to the EBU R128 target (-23 LUFS).
• A/85 ITU: 59.94 Hz and 23.98 Hz will be defaulted to A/85 ITU target (-24 LKFS).
• Custom: Select a Custom and use the slider to set any value between -31 LUFS and 

-10 LUFS.
5 In the True Peak Limiter Threshold (LKFS) section, use the slider or text box to set 
6 In the Presets section, select one of the following three predefined sets of ALC settings 

or the Custom setting:
• Factory Light: The ALC applies low dynamic range compression on the audio 

program content. The overall response time is relatively slow, which reduces the 
ALC ability to tightly follow the target output loudness.

Using this preset, the program content will sound a little more dense, while 
keeping most of the original program dynamic range.

• Factory Standard: The values provide an ALC profile which applies moderate 
dynamic range compression on the audio program content. The overall response 
time is also moderate,which allows the ALC to follow the target output loudness 
quite well. This preset is well-suited for most types of audio content. It is the factory 
preset loaded when loading the XVP-3901 card default parameters.

• Factory Heavy: The ALC applies high dynamic range compression on the audio 
program content. The overall response time is relatively fast, which improves the 
ALC ability to tightly follow the target output loudness. 

Using this preset, the program output content will sound much more dense, less 
dynamic.

• Custom: Selecting a Custom profile allows you to set any of the parameters to any 
valid value.

7 If you want to apply the new settings to the currently selected ALC profile, click Save.
However, if you want to create a new profile based on these edited settings, click Save 
As and provide a name for the new profile.
If both cases, the settings for channels using that profile are changed, but only after a 
Output Server 2 restart. As such, operators are notified that the channels need to be 
restarted in order to use the modified ALC profile settings.

Configuring Voice Overs Playback
You must select to which audio program you want scheduled voice overs to be applied. 
There are no language tags for voice over and only the first source program is used. 
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For each combination of channel types, source voice over programs are mapped to a 
specific mode on output. For example, a Dolby 5.1 voice over on a stereo output program is 
down mixed. The one exception is stereo voice overs to a Dolby 5.1 surround output, which 
can be mapped to one of four different modes by the user. Output Server 2 allows you to 
specify the stereo voice over to Dolby 5.1 output mapping at both a channel and a global 
level. 

Figure 8-1 below illustrates how each mapping mode (both the fixed and the user 
selectable) handles the source and output audio:

Fig. 8-1: The fixed and selectable voice over source and output mapping modes.

Applying Scheduled Voice Overs to Audio Programs
To apply scheduled voice overs to audio programs:

1 Open the Output Server 2 user interface:
a On the playout server, expand the instance of Output Server 2 for the channel to 

be configured (e.g. ITX1 Output Server 2). 
The Output Server 2 user interface appears. 

Note: Voice over configuration, stereo to 5.1 mapping and playback are 
licensed features. If your playout server does not have the required 
license the Voice Over checkbox and will not be visible on your Output 
Server 2 service. See License Requirements on page 16.
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b Go to Configuration > Audio tab. 
The Audio Programs and Audio Output Program Groups panels appear.

2 Check Apply VO for an audio program.
3 You should now configure Dolby metadata for your audio programs. See Configuring 

Dolby Metadata on page 78.
Alternatively, click Save to store your changes and automatically reboot the Output 
Server 2 service. 

Mapping Stereo to Surround Outputs for Voice Overs
The Stereo to Surround mapping mode setting is a single configuration that applies to all 
audio programs configured for that channel, not individual audio programs. It can be 
applied at either a channel level or a global level from any Output Server 2 service within 
the same iTX domain.

To configure the Stereo to Surround mapping mode for voice overs:
1 Open the Output Server 2 user interface:

a On the playout server, expand the instance of Output Server 2 for the channel to 
be configured (e.g. ITX1 Output Server 2). 
The Output Server 2 user interface appears. 

b Go to Configuration > Audio tab. 
The Audio Programs and Audio Output Program Groups panels appear.

2 On the right hand side, click Additional Config. 
The Additional Config panel appears.

3 Select a level at which to apply the configuration:
• The Global tab allows you to set the voice over mapping for all instances of Output 

Server 2 running in the same iTX domain.
• The Channel can be set to either use the global configuration or a channel-level 

override.
4 Use the drop down list to select a mapping mode from the following:

• Global (Channel tab only): If the Channel tab is set to Global it means the voice 
mapping for this instance of Output Server 2 is using the settings specified on the 
Global tab.

• Centre sum: The sum of the left and right channels are used produce a mono 
output on the center channel.

• Left and Right: The left and right channels from the source are mapped to the 
left and right channels on the output.

• Left and Right and Center: The stereo source is upmixed and spread among 
the left, right and center output channels.

• Upmix: The source audio is upmixed spread among all of the output channels (i.e. 
surround).

5 Now define the mapping rules for your audio programs. See Defining Audio Mapping 
Rules for Audio Programs on page 75.
Alternatively, click Save to store your changes and automatically reboot the Output 
Server 2 service. 
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Assigning Audio Programs to Audio Output Program Groups
Once the audio programs have been created, they must all be assigned to audio program 
output groups. The output channels of the selected rule must be compatible with the audio 
type of the destination output program group. For example, if the audio program is set to 
5.1 or 7.1, it cannot be assigned to an output group set to RAW, as RAW can only hold two 
(stereo) channels.

When you access the Audio tab for the first time it includes a default output, the 
configuration of which depends on whether the instance of Output Server is for a new 
channel or an existing one, which already had an audio configuration before being 
upgraded Output Server 2 v2.8 or later:

• For a new channel: 
• The Default audio program is assigned to an output group, using a type of PCM. 

• For an existing channel: 
• Output groups are created using the audio programs that were created from the 

existing audio configuration.
• The first audio program in the first output group will have Apply VO checked.

The steps below explain how to create a new output group.

To assign an audio program to an output group:
1 Open the Output Server 2 user interface:

a On the playout server, expand the instance of Output Server 2 for the channel to 
be configured (e.g. ITX1 Output Server 2). 
The Output Server 2 user interface appears. 

b Go to Configuration > Audio tab. 
The Audio Programs and Audio Output Program Groups panels appear.

2 In the Audio Output Program Group section, appropriate Output tab.
3 Click the drop-down list in the blank Type cell and select one of the following:

• RAW passes audio to the output without any decoding/encoding and uses the 2.0 
channel type only.

• PCM which has the channels 1, 2.0, 5.1 and 7.1 available.
• DolbyD which has the channels 2.0 and 5.1 available.
• DolbyE which has the channels 5.1, 5.1+2.0 (in that order) and 2.0+2.0 available.
• Dolby D Plus which has the channels 2.0, 5.1 and 7.1 available.
• MPEG which has the channels 1 and 2.0 available.
• AAC which has the channels 1, 2.0, 5.1 and 7.1 available.

Note: As RAW audio is output without being decoded or encoded, consider 
the following points before selecting this option:
• Compressed PCM audio cannot be output for RAW. Any media with PCM 

audio must be uncompressed to playout using RAW.
• RAW audio cannot be overlaid with voice overs, even if Apply VO is 

checked for the audio program.
• An audio output program group set to RAW must be assigned an audio 

program with unique labels that are not used by any other audio program.
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4 (Optional) If you selected PCM as the type in the Settings column, the Edit button 
becomes available. This allows you to set the PCM bit depth for the audio output 
program group. By default, this is set to 24-bit.

a Click Edit. The PCM dialog appears.
b Click on the Bit Depth drop-down list to change the value: 16 or 24 bits.

Alternatively, click Reset to restore the default value.
c Click OK to confirm your settings and close PCM Settings dialog.

5 (Optional) If you have the Dolby metadata license and selected Dolby E as the type, in 
the Settings column the Edit button becomes available. This allows you to set the 
Dolby E bit depth for the audio output program group. By default, this is set to 20-bit.

a Click Edit. The Dolby E Settings dialog appears.
b Click on the Bit Depth drop-down list to change the value.

Alternatively, click Reset to restore the default value.
c Click OK to confirm your settings and close Dolby E Settings dialog.

6 (Optional) If you selected MPEG as the type in the Settings column, the Edit button 
becomes available. This allows you to set the MPEG Bitrate for the audio output 
program group. By default, this is set to 128 kbits/s.

a Click Edit. The MPEG Settings dialog appears.
b Click on the Bitrate drop-down list to change the value.

Alternatively, click Reset to restore the default value.
c Click OK to confirm your settings and close MPEG Settings dialog.

7 (Optional) If you selected AAC as the type in the Settings column, the Edit button 
becomes available. This allows you to configure several AAC settings for the audio 
output program group.

a Click Edit. The AAC Settings dialog appears.
b Click the Version drop-down list to change the value. The default value is MPEG4 

ISO 14496-3.
c Click the Profile drop-down list to change the value. The default value is Low 
Complexity (AAC-LC).

d Click the Bitrate drop-down list to change the value. The default value is 
64 kbit/s.

e Click the Header type drop-down list to change the value. The default value is 
ADTS.

f Click OK to confirm your settings and close AAC Settings dialog.
8 If the Audio Output Program Group is targeting an IP output, then the PID cell appears. 

You must enter a unique non-zero numerical value.
9 Click Save to store your changes and automatically reboot the Output Server 2 service. 
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10 Click on an audio program Name cell, then drag and drop the selected audio program 
to the blank Programs cell in the Audio Output Program Groups section.

If you selected DolbyE as the audio type, you can add up to two audio programs 
(depending on their selected output channels).
When you have added audio programs to the output group, the Description cell 
updates to show the audio type and output channels of the output group.

11 Click Save to store your changes and automatically reboot the Output Server 2 service. 
Alternatively, wait until you have finished making changes in other areas of the 
Configuration panel, then click Save.

Adding logical audio programs and groups to live assets
As live events are not imported and analyzed by the GV Engine, they are not automatically 
assigned audio output program groups. Therefore, you must add logical audio program 
groups to each live asset in your system. This is performed from the property editor, within 
the Asset layout in iTX Desktop.

To add logical audio programs and groups to live assets:
1 Launch iTX Desktop and switch to the Asset layout.
2 From PinPoint, click  to restrict the search results to live assets.
3 Type in the criteria for the live asset you want to update.

Note: Some downstream audio processors may require mono audio 
program groups to be assigned in pairs, as they expect to receive the audio 
signal in pairs.

If your downstream audio processors are capable of handling individual 
mono audio program groups, this consideration can be ignored.

Note: If the combination of the selected audio program’s output channel 
and the output group’s audio type are incompatible, the Program cell turns 
red and the Description cell displays an error, explaining why the selected 
combination cannot be used together.

To correct this error, either change the output group’s audio type or the 
selected audio programs. See Managing Audio Registration, Output and 
Mapping on page 128.
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4 Press the Enter key or click  to begin the search.
5 From the results grid, select the required live asset.
6 In the property editor, click on the Asset tab.
7 On the Logical tab, click Edit. 

The Audio Program Groups Editor appears.
8 Click Add Group.

A new audio group appears at the bottom of the editor.

9 Click the Encoding drop-down list and select one of the following:
• PCM (Default)
• Dolby D
• Dolby E
• Dolby D Plus

10 Click on the Channel drop-down list and select one of the following:
• Mono
• Stereo
• 5.1
• 7.1

11 Double-click on the Label cell. 
The Label Selector appears.

12 Select a label for the audio program and click OK.
13 (Optional) If you selected Dolby E as the encoding method, you can add multiple audio 

programs to the group until all of the channels are assigned (for example a surround 
5.1 and a stereo 2.0 combination).

a Click Add Program to insert an additional audio program. 
b Follow step 10 to step 12 to define the additional audio program.

14 (Optional) To add more audio program groups to the live asset, repeat step 8 to step 13.
15 Click OK to close the Audio Group Editor dialog.

Your live asset is now ready to be used in schedules.
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The video signal to the video/audio I/O card in the playout server can contain splice inserts, 
such as SCTE messages (also known as digital cue tones). iTX can detect such messages and 
respond to them to start the playout of a sequence that is on hold in a schedule or end a 
sequence iTX is currently playing. SCTE refer to the time space provided by broadcasters to 
trigger these sequences as the “avail”. Output Server 2 gives users the ability to enable and 
disable individual SCTE features independently, depending on their requirements. Note 
that SCTE104 is the protocol for embedding Splice markers in an SDI stream, while SCTE35 
is the protocol for embedding Splice markers in an IP stream.

Summary
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About SCTE Splice Insert plugins
There are two sides to configuring SCTE splice inserts: the features you want to use need to 
be configured in the Splice Insert tab on the Output Server 2 Configuration panel, while 
the message types need to be configured via one of two different plugins in the iTX 
Desktop.

Plugin Description

VANC 
plugin

The VANC plugin is the legacy SCTE104 solution, which supports the following 
features:
• The ability to react to inbound splice request commands sent in a Multiple Operation 

Message, providing they are the only command in the Multiple Operation Message.
• Pass-through of splice request commands to downstream services. Any unsupported 

commands are stripped from the message. 
• Insertion of outbound splice commands.
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Configuring Splice Insert Features 
To configure Splice Insert features for Output Server 2:

1 On the playout server, expand the instance of Output Server 2 for the channel to be 
configured (e.g. ITX1 Output Server 2). 
The Output Server 2 user interface appears. 

2 Go to Configuration > Splice Insert.
3 Check Splice Insert Trigger Enabled.

As well as enabling splice insert triggering, checking this options makes the following 
splice insert features available:

• Heartbeat
• Inbound Triggers
• Break Trigger Type
• Enabled (on the IP 2022-2 tab)

4 To enable the passing of null splice insert messages for heartbeating to downstream 
services, check Heartbeat. 
This option is only supported by the SCTE104 plugin.

5 To enable pass-through to downsteam services, check Pass-Through Enabled.
This option is only supported by the SCTE104 plugin.

6 To have incoming messages passed through on the selected output line number, check 
Pass-Through on Output Line.

7 To perform partial or full replacement of splice event inbound splice inserts, enter a 
value in Event Mask. 

SCTE104 
plugin

The SCTE104 plugin (for SCTE 104 and SCTE 35) supports the following enhanced 
features:
• The ability to react to inbound Multiple Operation Messages containing more than one 

command, including:
• Splice request commands.
• Local and National Avail Insert Commands, either individually or both in the same 

Multiple Operation Message.
• Legacy DTMF triggers.

• Enhanced message pass-through, which provides the following additional functionality:
• All inbound SCTE messages can be either passed through or blocked.
• When pass-through is enabled, iTX allows for the passing of “NULL” SCTE messages for 

heart-beating to downstream services.
• The ability to enable or disable pass-through for all commands within a Multiple 

Operation Message. 
Splice commands received outside of a configured available window are unchanged.

• Insertion of outbound Multiple Operation Messages containing the following additional 
commands:
• Local and National Avail Insert Commands, either individually or both in the same 

Multiple Operation Message.
• Legacy DTMF triggers.

Plugin Description
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The mask configuration allows for bit level "OR" masking. For example:

This option is only supported by the SCTE104 plugin.
8 To set the delay TXPlay 2 allows before it responds to Start Sequence and End 

Sequence messages, enter a value in Delay (Frames).
9 Enable the required Inbound Triggers by checking any of the following options:

• If you want the channel to process spliceStart_normal insert commands, enable 
Sequence Start. 

• If you want the channel to process spliceEnd_normal insert commands, enable 
Sequence End.

• If you want the channel to process spliceStart_immediate insert commands, 
enable Immediate Sequence Start. 
These commands can be used to start a sequence early, but their usage is not 
recommended by SCTE 35 [1] and may result in inaccurate splices.

• If you want the channel to process spliceEnd_immediate insert commands, 
enable Immediate Sequence End. 
These commands can be used to terminate a sequence early, but must include the 
correct event ID for the sequence that is to be canceled.

All message types can be enabled at once, if required.
10 Enable the required Break Trigger Types by enabling or disabling the following 

options:
• National Breaks
• Local Breaks

The table below describes the effects from various combinations of these two options:

Incoming message (hex): 0x00005c7e

Inputted Event Mask string (dec): 1073741824

Actual Event Mask (hex): 0x40000000

Output (hex): 0x40005c7e

Combination Result

National Breaks disabled
Local Breaks disabled

iTX will trigger in all cases, i.e. when it receives Multiple 
Operation Messages with:
• Only a splice_request_data command (legacy SCTE104)
• Both a splice_request_data and a 
segmentation_descriptor_request (for either local or 
national breaks).

NOTE:
If you are only using the legacy VANC plugin, both break 
trigger types must be disabled.

National Breaks enabled
Local Breaks disabled

iTX will only trigger if a Multiple Operation Message is 
received with a splice_request_data and a 
segmentation_descriptor_request with the 
segmentation_type_id set to National (value 0x32). 
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11 On the SDI tab’s Output Line Number field, enter the vertical ancillary (VANC) line 
number on which to output splice inserts. The default value is 10.

12 On the IP 2022-2 tab, check the Enabled checkbox and set the Pid field, which is the 
Packed Identifier of the channel in the output IP transport stream. Valid PID numbers 
range from 32 to 8186 and must be unique across a given IP output target. The default 
Pid value is 745.

13 Click Save to store your changes and automatically reboot the Output Server 2 service. 
Alternatively, wait until you have finished making changes in other areas of the 
Configuration panel, then click Save.

Configuring the SCTE 104 Message Types
In addition to the configuration that has to be performed in the Output Server 2 user 
interface, the following configuration needs to be performed within iTX Desktop. The 
required configuration is dependent on whether you are using just the legacy features or 
both the legacy and enhanced features.

Configuring the legacy VANC plugin
For channels that will only process legacy SCTE 104 messages:

• In Engineering > Channel Config > Plugins > VANC specify:
• Insert Type (select SPLICER)
• Line Number
• Automatic System Index
• Duration (Frames)

For more information, see the iTX System Administration Guide.

Configuring enhanced SCTE 104 plugin
For channels that will process both legacy and enhanced SCTE 104 features:

• In Engineering > Channel Config > Plugins > SCTE104 specify:
• Insert Type
• Automatic System Index
• Duration (Frames)

National Breaks disabled
Local Breaks enabled

iTX will only trigger if a Multiple Operation Message is 
received with a splice_request_data and a 
segmentation_descriptor_request with the 
segmentation_type_id set to Local (value 0x30). 

National Breaks enabled
Local Breaks enabled

iTX will only trigger if a Multiple Operation Message is 
received with a splice_request_data and a 
segmentation_descriptor_request with the 
segmentation_type_id set to Local (value 0x30) or 
National (value 0x32). 

Combination Result
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For more information, see the iTX System Administration Guide.

Configuring sequences for SCTE 104
A sequence is a small group of schedule events that iTX handles as a single event block. A 
typical sequence might contain a few video clip events and secondary events, with certain 
transitions or vision effects. As such, sequences can be used to schedule a block of 
advertisements or trails, triggered to start and stop by SCTE 104 messages.

• For sequence control via SCTE 104 messages, in the Event Editor for the sequence 
enable the Allow External Takes.

• For scheduled break sequences on the inbound channel:
• In Engineering > Channel Config > Channel Config 2, the Fixed Availability 

Windows is used to control how the start and end times for a sequence are 
interpreted. 
When enabled, the Start Window and End Window times for sequences are 
applied as specified in the Event Editor for the item. The Start and End Window 
times include the time and date for the item.
When disabled, the Start Window and End Window times for sequences are 
applied relative to the start time of the item. 

• In Event Editor for the sequence item: 
• Specify the sequence’s availability window by entering timecodes in the Start 

Window and End Window fields. 
How these times are interpreted is dependent on the Fixed Availability 
Windows option in Channel Config 2.

• If required, enable SCTE104 LocalAd. 
iTX inserts an SCTE 104 message to trigger the insertion of local advertisement. 
It does this when it plays out a sequence as a result of receiving an SCTE 
message containing a delay.
Unless you require this specific functionality, you should ensure the option is 
not selected.

For more information on configuring availability windows see the iTX System Administration 
Guide.

For more information on working with sequences see the iTX Desktop Operator Guide.

Note: Once an availability window has been set and applied it cannot be 
removed. If the availability window is changed, the new window will take 
effect, but the previous window will not be removed until the Output Server 
2 service is restarted.
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Configuring Optional Plugins and 
Functionality
Not all of iTX’s functionality is mandatory and as such some aspects of Output Server 2 only 
need to be configured if you require the associated functionality or have purchased the 
corresponding software license and (if applicable) hardware. This section explains how to 
configure these optional plugins and functionality.

Summary
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Configuring Subtitle Playout
From v2.8 onwards, iTX includes the ability to playout subtitles using Grass Valley Softel 
Inside. This functionality is optional and therefore no basic configuration is required if you 
do not want to use Softel Inside for your subtitling solution. 

If you are using Softel Inside, see the iTX Softel Inside Configuration & User Guide for more 
information.

Playing Out Legacy Subtitles or Closed Captions on iTX v2.8 or Later
If you had been playing out basic subtitles or closed captions on a previous installation of 
Output Server 2, you would have had to configure one stream and one service. As of iTX 
v2.8 or later, legacy subtitles and closed captions no longer require this baseline 
configuration and therefore it must be removed from the Output Server 2 user interface.

To remove the previous baseline subtitle configuration for legacy subtitles:
1 On the playout server, expand the instance of Output Server 2 for the channel to be 

configured (e.g. ITX1 Output Server 2). 
The Output Server 2 user interface appears. 

2 Go to Configuration > Subtitles tab. 
3 Expand the Services tab.
4 From the Service drop-down list, select each service you have configured and click 

Remove.
5 Expand the Streams tab.
6 From the Streams drop-down list, select each stream you have configured and click 

Remove.
7 Click Save. Output Server 2 will automatically shut down and restart to apply your 

changes.
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Configuring iTX Desktop for 4K CGs and Logos
If you are operating a 4K channel and using the iTX CG or Logo plugin, you must instruct 
your iTX Desktop PCs to enable the 4K version of CG and Logo canvas. This is done by 
adding an environment variable to Windows. 

This environment variable can be assigned to either the currently logged in user or to all 
users, as a system variable. The steps below explain how to add the 4K Desktop 
environment variable at a system level.

To create the Windows environment variable for the 4K Desktop:
1 On the iTX Desktop PC, press +R. 

The Run dialog appears.
2 In the Open field, type sysdm.cpl. 

The System Properties dialog appears.
3 Click Advanced, then Environment Variables.

The Environment Variables dialog appears.
4 In the System Variables section, click New.

The Edit System Variable dialog appears.
5 Enter the environment variable as follows:

• In the Variable Name field, enter ENABLE_4K_DESKTOP.
• In the Variable Value field, enter 1.

6 Click OK to close the Edit System Variable dialog. 
On the Environment Variables dialog, the new variable is listed in the System Variables 
section.

7 Click OK to close the Environment Variables dialog.

Viewing the XG Inside Status
If you have XG Inside and multiple channels configured on the same playout server, you can 
view which XG Inside channel has been assigned to an instance of Output Server 2 from the 
Channel tab of the Output Server 2 user interface.

To view the XG Inside channel status:
1 On the playout server, expand the instance of Output Server 2 for the channel to be 

configured (e.g. ITX1 Output Server 2). 
The Output Server 2 user interface appears. 

2 Go to Configuration > Channel tab. 
The XG Inside Channel parameter is listed among the other channel configuration 
settings. 
If this setting is grayed out it means you do not have the necessary software installed 
on your playout server. 

For more information about configuring Vertigo XG Inside, see the Vertigo XG Inside User 
Guide.
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About Custom Aspect Ratio Control (ARC) Modes
In the Channel Config layout of iTX Desktop, the Advanced Aspect Ratio Control panel 
allows you to map a scheduled item’s field values to an output aspect ratio, ARC mode and 
Active Field Description (AFD). For channels that are operating on Output Server 2 you can 
also define custom ARC modes. When defining a custom ARC, you can alter the following 
properties in both the input and the output picture:

• Aspect ratio (default 16:9)
• Vertical size (default 100%)
• Horizontal size (default 100%)
• Tilt position (default 0.00%)
• Pan position (default 0.00%)

Reducing the input Vertical or Horizontal percentages crops the picture equally on each 
side, while reducing the output Vertical or Horizontal percentages zooms the picture out 
equally on each side. For example, a Horizontal input value of 80% will crop 10% from the 
left and right sides of the picture. 

It is also possible to lock the aspect ratio to the values of your choice. For example, if 
Horizontal is set to 100% and Vertical is set to 54.05% (creating a 1.85:1 aspect ratio), 
checking Lock Aspect Ratio means if you change a Horizontal value to 90%, the 
corresponding Vertical value automatically changes to 48.65%, maintaining the 1.85:1 
aspect ratio.

Reducing a Vertical value also allows you to adjust the corresponding Tilt value. The Tilt 
range is determined by the Vertical value. For example, if a Vertical value is reduced to 90%, 
the Tilt range will be -5.00% to +5.00%, with 0.00% being center. 

Reducing a Horizontal value allows you to adjust the corresponding Pan value. The Pan 
range is determined by the Horizontal value. For example, if a Horizontal value is reduced to 
75%, the Pan range will be -12.50% to +12.50%, with 0.00% being center. 

As the percentages are changed, preview windows automatically update to show what area 
of the input picture will be used and the effect on the output picture. Figure 10-1 below to 
Figure 10-4 on page 100 show the preview windows for some example custom ARC modes.

Fig. 10-1: The Input values are set to Vertical 90% and Horizontal 90%, as illustrated by the area 
within the red border. The Output values are set to default. The resulting output picture is cropped 
evenly on all sides.
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Fig. 10-2: The Input values are set to Vertical 80% and Tilt -10%, as illustrated by the area within the 
red border. The Output values set to default. The resulting output picture only shows the top 80% of 
the input picture.

Fig. 10-3: The Input values set to default, so the whole picture is kept within the red border. The 
Output set to Vertical 90%, Horizontal 90%, Tilt -5% and Pan -5%. The resulting output picture is 
zoomed out and displayed in the top-left corner, with a border along the bottom and right.

Fig. 10-4: The Input values are set to Horizontal 75%, as illustrated by the area within the red border; 
Output set to Aspect Ratio 4:3. The resulting output picture is horizontally cropped and displayed 
with a 4:3 aspect ratio.

Defining a Custom Aspect Ratio Control (ARC) Mode
Custom ARC modes are defined from the Advanced Aspect Ratio Control - Mapping 
Configuration pop-up layout, in the Channel Config layout. When you apply a custom ARC 
100



iTX Output Server 2
Channel Configuration Guide
mode, it takes effect on the next asset in the schedule with AFD settings that correlate to 
that mode.

To access the Custom Aspect Ratio Control Mode dialog:
1 Start the iTX Desktop on a client PC and login with an Administrator profile.
2 Open the Engineering layout.
3 Click Channel Config. 

The Channel Config pop-up layout appears.
4 From the View list, select the view containing the channels to be configured. The 

channels associated with that view appear.
5 Click the name of the channel to be configured.
6 Click the Channel Config 4 tab.
7 In the Advanced Aspect Ratio Control panel, click Configure Mapping...

The Advanced Aspect Ratio Control - Mapping Configuration pop-up layout appears.
8 Click Define Custom ARC Mode...

The Customer Aspect Ratio Control Mode dialog appears.

Note:
• The Advanced ARC and AFD-insertion features are only available if your 

system has the necessary software license. Your system may be licensed to 
use the functionality for both of these in one license. Configuring the 
settings for unlicensed functionality does not affect the output video 
signal. 

• The mapping configuration dialog is intended to provide the maximum 
flexibility for the setting up of ARC operations and AFD insertion. The 
dialog does not prevent you from setting unsuitable configurations (for 
example, selecting a 4:3 aspect ratio for an HD channel). 
To prevent problems with the display of the video image, ensure the 
configuration settings are correct for each channel in your iTX system. 

• For information on editing and deleting custom ARC, see Maintaining 
Custom Aspect Ratio Control (ARC) Modes, on page 133.
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9 In the Customer Aspect Ratio Control Mode dialog, click New.
A new set of default ARC values appear with the name new-custom-mode-(n), where 
(n) is a unique number.

10 In the Name field, enter a unique name to identify the new custom mode. 
11 In the Input section. define the area to use from the input picture:

a Select an input Aspect Ratio from either 16:9 (default) or 4:3.
b Configure the size of the area to use from the input picture. 

• For the Vertical size, enter a percentage or drag the slider to crop the picture 
vertically. 

• For the Horizontal size, enter a percentage or drag the slider to crop the 
picture horizontally. 

• If you want the two percentages to move in relation to each other, check Lock 
Aspect Ratio.

c Configure the position of the area to use from the input picture:
• If the Vertical percentage has been reduced, you can adjust the Tilt value by 

entering a percentage or dragging the slider. 
• If the Horizontal percentage has been reduced, you can adjust the Pan value 

by entering a percentage or dragging the slider. 
As the percentages are changed, both preview windows automatically update to show 
the effect.

12 In the Output section, define the ARC for the output picture:
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a Select an output Aspect Ratio,
b Configure the size of the output picture. 

• For the Vertical size, enter a percentage or drag the slider to zoom out the 
picture vertically. 

• For the Horizontal size, enter a percentage or drag the slider to zoom out the 
picture horizontally. 

• If you want the two percentages to move in relation to each other, check Lock 
Aspect Ratio.

c Configure the position of the output picture:
• If the Vertical percentage has been reduced, you can adjust the Tilt value by 

entering a percentage or dragging the slider. 
• If the Horizontal percentage has been reduced, you can adjust the Pan value 

by entering a percentage or dragging the slider. 
As the percentages are changed, the Output preview window automatically updates to 
show the effect.

13 Click Save then Close.
You are returned to the Advanced Aspect Ratio Control - Mapping Configuration 
pop-up layout. From here you can assign your new custom ARC to a set of field values. 
See Assigning a Custom Aspect Ratio Control (ARC) Mode below.

Assigning a Custom Aspect Ratio Control (ARC) Mode
Both standard and custom ARC modes are assigned to a ARC operation in the same way.

To assign a custom ARC mode:
1 Open the Advanced Aspect Ratio Control - Mapping Configuration dialog
2 Decide which set of field values you want to remap and click the corresponding ARC 

Mode button.

The ARC Mode selection dialog appears.
3 Select your new ARC mode from the Custom ARC modes list then click OK.

On the Advanced Aspect Ration Control - Mapping Configuration dialog, the name of 
the custom ARC mode appears in the ARC Mode column and the corresponding 
Output Aspect Ratio field will change a display only field showing the output aspect 
ratio of the custom ARC mode.

4 Select your required Active Field Description then click OK.
For more information see the iTX System Configuration Guide.

5 On the Channel Config pop-up layout, click Save and Close.

Note: Once an ARC mode and AFD code is mapped to a set of field values, 
the very next scheduled item on the channel with matching field values will 
playout using the new ARC mode and AFD.
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The examples below show the effect on the final picture using different custom ARC input 
and output settings and what happens when you change both the input and the ouput 
settings:
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 I/O Card Connection Reference
This appendix discusses the I/O Device Controller Engineering Panel, which contains the 
schematics for every combination of video/audio I/O card and playout type. This can be 
used as a reference when connecting inputs and outputs to your video/audio I/O card.

Summary
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About I/O Device Controller Engineering Panel
The I/O Device Controller Engineering Panel shows your video/audio I/O cards inputs and 
outputs for your currently selected playout type (in TXPlay 2 Config) and whether they are 
the main or secondary inputs and outputs for the selected playout type. 

The image below shows the Engineering panel for a Corvid 44 set to the dual channel 
playout type:
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Accessing the I/O Device Controller Engineering Panel
The Engineering panel uses the following indicators:

The drop-down menu on the bottom right can be used as a filter to show different inputs 
and outputs individually:

• All 
• None
• Channel A
• Channel B
• Inputs 
• Outputs
• Reference

Accessing the I/O Device Controller Engineering Panel
To access the I/O Device Controller Engineering panel:

1 On the playout server running the service, maximize the Server Controller application. 
If Server Controller is not running, it can usually be found in Start>All Programs>iTX 
2.0.

2 Select the Controlled Services tab. All of the services running on that server are listed. 
3 Double-click I/O Device Controller. 

The I/O Device Controller user interface appears. It includes tabs for Service Details, 
Trace Logs, Installation Info, Configuration and Engineering.

4 Click on the Engineering tab. 
The schematic for your video/audio I/O card appears.

Indicator Description

Output spigot 

Input spigot 

Reference input spigot
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Corvid LP I/O Connections

Corvid LP video/audio I/O cards only support the single channel playout type and have the 
following inputs and outputs: 

Kona 3G I/O Connections

Kona 3G video/audio I/O cards only support the single channel playout type and have the 
following inputs and outputs:

Playout 
type

Port RS-
422 Port R Port 1 Port 2

Single 
channel

- Ref In Ch A 
Output

Main

Ch A
Input
Main

Playout 
Type Port J1 HDMI

Port 
SDI 1

Port 
SDI 2

Port 
SDI 3

Port 
SDI 4

Single 
channel

Ref 
Input

- - Ch A
Input
Main

- Ch A 
Output

Main
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Corvid 44 I/O Connections

Depending on the selected playout type, Corvid 44 video/audio I/O cards uses the 
following inputs and outputs:

Playout 
Type Port 1 Port 2 Port 3 Port 4 Port R

Single 
channel

Ch A
Output

Main

Ch A
Output

Sec

Ch A
Input
Main

- Ref
Input

4K Single 
channel

Ch A
Output
Main 1

Ch A
Output
Main 2

Ch A
Output
Main 3

Ch A
Output
Main 4

Ref
Input

Single 
channel 
4K 2SI

Ch A
Output
Main 1

Ch A
Output
Main 2

Ch A
Output
Main 3

Ch A
Output
Main 4

Ref
Input

Single 
channel + 
Fill & Key

Ch A
Output
Main 1

Ch A
Input

Main 1

Ch A
Input
Fill & 
Key - 

Fill

Ch A
Input
Fill & 
Key - 
Key

Ref
Input

Dual 
channel

Ch A
Output

Main

Ch B
Output

Main

Ch A
Input
Main

Ch B
Input
Main

Ref
Input

Simulcast Ch A
Output

Main

Ch B
Output

Main

Ch A/B
Input
Main

Ch A/B
Input

Second

Ref
Input

Dual Live Ch A
Output

Main

Ch A
Output

Sec

Ch A
Input
Main

Ch A
Input

Second

Ref
Input
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Corvid 88 I/O Connections 

o

Depending on the selected playout type, Corvid 88 video/audio I/O cards use the following 
inputs and outputs:

Playout 
Type Port 1 Port 2 Port 3 Port 4 Port 5 Port 6 Port 7 Port 8 Port R

Single 
channel

Ch A
Output

Main

- Ch A
Input
Main

- - - Ch A
Output

Sec

- Ref
Input

4K Single 
channel 

Ch A
Output
Main 1

Ch A
Output
Main 2

Ch A
Output
Main 3

Ch A
Output
Main 4

Ch A
Input

Main 1

Ch A
Input

Main 2

Ch A
Input

Main 3

Ch A
Input

Main 4

Ref
Input

4K 2SI 
Single 
channel

Ch A
Output
Main 1

Ch A
Output
Main 2

Ch A
Output
Main 3

Ch A
Output
Main 4

Ch A
Input

Main 1

Ch A
Input

Main 2

Ch A
Input

Main 3

Ch A
Input

Main 4

Ref
Input

Fill & Key 
Single 
channel 

Ch A
Output

Main

- Ch A
Input
Main

- Ch A 
Input 
Fill & 
Key - 

Fill

Ch A 
Input 
Fill & 
Key - 
Key

Ch A
Output

Sec

- Ref
Input

Dual 
channel

Ch A
Output

Main

Ch B
Output

Main

Ch A
Input
Main

Ch A
Input

Second

Ch B
Input
Main

Ch B
Input

Second

Ch A
Output

Sec

Ch B
Output

Sec

Ref
Input

Simulcast Ch A
Output

Main

Ch B
Output

Main

Ch A/B
Input
Main

Ch A/B 
Input

Second

- - Ch A
Output

Sec

Ch B
Output

Sec

Ref
Input

Fill & Key 
Simulcast

Ch A
Output

Main

Ch B 
Output 

Main

Ch A/B
Input
Main

Ch A/B 
Input

Second

Ch A 
Input 
Fill & 
Key - 

Fill

Ch A 
Input 
Fill & 
Key - 
Key

Ch B 
Input 
Fill & 
Key - 

Fill

Ch B 
Input 
Fill & 
Key - 
Key

Ref
Input
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Dual Live Ch A 
Output

Main

- Ch A
Input
Main

Ch A
Input

Second

- - Ch A
Output

Sec

- Ref
Input

Fill & Key 
Dual Live

Ch A 
Output

Main

- Ch A
Input
Main

Ch A
Input

Second

Ch A 
Input 
Fill & 
Key - 

Fill

Ch A 
Input 
Fill & 
Key - 
Key

Ch A
Output

Sec

- Ref
Input

Dual Fill & 
Key

Ch A 
Output

Main

Ch A
Output

Sec

Ch A
Input
Main

Ch A
Input

Second

Ch A 
Input 
Fill & 
Key - 

Fill

Ch A 
Input 
Fill & 
Key - 
Key

Ch A 
Input 
Fill & 

Key B - 
Fill

Ch A 
Input 
Fill & 

Key B - 
Key

Ref
Input

Playout 
Type Port 1 Port 2 Port 3 Port 4 Port 5 Port 6 Port 7 Port 8 Port R
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Depending on the selected playout type, a playout server with dual Corvid LP video/audio 
I/O cards use the following inputs and outputs:

Playout 
type

Device 0 Device 1

Port RS-
422 Port R Port 1 Port 2

Port RS-
422 Port R Port 1 Port 2

Single 
channel

- Ref 
Input

Ch A
Output

Main

Ch A
Input
Main

- - - -

Dual 
channel

- Ref 
Input

Ch A
Output

Main

Ch A
Input
Main

- Ref 
Input

Ch B 
Output

Main

Ch B
Input
Main

Dual live - Ref 
Input

Ch A 
Output

Main

Ch A
Input
Main

- - Ch A
Input

Second

-
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Operating an Output Server 2 System
This appendix contains information about the day-to-day operation an Output Server 2 
channel, including simulcast and dual live channel. 

Summary
Managing Audio from iTX Desktop  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 113
About Output Server 2 Channel Status Indicators  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 124
Viewing Live Event Inputs on Channel Control Layouts . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 124

Managing Audio from iTX Desktop
From within iTX Desktop, you can manage the audio configuration of video, voice over and 
live assets in the following ways:

• For video assets:
• View both the logical audio program groups and physical track configuration
• Preview the playout of the video asset’s logical and physical audio programs
• View and apply a different Audio Import Rule to the asset
• Manage the asset’s physical audio tracks
• Monitor and/or override the audio mapping status of a scheduled video event

• For Live assets:
• View both the logical audio program groups and physical track configuration
• Reconfigure or remove a logical audio program or group from a Live asset
• Edit physical audio tracks for a live asset
• Monitor and/or override the audio mapping status of a scheduled Live event

• For Voice over assets:
• View both the logical audio program groups and physical track configuration
• Override which audio programs a Voice Over event is applied to

Viewing an Asset’s Logical or Physical Audio Mapping
Both the logical audio program groups and the physical audio mapping for video, voice 
over and live assets can be viewed from the property editor’s Logical and Physical tabs on 
the Asset layout. For video and voice over assets, these tabs can be found on the Locations 
tab, while for live assets they are on the Asset tab.

Figure B-1 on page 114 shows the Logical tab of a video asset and Figure B-2 on page 114 
shows the Physical tab of the same asset.
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Viewing an Asset’s Logical or Physical Audio Mapping
Fig. B-1: The Logical sub-tab shows the structure of the audio program groups for the selected asset.

Fig. B-2: The Physical sub-tab shows the arrangement of audio tracks within the media file. 

To view an asset’s Logical or Physical audio mapping
1 In iTX Desktop, switch to the Asset layout.
2 From PinPoint, select one of the following filters:

• To restrict the search results to video assets, click .
• To restrict the search results to voice over assets, click .
• To restrict the search results to live assets, click .

3 (optional) - Set additional filters to narrow the search to specific characteristics of 
logical audio mapping. For example:

• (Video and voice over assets only) From the filter at the top of PinPoint select 
Media > Has Logical Audio. The filter’s setting can be set to:

• Has Logical Audio: Yes | No
• Location Type: ITX | Proxy

• (Video assets only) From the filter at the top of PinPoint select Media > Audio 
Import Rule. The filter’s setting can be set to:

• Audio Import Rule: Is | Is Not
• Location Type: No Matching Rule| No Rule Applied | Manually Overridden | 

<SpecificAudioImportRuleName>
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4 Type in the criteria for the asset you want to update.
5 Press the Enter key or click  to begin the search.
6 From the results grid, select the required asset.
7 For video and voice over assets, go to the property editor on the right and select the 

Locations tab.
For live assets, go to the property editor on the right and select the Assets tab.

8 Click the Logical and Physical tabs to swap views.

Previewing the playout of a video asset’s Logical Audio Programs
When a video asset selected in the Asset layout has multiple audio programs, clicking the 
Audio Mixing Configuration button in the Media Viewer opens a two-tabbed dialog that 
displays the asset’s logical and physical audio configurations.

The Logical View tab shows a list of the logical audio programs present in the clip. You can 
select the program to be used during the preview the clip in the Media Viewer.

Listening to a preview of each of the programs is a valuable way to verify the quality and 
language of the audio track. If after previewing the audio, you need to change the logical 
audio mapping, you can try fixing the problem by defining and/or reapplying the audio 
import rule to the asset (see Viewing and changing the Audio Import Rule of a video asset, 
on page 115).

To preview an asset’s logical audio program
1 Use the iTX Desktop’s PinPoint search to locate and select the video asset. See Viewing 

an Asset’s Logical or Physical Audio Mapping, on page 113.
2 Verify that the Media Viewer is in GV Engine Viewer mode:

a Click the Asset Properties button  in the Media Viewer controls.
b Ensuring that the Player mode field is set to GV Engine Viewer.

3 Load the video asset in the Media Viewer.
4 Click the Audio Mixing Configuration button  in the Media Viewer controls.
5 Select the Logical View tab to view a list of the asset’s logical audio programs.

The blue audio  button indicates the currently selected audio program that will 
playout when previewing the clip in the Media Viewer. 

6 To change to another audio program, click the gray audio button  associated with 
the audio program and then click off the dialog. 
The selected audio group’s label is displayed next to the Audio Mixing Configuration 
button and that program’s audio will be heard when the clip is played in the Media 
Viewer.

Viewing and changing the Audio Import Rule of a video asset
Using the asset property editor, it is possible to view the current audio import rule applied 
to the video asset, as well as re-apply another audio import rule to the asset.
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Managing physical audio tracks for a video clip
To view and change the audio import rule applied to a video asset:
1 In iTX Desktop, switch to the Asset layout.
2 From PinPoint, click . to restrict the search results to video assets.
3 (optional) - Restrict the search results to only assets whose audio import rule is in a 

specific state.
a Set the filter at the top of PinPoint to Media > Audio Import Rule. 
b Set the filter’s setting to:

• Audio Import Rule: Is | Is Not
• Location Type: No Matching Rule| No Rule Applied | Manually Overridden | 

<SpecificAudioImportRuleName>
4 Press the Enter key or click  to begin the search.
5 From the results grid, select the required asset.
6 In the property editor on the right and select the Locations tab.
7 Scroll down the Locations tab until the Audio Information section is displayed.

The Applied Audio Import Rule field displays the rule that is currently applied to the 
asset. 

8 To change the applied audio import rule, click the Change button.
9 In the Change applied Audio Import Rule dialog, select the rule from the Compatible 

Rules section that you want applied to the video asset.
If the Compatible Rules section does not list an appropriate rule, you may consider 
creating a new audio import rule and then try again. See Creating Labels and Audio 
Import Rules for Logical Audio Programs, on page 20.

10 Click OK to close the Change applied Audio Import Rule dialog.
11 Click Save in the property editor.

Managing physical audio tracks for a video clip 
The Physical audio tab displays details of the individual physical audio tracks of a selected 
video clip, which includes two properties that you can modify:

• The group to which a mono track belongs. iTX can use mono tracks in the same group 
to produce a PCM stereo or Dolby E output signal.

• A language tag, which identifies the language of the audience the track is intended for.

To modify the properties, you use the Audio Track Mapping dialog, which is access from the 
Edit button on the Physical tab.
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Grouping mono tracks
Usually iTX automatically adds track grouping information to an asset when it ingests the 
broadcast quality file. This can be controlled in Delivery Manager within the end point 
configuration. See the iTX Delivery Manager Setup Guide for more information.

The following procedure is only applicable when this has not happened.

To manually group mono tracks:
1 Search for a video asset, as described in Viewing an Asset’s Logical or Physical Audio 

Mapping.
2 Open the Locations tab, select the Physical tab.
3 Click Edit. 

The Audio Track Mapping dialog appears.
4 Select tracks you want to group.
5 Click the button that denotes the output format that the mono tracks can be used to 

produce (i.e Dolby E 5.1 + 2, Dolby E 5.1, or PCM Stereo). 
6 Click OK to close the dialog.

Adding language tags to tracks

Add a language tag to a track
1 In iTX Desktop, switch to the Asset layout.

Note: You can use the Audio Track Mapping dialog to reverse the automatic 
grouping iTX performs on ingest; to do so, you change a track marked as 
PCM Stereo or Dolby E to mono.
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Editing the logical audio programs and groups for a live asset
2 Search for and select an asset using PinPoint.
3 Open Locations tab, then select the Physical tab.
4 Click Edit. 

The Audio Track Mapping dialog appears.
5 Click on a Language box. 

The Language Selection dialog appears:

6 You can change the selected languages in the following ways:
• To add a language to the audio track, select a language from the Available 

Language Codes column, then click the right arrow button  to add it to the 
Selected Language Codes. 

• To remove a language from the audio track, select a language from the Selected 
Language Codes column, then click the left arrow button  to return it to the 
Available Language Codes.

7 Click OK to close the Language Selection dialog.
8 The Audio Track Mapping dialog now displays the name of the selected language in 

the Language box.
9 Click OK to close the Audio Track Mapping dialog.

Editing the logical audio programs and groups for a live asset
Using the asset property editor, it is possible to edit the logical audio program groups 
assign to a live asset. Editing the logical audio programs does not affect the physical audio 
configuration.

To edit the logical audio of a live asset:
1 Search for a live asset, as described in Viewing an Asset’s Logical or Physical Audio 

Mapping.
2 On the Logical tab, click Edit. 
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The Audio Program Groups Editor appears.
3 To change how the asset is encoded, click the Encoding drop-down list and select one 

of the following:
• PCM 
• Dolby D
• Dolby E
• Dolby D Plus
• MPEG
• ACC

4 To change which channels the audio is output on, click on the Channels drop-down list 
and select one of the following:
• Mono
• Stereo
• 5.1
• 7.1

5 To change the current audio program label:
a Double-click on the Label text. 

The Label Selector appears.
b Select the label for the audio program and click OK.

6 (Optional) If you selected Dolby E as the encoding method, you can add multiple audio 
programs to the group until all of the channels are assigned (for example a surround 
5.1 and a stereo2.0 combination).

a Click Add Program to insert an additional audio program. 
b Follow step 3 to step b to define the additional audio program.

7 Click OK to close the Audio Group Editor dialog.

Removing a logical audio program or group from a live asset
Using the asset property editor, it is possible to remove unwanted logical audio programs 
and groups from a live asset. 

To configure the logical audio of a live asset:
1 Search for a live asset, as described in Viewing an Asset’s Logical or Physical Audio 

Mapping.
2 On the Logical tab, click Edit. 

The Audio Program Groups Editor appears.
3 To remove a program from an audio group, click on the X next to the program name, as 

shown in Figure B-3 on page 120.
4 To remove an audio group (and all of its programs), click on the X next to the audio 

group name, as shown in Figure B-3 on page 120.

Note: If you are changing a Dolby E program group to either Dolby D, 
Dolby D Plus or PCM, you should remove the unwanted audio program 
before selecting a different method of encoding. See Removing a logical 
audio program or group from a live asset on page 119.
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Editing physical audio tracks for a live asset
Fig. B-3: Removing audio programs and groups via the Audio Group Editor dialog.

5 Click OK to close the Audio Group Editor dialog.

Editing physical audio tracks for a live asset
The Physical audio tab displays details of the individual physical audio tracks of a selected 
live asset, which includes two properties that you can modify: the language tag and the 
compression method.

To edit the physical audio tracks for a live asset:
1 Search for a live asset, as described in Viewing an Asset’s Logical or Physical Audio 

Mapping.
2 On the Physical tab, click Edit. 

The Audio Tracks Mapping dialog appears.

3 To add an audio track, click .
A new row appears, with the next available ID number.

4 Double-click on the Language cell.
The Language Selection dialog appears.

5 To add a language tag, select the language tag you require from the Available 
Language Codes column the click . 
The selected language is added to the Selected Language Codes column.

6 To remove the language tag, select the language tags you require from the Selected 
Language Codes column the click . 
The selected language is added to the Available Language Codes column.
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7 Click OK to close the Language Selection dialog.
8 Click on Compression and select one of the following from the drop-down list:

• PCM mono
• PCM stereo
• Dolby D 5.1
• Dolby D 2.0
• Dolby E 5.1+2
• Dolby E 5.1
• Dolby D Plus 2.0
• Dolby D Plus 5.1
• Dolby D Plus 7.1

9 (Optional) To add more audio tracks, repeat step 3 to step 7.
10 (Optional) To remove an existing audio track, select the track then click .
11 Click OK to confirm your settings and close the Audio Track Mapping dialog.

Monitoring the Audio Mapping status of scheduled video or live events
Audio mapping rules control the order of preference for which the audio channels from the 
media file are assigned to the given audio program. (see Defining Audio Mapping Rules for 
Audio Programs, on page 75).

On playout, operators can use the Audio status icon in the schedule grid’s Audio Mapping 
column to see which events have had their audio mapped. If required, the operator can 
override the current audio mapping.

The color of the Audio status icon indicates what kind of audio program match has been 
found. 

• Green: Indicates that there is a Preferred match for all the audio output programs 
specified in the audio configuration. The clip will play out with the label specified in the 
rule.

• Orange: One or more of the audio output programs did not match the labels in the 
Preferred labels specified in the audio configuration, but there was a match in the 
Alternate labels.

• Red: One or more of the audio output programs did not match the labels in both the 
Preferred and Alternate Rule in the audio configuration. The operator may need to 
override the event’s current audio program mapping (see page 122 and page 123).

• Mute (crossed out speaker): One or more of the audio programs has matched on the 
Silence label in either the Preferred rule or Alternate rule.

• Blue: All programs are matched to a preferred tag and a manual intervention was 
already performed.

Note: If there are any audio mapping issues on an available/ready schedule 
item, an alert is also raised and displayed within the channel Health and on 
the iControl interface.
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Overriding the audio mapping of a scheduled video or live event
The initial audio mapping of a scheduled video or live event is determined by the mapping 
rules specified in the Output Server 2 Audio Configuration (see page 74). Similarly, the 
default audio mapping for live events is determined by the audio tracks configuration in 
the asset’s Logical Audio Tracks in the Asset Property Editor (see page 118).

You can manually override the current audio mapping of a video or live scheduled event by 
clicking the event’s Audio Status icon in the Audio Mapping column of the schedule grid.

The Audio Mapping dialog displays the audio rule options for each Audio Output Program 
Group. As demonstrated below, for each Audio Output Program Group:

• The currently selected label is highlighted in blue.
• Labels that are included in the rules but not in the asset are displayed but disabled.
• Labels in the asset which are also in the rules are shown as available for selection.
• Labels in the asset, but not in the rules are not displayed.

The Audio Output Program Groups listed in the Audio Mapping dialog can be filtered by 
Issue (e.g. show only items that have resulted in a red or orange status) and/or by Type (e.g. 
show only IP or SDI Program Groups).

Operators can view the currently selected labels in blue, which indicate which logical audio 
tracks will be played out. Operators can manually override the current label assignment by 
selecting another available label in the Audio Output Program Group and clicking OK. Once 
the override is applied, the change is reflected on the Audio Mapping status icon on the 
schedule grid.

To override the audio mapping of a scheduled video or live event
1 In the iTX Desktop’s schedule grid, click the Audio Mapping cell of the scheduled video 

or Live event.
The Audio Mapping dialog appears.

Note: For changes to be applied to the audio mapping, the event must not 
have been committed or reach the on-air state.
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2 If you want to override an Audio Output Program Group’s current label assignment 
(highlighted in blue), click one of the available labels in the program group.

3 Click OK to close the Audio Mapping dialog and apply the changed audio mapping to 
the event.
If all programs in the event’s new audio mapping are matched to a Preferred rule tag, 
then the Audio status icon associated with the event turns blue.

Overriding which audio programs a Voice Over event is applied to
When a Voice Over event is added to a primary event in a schedule, which audio programs 
the voice over will be applied to is initially determined by how the audio programs were 
configured using the Apply VO setting in the Output Server 2 Configuration dialog (see 
Applying Scheduled Voice Overs to Audio Programs, on page 85).

As a quick visual reference, if the Audio Status icon in the Audio Mapping column schedule 
grid is white, then this indicates that the “Apply VO” is set on at least one audio program 
within the configuration. If the Audio status icon is purple, this indicates that the audio 
output program was specified through traffic.

After the Voice Over event is scheduled in the ITX Desktop, you may want to verify exactly 
which audio program(s) the voice over will be applied to. Additionally, you want to override 
the Apply VO setting (enable or disable) for one or more of the audio programs. Clicking the 
Audio Status icon in the Audio Mapping column opens the Voice Over Output Selection 
dialog, which displays the current state of the Apply Voice Over setting for each program.

To view and/or override the Apply VO settings a scheduled Voice Over event
1 In the iTX Desktop’s schedule grid, click the Audio Mapping cell of the scheduled voice 

over event.
The Voice Over Output Selection dialog appears.

2 To override the current setting, click the Apply Voice Over button to change the state 
from enabled  to disabled , or disabled to enabled.

3 Optional: If you want to change the event’s mapping of Stereo to Surround setting (see 
page 86).

4 Click OK.
123



Operating an Output Server 2 System
About Output Server 2 Channel Status Indicators
The event’s Audio Status icon turns blue to reflect that a manually intervention has 
been performed on the voice over event’s audio program mapping.

About Output Server 2 Channel Status Indicators
The table below describes the indicators that may appear on top of the Schedule Grid for 
an Output Server 2 system:

Viewing Live Event Inputs on Channel Control Layouts
The input each live event is coming from can be viewed from the timeline in iTX Desktop.

To view the live event input:
• While a live event is on air, hover your mouse cursor over the event block on the 

timeline. The pop-up tooltip shows information about the event in focus, including its 
input (at the bottom).

Indicator Description

This indicator appears when a network channel (Channel Controller) is 
currently selected. Hovering over this indicator displays the controlled 
channels and their on air status. 

In an simulcast system, this indicator appears on simulcast and simulcast 
backup channels, alongside the Follower label.

In a system with a matrix router, this indicator appears when the channel 
output is routed to a destination to which the transmission system is 
connected.

Note:
• Channel control and schedule changes cannot be performed on TXPlay 

channels.
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This appendix contains information about how to maintain an Output Server 2 system. This 
includes the location of log files, the OS2 Engineering panel, changing Output Server 2 
configuration and changing system configuration that is outside of Output Server 2, but 
which affects the way it operates.

Summary
Starting Output Server 2 . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 125
Configuring Media Cache 2 . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 126
Managing Audio Registration, Output and Mapping . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 128
Overriding the Default ALC Processing State using the Channel Controller . . . . . . . . . . . . 132
Activating or Deactivating Fill and Key using the Channel Controller  . . . . . . . . . . . . . . . . . 132
Honoring NTSC SD Field Orders . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 133
Maintaining Custom Aspect Ratio Control (ARC) Modes . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 133
Deleting a Channel . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 135
Configuring Server Controller for Output Server 2 Components  . . . . . . . . . . . . . . . . . . . . . . 136
Viewing the Output Server 2 Engineering Panel  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 138
About Logging for Output Server 2  . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 140

Starting Output Server 2
As iTX services, Output Server 2, TXPlay 2, the I/O Device Controller and Media Cache 2 are 
controlled by the Server Controller application, which is installed with any iTX component. 
When the Server Controller is started, all of the services installed on the playout server are 
started, one after another. If a service is shut down, Server Controller can restart them 
automatically to protect system integrity.

Through Server Controller, Output Server 2 can be configured to control the way it starts, 
the channels it runs and the way those channels are setup.

To start Server Controller: 
• Go to Start > All Programs > iTX 2.0 > Server Controller.

The Server Controller appears and loads all of the installed services in their current 
configuration.
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Configuring Media Cache 2 
The Media Cache 2 service window includes a Configuration tab, for controlling caching 
thresholds, playback from the NAS and selecting which Media Watcher and domain to use.

Setting the Caching Thresholds
There are two fields for controlling the caching thresholds, one for the maximum transfer 
speed and one for the maximum block size.

The cache should be setup with a capacity large enough to meet the requirements of the 
most demanding schedule. However, if the schedule content cannot fit onto the cache, 
then set the Enable Caching Look Ahead and Caching Look Ahead fields. These options 
allow you to enable and configure a Look Ahead window where only items within the 
schedule that appear within the Look Ahead window are referenced by the Media Cache 2 
service. Anything outside the window is a candidate for deletion.

To change the caching thresholds:
1 On the playout server running the Output Server 2 system, expand the Media Cache 2 

service window.
2 Click the Configuration tab. 
3 Enter a value in the Max Transfer Rate (MB/s) field to select the maximum caching 

speed, up to 1024 MB/s (or 8.192 Gbit/sec). 
This option defaults to 0 MB/s, which means the speed is uncapped. 

4 Enter a value in the Block Size (MB) field to control the size of the data blocks that are 
written to disk. The default is 8 MB. Increasing this value can reduce the amount of 
throttling that is required during caching and improve the overall performance.

5 (optional) If the schedule content cannot fit onto the cache, then set the Enable 
Caching Look Ahead and Caching Look Ahead fields.

6 Click Save.
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Controlling Playback from Network Attached Storage (NAS)
When media cannot be cached in time for playout, iTX can resort to playing it from the NAS. 
The success of playing from a NAS depends on several facts, including the speed of your 
network and the bitrate of the media being played. As such, the Media Cache service allows 
you to control playback from the NAS and the maximum media bitrate it will attempt to 
play. This can be useful when you have higher bitrate media, such as DNxHD encoded MXF 
files, which might struggle to play from a NAS.

To control the playback from a NAS:
1 On the playout server running the Output Server 2 system, expand the Media Cache 2 

service window. 
2 Click the Configuration tab. 
3 Click Enable Playback From NAS to enable or disable playback from NAS.

4 Enter a value in the Maximum Allowed Bitrate (Mb/s) field to limit NAS playback to 
media that is below the specified value.
The default value is 99999Mb/s.

5 Click Save.

Selecting the Media Watcher
The Media Cache 2 service allows you to select which Media Watcher you want to copy files 
from external search folders when they are required for playout. Depending on the search 
folder configuration, the copy destination may be either the Output Server cache or a 
Media Store managed by the Media Watcher.

To select a Media Watcher:
1 On the playout server running the Output Server 2 system, expand the Media Cache 2 

service window. 
2 Click the Configuration tab. 
3 From the Media Watcher box, select the Media Watcher you want to use to copy files 

from external search folders when they are required for playout. 
4 Click Save.

Selecting Search Domains
Through the search domains panel, you can tell a Media Cache 2 service to use a user 
specified search domains list, instead of the central list that you configure in the Media 
Watcher. 

Note: If you set up the Media Cache 2 Service to use a local domain search 
list, you must set up TX Play on the same machine to use an identical list.
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To select search domains:
1 On the playout server running the Output Server 2 system, expand the Media Cache 2 

service window.
2 Click the Configuration tab. 

The Configuration panel appears.
3 Click Local to switch the service between using the local configuration and the central 

one.
4 In the Available Domains list, select the domains you want to use, then click >> to add 

them to the Selected Domains list.
5 Click Save.

Managing Audio Registration, Output and Mapping
In addition to the initial configuration of audio programs and output groups, you may want 
to change how your audio is registered, output and substituted. Some of this configuration 
is performed outside of Output Server 2 and the iTX Desktop. This section describes how to 
perform these tasks.

Separating Mono Tracks on Import
By default, Delivery Manager combines mono tracks to create stereo programs on import. 
This option can be enabled or disabled within the Delivery Manager endpoint configuration, 
Once changed, this configuration will only affect newly imported media.

To separate mono tracks in Delivery Manager:
1 From Windows, click START > All Programs > iTX 2.0 > Delivery Manager Config. 

The Select Configuration dialog is displayed.
2 Select a configuration profile and click OK.

The Delivery Manager Configuration dialog appears,
3 On the Delivery Manager Configuration dialog, select the tab for the endpoint you 

want to configure.
4 In the Audio Options section, uncheck Group Mono Tracks.

Note that the Group Mono Tracks checkbox is only displayed if the Use Audio Import 
Rules checkbox is unchecked.

5 Click Save, then Close.
6 Restart the Delivery Manager service.

Including Language Metadata on Import
By default, Delivery Manager ignores any language audio program labels contained within the 
metadata of video and voice over media. This option can be enabled or disabled within the 
Delivery Manager endpoint configuration, Once changed, this configuration will only affect 
newly imported media.

To include language metadata in Delivery Manager:
1 From Windows, click START > All Programs > iTX 2.0 > Delivery Manager Config. 
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The Select Configuration dialog is displayed.
2 Select a configuration profile and click OK.

The Delivery Manager Configuration dialog appears.
3 On the Delivery Manager Configuration dialog, select the tab for the endpoint you 

want to configure.
4 In the Audio Options section, uncheck Ignore Language Metadata.

Note that the Ignore Language Metadata checkbox is only displayed if the Use Audio 
Import Rules checkbox is unchecked.

5 Click Save, then Close.
6 Restart the Delivery Manager service.

Editing Audio Program Labels
The audio program labels that are currently stored in the iTX Opus database can be viewed, 
selected and edited from the iTX Desktop’s Configuration layout (see page 20) or the Audio 
tab of the Output Server 2 Configuration user interface. 

If the labels are not in use, they can also be edited and deleted. The labels are stored 
centrally and therefore changes you make on one playout channel are available on all of the 
other playout channels in the same iTX domain.

Labels that are currently in use cannot be edited. This is indicated by a closed padlock icon 
 on the Audio tab of the Output Server 2 Configuration user interface.

To edit the list of audio program labels
1 On the playout server, expand the instance of Output Server 2 for the channel to be 

configured (e.g. ITX1 Output Server 2). 
The Output Server 2 user interface appears.

2 Select the Configuration > Audio tab. 
The Audio Programs and Audio Output Program Groups panels appear.

3 In the Audio Programs section, click Available Labels.
A list of all of the available labels appears. This includes those created when media was 
registered (e.g. P#1, P#2, P#2, etc) and user created labels. If languages were defined in 
an Asset’s metadata, they are also displayed, for example ENG#1, ENG#2, FRA#1, etc.

4 You can edit the list of audio program labels in the following ways:
• To edit a label (that is not in use), double-click on its entry in the list and type the 

required amendment.
• To add a label, click in the blank box at the bottom of the list, type in a name, then 

press the Enter key.
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• To delete an existing entry (that is not in use), select it and press the Delete key.
5 Click Save to store your changes and automatically reboot the Output Server 2 service. 

Alternatively, wait until you have finished making changes in other areas of the 
Configuration panel, then click Save.

Editing Audio Programs and Mapping Rules
All of the configuration for existing audio programs can be altered, including the mapping 
rules, or they can be deleted altogether.

To edit an audio program:
1 On the playout server, expand the instance of Output Server 2 for the channel to be 

configured (e.g. ITX1 Output Server 2). 
The Output Server 2 user interface appears. 

2 Select the Configuration > Audio tab. 
The Audio Programs and Audio Output Program Groups panels appear.

3 In the Audio Programs section, an existing Audio Program mapping rule can be edited 
in the following ways:

a To rename a rule, double-click on its Name cell and type the new name.
b To delete a label from the rules, select the label in the Preferred Rule cell or the 

Alternative Rule cell and press the Delete key.
c To change whether the scheduled voice over is applied to the audio program, 

check or uncheck Apply VO?. See Configuring Voice Overs Playback on page 84.
d To change the Dolby metadata configuration, click Edit in the Dolby column.

The popup Dolby dialog appears. See Configuring Dolby Metadata on page 78.
e To change the upmixing profile for audio programs requiring conversion to Dolby 

5.1 or Dolby 7.1, click Edit in the Upmix column.
The Upmixing Configuration pop-up dialog appears for the selected audio 
program. See Configuring Audio Upmixing on page 79.

f To change the audio watermarking type and/or settings, click Add in the 
Watermarking column.
The Watermark pop-up dialog appears for the selected audio program. See 
Configuring Audio Watermarking on page 81.

g To change the Automatic Loudness Control settings, click Add in the ALC column.
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The ALC Profile pop-up dialog appears for the selected audio program. See 
Configuring Automatic Loudness Control (ALC) on page 83.

h To change the output channel, select an alternative from the Output Channels 
drop-down list.
When you select a different output channel type, a pop-up message appears 
asking if you would like to change the Dolby configuration to defaults that are 
appropriate for the output type.
Click Yes to change your Dolby configuration to sensible defaults or No to leave the 
Dolby configuration as is.

i To delete an audio program, click  at the end of the row.
4 Click Save to store your changes and automatically reboot the Output Server 2 service. 

Alternatively, wait until you have finished making changes in other areas of the 
Configuration panel, then click Save.

Editing Audio Output Program Groups
An audio output program group can be edited by changing its audio type, changing the 
rules assigned to it or by deleting it altogether.

To edit an audio output program group:
1 On the playout server, expand the instance of Output Server 2 for the channel to be 

configured (e.g. ITX1 Output Server 2). 
The Output Server 2 user interface appears. 

2 Select the Configuration > Audio tab. 
The Audio Programs and Audio Output Program Groups panels appear.

3 In the Audio Output Program Groups section, select an output target tab, either SDI or 
IP.

4 An existing output group can be edited in the following ways:
• To change the audio type, select an alternative from the Type drop-down list.
• To delete a audio program from the output group, select the program in the 

Programs cell: 

Press the Delete key.
• To delete an output group, click  at the end of the row.

Note: If the combination of the selected audio program’s output channel 
and the output group’s audio type are incompatible, the Program cell turns 
red and the Description cell displays an error, explaining why the selected 
combination cannot be used together.

To correct this error, change either the output group’s audio type or the 
selected audio programs.
131



Maintaining an Output Server 2 System
Overriding the Default ALC Processing State using the Channel Controller
5 Click Save to store your changes and automatically reboot the Output Server 2 service. 
Alternatively, wait until you have finished making changes in other areas of the 
Configuration panel, then click Save.

Overriding the Default ALC Processing State using the Channel 
Controller

The Channel Controller service's Engineering tab features an ALC button that allows 
system administrators to override the initial ALC state (activated or deactivated) for the 
TXPlay2 channels controlled by the Network channel. This ensures that the initial ALC 
Processing state is uniformly applied to the channels upon their first start‐up.

You can easily identify the channel’s current ALC processing state by the color of the ALC 
button:

• When the ALC button is green, it means that ALC is active on all audio programs in the 
channel Network whose ALC Profile is enabled.

• When the ALC button is grey, it means that ALC is inactive across all audio programs in 
the channel Network.

When a schedule is being played out on the Network channel and the ALC button is clicked, 
an Activate ALC Profile or Deactivate ALC Profile is added as a secondary event to the on-
air primary event in the Schedule Grid and the ALC profile is either immediately activated or 
deactivated. If no event is currently on-air, the ALC setting will be applied but no secondary 
event will be added to the Schedule Grid. The ALC event’s Item Title in the Schedule Grid 
acknowledges that the event was added as an “Engineering Override” and the event is also 
added to the Trigger track in the iTX Desktop’s Timeline.

Activating or Deactivating Fill and Key using the Channel 
Controller

The Channel Controller service's Engineering tab features two Fill and Key buttons that 
allows system administrators to override the current Fill and Key states (activated or 
deactivated) for the TXPlay2 channels controlled by the Network channel.

You can easily identify the channel’s current Fill and Key processing state by the color of the 
Fill and Key button:

• When the Fill and Key button is green, it means that Fill and Key is active on all the 
channels controlled Network channel.

• When the Fill and Key button is grey, it means that Fill and Key is inactive across all the 
channels controlled Network channel.

When a schedule is being played out on the Network channel and the Fill and Key button is 
clicked, a Fill and Key Manual On or Fill and Key Manual Off is added as a secondary event 
to the on-air primary event in the Schedule Grid and the event is also added to the Fill & Key 
track in the iTX Desktop’s Timeline. If no event is currently on-air, the Fill & Key setting will 
be applied but no secondary event will be added to the Schedule Grid.
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Honoring NTSC SD Field Orders
In an Output Server 1 system, the field order for NTSC SD assets often had to be reversed on 
a per-asset basis for video to playout as expected. This was done by checking the Reverse 
Field Order check box on the Asset tab of the Asset layout in iTX Desktop. Output Server 2 is 
able to interpret the field order from the media itself. As such, Output Server 2 defaults to 
ignoring the Reverse Field Order checkbox and plays out the asset as the media dictates.

If you are operating a mixed Output Server system, you may not want Output Server 2 
playout servers to ignore assets with reversed field orders. This can be controlled using a 
global configuration called OS2 Ignore “Reverse Field Order”. If this option is set 
incorrectly for you system, your NTSC SD assets it may play out incorrectly (juddering or 
shaking).

To configure OS2 to honor Reverse Field Order:
1 On a playout server that is running Output Server 2, start the iTX Desktop client.
2 Log in with a system administrator profile.
3 Open the Engineering layout.
4 Click Channel Config. 

The Channel Config pop-up layout appears.
5 Click the System Wide Config tab. 
6 The OS2 Ignore “Reverse Field Order” field is enabled (lit green) by default.

Click OS2 Ignore “Reverse Field Order” to disable it.
7 Click Close. 
8 The Channel Config pop-up layout closes.

Maintaining Custom Aspect Ratio Control (ARC) Modes
Custom ARC modes are stored in the iTX database, so when one is created it is available to 
all channels within the same iTX domain. As such, editing or deleting a custom ARC mode 
affects all of the channels using it.

Note: For Output Server 2, a video asset’s detected field order can be seen 
in the Field Order field on the Locations tab in the Asset layout of iTX 
Desktop.
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Editing a custom ARC mode

To edit a custom Aspect Ratio Control mode:
1 Open the iTX Desktop and click the Engineering layout.
2 Click Channel Config. 

The Channel Config pop-up layout appears.
3 From the View list, select the view containing the channels to be configured. The 

channels associated with that view appear.
4 Click the name of the channel to be configured.
5 Click the Channel Config 4 tab.
6 In the Advanced Aspect Ratio Control panel, click Configure Mapping...

The Advanced Aspect Ratio Control - Mapping Configuration dialog appears.
7 In the Advanced Aspect Ratio Control - Mapping Configuration dialog, click Select.... 

The Select Item dialog appears.
8 Select the ARC mode to be edited then click OK.

The select custom ARC mode and its settings appears.
9 Modify the Input and Output Aspect Ratio, size and position as required. For more 

information see To remove the previous baseline subtitle configuration for legacy 
subtitles:, on page 97.

10 When you have finished making changes, click Save. 
11 Click Close. 

You are returned to the Advanced Aspect Ratio Control - Mapping Configuration 
dialog.

Deleting a custom ARC mode
It is possible to delete a custom ARC mode from any iTX channel. If the deleted custom ARC 
is still in use (either on the selected channel or any other channel), iTX will automatically 
restore it.

To delete a custom Aspect Ratio Control mode:
1 Open the iTX Desktop and click the Engineering layout.
2 Click Channel Config. 

The Channel Config pop-up layout appears.
3 From the View list, select the view containing the channels to be configured. The 

channels associated with that view appear.
4 Click the name of the channel to be configured.
5 Click the Channel Config 4 tab.
6 In the Advanced Aspect Ratio Control panel, click Configure Mapping...

Note: Custom ARC modes can be edited at any time and the very next 
scheduled item to be played out with matching field values will have its ARC 
operation and AFD code changed accordingly. This includes those in 
schedules on other channels that use the same custom ARC mode.
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The Advanced Aspect Ratio Control - Mapping Configuration dialog appears.
7 In the Advanced Aspect Ratio Control - Mapping Configuration dialog, click Select.... 

The Select Item dialog appears.
8 Select the ARC mode to be deleted then click OK.

The select custom ARC mode and its settings appears.
9 Click Delete. 

The item is deleted with no further confirmation or prompts and the first custom ARC 
in the select list is displayed.

10 Click Close. 
You are returned to the Advanced Aspect Ratio Control - Mapping Configuration 
dialog.

11 Click OK to close the Advanced Aspect Ratio Control - Mapping Configuration dialog.

About Restored Custom ARC Modes
If the custom ARC mode was assigned to a channel, it is not removed from the iTX database.

When the Advanced Aspect Ratio Control - Mapping Configuration dialog is next accessed 
from a channel using a deleted custom ARC, a warning will appear to say the deleted 
custom ARC mode has been restored.

If a new custom ARC is created with the same name as a deleted custom ARC, when the 
deleted one is restored, its name is appended with a dash then a number. e.g. a custom ARC 
mode called example_custom_arc would be restored as example_custom_arc-1.

To permanently delete a custom ARC mode, it must be unassigned on every channel that is 
using it before being deleted.

Deleting a Channel
Channels can be deleted from the ITX Channel Config dialog of TXPlay 2 Config.

To delete a channel:
1 On the Windows desktop of the playout server, double-click on the TXPlay 2 Config 

icon. The ITX Channel Config dialog appears.
2 If there is more than one channel configured on the playout server, select the channel 

to be deleted from the Channel Name drop-down list.
3 Click Delete Channel. 

The channel disappears from TXPlay 2 Config.
4 Click Save to confirm the deletion.

IMPORTANT
• You must make sure you stop the instances of TXPlay 2 and Output Server 

2 associated with the channel to be deleted before you begin. 
• Deleting a channel from an playout server does not remove it from any 

views in iTX Desktop.
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Configuring Server Controller for Output Server 2 Components
Under normal operating conditions, the Service Controller configuration for each iTX 
service is updated and maintained by modifying their respective configuration utility. For 
example, the running the TXPlay2 Config utility defines the Server Controller arguments for 
Output Server and I/O Device Controller. However, sometimes it is necessary to make 
changes to the way a service runs by changing the Server Controller configuration directly. 

Server Controller Configuration for the I/O Device Controller
To edit the Server Controller configuration for I/O Device Controller:

1 From Windows, click Start > All Programs > iTX2.0 > Server Controller Config. 
The Server Controller Configuration dialog appears.

2 Go to the Services tab.
3 Select the Device Controller service then click Edit. 

The Service Details dialog appears.

4 Make sure Enabled is checked. This will run the instance of the service when Server 
Controller is started.

5 In the Arguments field, the following arguments are available:

Argument Description

-config SingleChannel Single input, single output channel.

-config SingleChannel4K Four inputs, four outputs for a single channel.

-config DualChannel Two independent channels, each with a single input 

-config DualLive Single channel with two inputs

-config DualFK -device 
Corvid88

Single channel with two inputs and two pairs of Fill & 
Key inputs

-config Simulcast Two channels sharing two inputs 
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6 Make sure Auto Restart is checked. This ensure Server Controller automatically 
restarts the I/O Device Controller service in the event of a failure. 

Server Controller Configuration for Output Server 2
To edit the Server Controller configuration for an Output Server 2 channel:

1 From Windows, click Start > All Programs > iTX2.0 > Server Controller Config. 
The Server Controller Configuration dialog appears.

2 Go to the Services tab.
3 Select the Output Server 2 service then click Edit. 

The Service Details dialog appears.

4 Make sure Enabled is checked. This will run the instance of the service when Server 
Controller is started.

5 In the Arguments field, the following arguments are available:

Argument Description Inclusion

-ui Enables the user interface, which is 
required to access Output Server 2’s 
Configuration and Engineering panels.

Required

-n <Name> Specifies the name of the service. For 
example, for a channel called "GV Movies 
1" you might enter: -n GVMovies1 (no 
spaces)
A user friendly alias for channel names 
can be created in iTX Desktop.

Required

-backup Used to indicate an instance is a backup 
service.

Optional
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6 Make sure Auto Restart is checked. This ensure Server Controller automatically 
restarts the Output Server 2 service in the event of a failure. 

Viewing the Output Server 2 Engineering Panel
Along with the Configuration panel, Output Server 2’s user interface includes an 
Engineering panel, which contains the following tabs:

• Status
• Event Log

For information on accessing the user interface, see Selecting the Channel Resolution and 
Frame Rate, on page 64.

-t <Card type> Describes the type of video or audio card 
fitted in the host machine. In most cases 
this will say: -t AJAXena.

Required

-id <Letter> Used to identify the inputs/outputs on 
the video/audio I/O card being used for 
the channel. 
For example: -id A or -id B.

Required for:
• Corvid 44 
• Corvid 88
• Dual Corvid 

LPs

-p <plugin name> Identifies the media application 
framework plugin to be used with 
Output Server 2. 
Valid values include: 
• -p iTXPlayer2 (default value)
• -p Simulator (use for testing only)

Default

-ratefamily <framerate> Specifies the frame rate to use for the 
channel, overriding the valid specified in 
I/O Device Controller’s configuration. 
Valid values include:
• -ratefamily 50
• -ratefamily 59.94
• -ratefamily 24
• -ratefamily 23.98

Note:
• If you add or change this argument you will 

need to reselect the Resolution from the 
Output Server 2 user interface.See Selecting 
the Channel Resolution and Frame Rate on 
page 64.

• If the frame rate family specified in Output 
Server 2 does not match that of the I/O 
Device Controller, Output Server 2 will start 
up in an error state.

Optional

Argument Description Inclusion
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About the Status tab
The Status tab shows the input status of the video/audio I/O card and information about the 
GV Engine. It also allows you to select the I/O Device and also adjust the audio 
synchronization for the current clip.

About the Event Log
The Event Log displays events sent from GV Engine to Output Server 2. This information can 
be used by GV Care to diagnose potential issues with either FPP or Output Server 2.
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About Logging for Output Server 2

Log File Locations
The log files for an Output Server 2 channel and its related components can be found in the 
following locations:

Custom logging profiles from iTX v2.8 onwards
For each iTX service there is a corresponding logging profile file. These are XML files that 
provide the service with parameters for how to collect and output logs. Although these 
logging profile files are distributed with default parameters, you can edit them to create 
custom logging profiles.

Each logging profile file has the same filename as the service it is for, followed by .logging. 
For example, OutputServer2.exe has a logging profile file called 
OutputServer2.exe.logging.

iTX v2.8 introduced 64-bit versions of Output Server 2 and I/O Device Controller, with 
executable filenames that end _x64.exe. If you have any existing custom logging profiles 
for either Output Server 2 or I/O Device Controller they will no longer work, as the 32-bit 
executables to which they refer are no longer active. 

Component Logs

Output Server 2 service Each messages sent from TXPlay 2 to OutputServer2 is logged as 
an individual XML file in the following location:
C:\ITXLogs\OutputServer\YYYY-MM-DD\*.xml

VyConsoleApp for FPP Each pooled VyConsoleApp process creates its own log file in the 
following location:
%APPDATA%\Miranda\VyConsoleApp_CHANNELNAME_SC_COM_
POOLID.log.*

VyCOMScheduler for FPP - 
Engineering logs

The engineering logs are written to the following location:
%APPDATA%\Miranda\VyCOMScheduler\VyCOMScheduler_CH
ANNELNAME.log
This file will roll over when it reaches about 10 MiB and up to 5 
rolled over files are kept.

VyCOMScheduler for FPP - 
Command logs

All commands that VyCOMScheduler receives are logged as 
executable powershell scripts.
%APPDATA%\Miranda\VyCOMScheduler\SchedulerCommandL
og.ps1.*
This file will roll over when it reaches about 10 MiB and up to 5 
rolled over files are kept.

Note: These scripts must be provided when reporting an issue 
since it tells Grass Valley Support exactly what Output Server 2 
received and when, and allows Grass Valley Support to replay the 
commands.
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To continue using your custom logging profiles for Output Server 2 or I/O Device Controller, 
you will need to copy their configuration from the old file to the 64-bit version. 

To copy a custom logging profile to the 64-bit version:
1 On the Appliance Server running Output Server 2, open Windows Explorer.
2 Navigate to the Services folder for the iTX installation, e.g. C:\Program Files 

(x86)\Services.

3 To update the logging profile for the 64-bit Output Server 2:
a Open the folder OutputServer2.
b Open OutputServer2.exe.logging in a text editor, then copy and paste its 

contents into OutputServer2_x64.exe.logging.
c Save OutputServer2_x64.exe.logging and close the text editor.

4 To update the logging profiles for the 64-bit I/O Device Controller:
a Open the folder DeviceController.
b Open DeviceController.exe.logging in a text editor, then copy and paste its 

contents intoDeviceController_x64.exe.logging.
c Save DeviceController_x64.exe.logging and close the text editor.

5 Using Server Controller, restart the Output Server 2 and/or I/O Device Controller 
service(s) to pick up the changes to the logging configuration.
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Contact Us
Grass Valley Technical Support
For technical assistance, contact our international support center, at 
1-800-547-8949 (US and Canada) or +1 530 478 4148.

To obtain a local phone number for the support center nearest you, please consult the 
Contact Us section of Grass Valley’s web site (www.grassvalley.com).

An online form for e-mail contact is also available from the web site.

Corporate Head Office
Grass Valley
3499 Douglas-B.-Floreani
St-Laurent, Quebec  H4S 2C6
Canada
Telephone: +1 514 333 1772
Fax: +1 514 333 9828
www.grassvalley.com
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